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STAY IN TOUCH WITH OUR STAFF ON TWITTER: @MACLIFE

A NEW ERA FOR MAC|LIFE

I

’ve been wanting to write this editor’s letter since January.
That was when I used an iPad for the ﬁrst time, and my
initial reaction was an inarticulate garble of “I must own that
gadget” greed. And then my second thought was, “We have to
make a Mac|Life iPad app.” That day is ﬁnally here…or it will
be soon. Like all app developers, we don’t know precisely what
awaits us in the approval process, but we’re hopeful that by early
to mid August, you’ll ﬁnd our baby in the App Store.
So let me tell you a bit about what we’re aiming for. Instead
of hustling to produce one of the ﬁrst magazine apps for iPad,
we’ve taken the time to do something different and more
interesting. We wanted an app that was more than just iBooks for
magazines. We wanted something that recognizes that the iPad
both grabs and sends information. We wanted an app that mixes
the strengths of our print magazine with what modern internet
media does best: interactivity, participation, and immediacy.
We’ve bundled all these goals into what I like to call “Issue
Zero” of our iPad app. As far as its magazine pages go, it’s all
content you’ve seen from us before, and that’s why the app is
free. That said, you’ve never been able to interact with our “print
content” like this before. You can tweet, Facebook Like, and send
emails about the stories you’re reading and the products they
cover, all without leaving the app. You can also provide your
own personal ratings for the products we cover, check out the

live-updated @maclife Twitter feed, and enjoy some spiffy videos
and animations.
Coming next: in-app commenting and…well, that’s where you
come in. The goal with this 1.0 version (and truly, it’s more like
an 0.3 version) is to gather feedback from you, our readers,
on where we’re going. Something not working how you’d like it
to? Have an idea for something else our app should do? Please
tell us. You can ping us from in-app or dash off an email to
app@maclife.com. We’ll
Instead of hustling to
deﬁnitely be listening, and
produce one of the ﬁrst
your feedback and ideas
magazine apps for iPad,
will be vital in shaping this
app. We have big plans, but
we’ve taken the time to
they’ll be bigger and better
do something different
with your participation.
and more interesting.
Thanks for joining us on
this ride, and we’d also like to shout out a big thank-you to our
developer, Balthaser, for the huge amount of work, inspiration,
and late nights they put into this project.
Separately, I’m thrilled to welcome Nic Vargus to our staff as
our new associate editor. You may recognize his name as one of
our regular contributors, and it’s great to have him onboard to
head up our coverage of iOS apps and more. You can welcome—
and haze!—him yourself on Twitter at @nicvargus.

Paul Curthoys, EDITOR-IN-CHIEF

>>>OVERHEARD AT MAC|LIFE THIS MONTH....

“If you get a
message that my
magic cauliﬂower
is ready to
harvest, you can
just ignore it.”
—Susie, warning
of We Rule push
notiﬁcations when
loaning her iPad to a
colleague.
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“How many
times do I have
to tell iTunes
I’m over 17?
You want to cut
off my arm and
count the rings,
iTunes? Is that
what you want?”
—Robbie, on how
updating apps can
be a chore.

“I can’t ﬁnd
my Yeti!”
—Robin, in a
statement that
makes more sense
once you read the
review on p62.

“Using a 3G
running iOS 4 is
the worst iPhone
experience I’ve
ever had. It was
like a long, slow
commercial
for reasons to
upgrade.”—Ray,
on the pain of waiting
for the white iPhone
to ﬁnally arrive.

“I used to rock
Boyz II Men mix
tapes like it was
my job.”

“My air
freshener bled
all over me this
morning.”

—New-guy Nic,
talking with Susie
and Ray about ﬁrst
favorite bands and
how he listened
to them.

—Flo, telling the
harrowing tale of
how her Glade
Plug-in exploded.

DiscLabel lets you decide which image
to present to the world.

™
The fastest and easiest way to enhance your
CD & DVD labels and packaging

Learn how to create
your own labels.
Watch a tutorial at
www.smileonmymac.com/howto

Download a trial version of DiscLabel today…

www.smileonmymac.com/maclife
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YOUR OPINIONS, R ANTS & R AVES

LETTER OF
THE MONTH
Dumpin’ on Dashboard
I just read the article on Dashboard
(“Are Widgets Dead?” Jul/10, p14)
and wanted to chime in. When
Dashboard debuted in 2005, I used
it for a bit, then realized I didn’t
have much use for its functionality
when I could set up different Mac
and web apps to do the same things.
An article in MacAddict said it
could be quite a memory hog, so I
downloaded TinkerTool and disabled
the Dashboard. I don’t think I’ve used
it since late 2005 or early 2006.
Since I edit video on Final Cut Pro, I
need all the memory allocation I can
get! Also, I wanted to say “Welcome
back, Rik Myslewski! It’s great to see
you in Mac|Life dispensing geeky
advice and thoughts.—Heath
McKnight
We’re also thrilled to have Rik
taking up residence on our back
page. Unlike the Dashboard, some
things never go out of style…
like knowledgeable and geeky
friends.—Susie

iTunes Intervention
In July’s “Consider” (p6), you talked about
some of the problems with iTunes. One of the
biggest is that it must exist on some form of
hardware, rather than staying in a cloud and
syncing over the air. Which brings me to the
biggest problem of the iPad. The iPad should
not have to sync with iTunes—it should have
a full version of iTunes on it so that I can sync
my iPhone or iPod with the iPad, making it
the only computer I would need!
Since getting my iPhone, I basically
use my computer for two things: First,
creating certain print-ready documents and
spreadsheets that are a pain to create on
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the iPhone. And second, syncing my iPhone.
That’s it!
If the iPad became the holder of my iTunes
and could support an external hard drive,
my need for a laptop or PC would ﬁnally be
over. This is what I’ve been waiting for since
watching Star Trek as a kid, and sadly, I’m still
waiting!—Stephen Mitchell
I noticed you said your iPhone was slow to
sync. I had the same issue, and it was because
I had too many photos on the phone. After I
backed up the photos and deleted them from
the phone, it was able to sync much faster.
Hope this helps.—Greg Helfand
I think iTunes is pretty much okay as is with
an exception or two. In 2007, I ripped my
1,700-plus CD collection into one of my Macs,
but I ﬁnd one thing missing. My previous
multi-CD changer would let me double-click a
song or album to add it, in order, to its playlist.
iTunes makes you drag and drop songs to a
playlist, which isn’t as intuitive. I also don’t like
Apple’s methodology for library organization
and use my own instead.—David Valentine
My biggest pet peeve is that it’s still called
“iTunes.” Tunes are only a small percentage of
what the app now does for me.—Jeff Truitt
I agree with your article, mostly with No. 3
(weak browsing options in the iTunes Store).
I used to be able to browse new music by the
week it was released for the previous month
or so. The new iTunes Store is more about
looking cool than helping me ﬁnd or explore
content, so I stopped buying music there.
iTunes is also starting to run extremely
slowly on older computers. Apple should offer
a smaller, feature-limited core installation for
people that just want to use it for a few simple
functions, and iDevice functionality should be

automatically added when a device is plugged
in for the ﬁrst time.—Martin Magaña
Wow! This is just a small sampling of the
feedback we got from Paul’s column, “Hey,
iTunes? This Is an Intervention!” and we
thank everyone for writing. iTunes handles
a ton of functions, and virtually everybody
uses it—which leads us to that old saying
about how you can’t please everybody.
Check out our feature “Turn iTunes Up to
11” on p32 to read about some tweaks and
tuning that’ll make iTunes 9 work much
better for you.—Ray

More Thoughts on Flash
After reading “Is Adobe a Flash Point?”
(Aug/10, p6) and Steve Jobs’ “Thoughts on
Flash,” I have a few of my own. As a PC user
for 16 years, I know all too well about thirdparty apps and programs causing instability
on the original platform. How many times do
you download a program that requires a plugin to run on your system? How many times
has a new program or plug-in been the ﬂy in
the ointment of your OS?
Our house has been 100 percent Apple
since 2008: iPods, MacBooks, iMacs, and
iPhones. I cannot express the level of
gratitude I feel toward Apple for developing
devices that just work. Turn it on, it works.
End of story. So if Steve Jobs is telling us the
truth and Flash will destabilize the iPhone and
the iPod touch, then I say kick it to the curb.
If Adobe wants to occupy the Apple mobile
platform, then Adobe should step up and
write something stable that does not use a
lion’s share of power! Why should Apple allow
an unstable piece of software on a system
that just works?—Shawn Barnhart
I think Apple is making a mistake with its
pi**ing contest with Adobe Flash. Apple does
so many things right, and so many of them
work right the ﬁrst time! I can, as a graphic
design student, say the same about
Adobe. My Mac came with the Adobe
Master Collection, and it’s all I’ll ever
need. I think it’d serve both Adobe and
Apple to get along.—Keith Coleman
Those of us old and grizzled enough
remember how it felt to be secondclass citizens and largely at the
mercy of big players like Adobe and
Microsoft. Back then, the thinking
was that the Mac would simply die

out, so why write software for it? Adobe
has an abysmal record of supporting the
Apple product line, and yet Paul even speaks
of Steve Jobs’ “ban” on Flash on the iOS
platform. At the time you wrote those words,
there was no Flash for any mobile platform,
yet somehow it is Apple that is banning Flash!
Flash is not the future. It is largely
unneeded now except for the ugly, intrusive
Flash ads! The most useful addition to my Mac
software is Click2Flash, and I hardly ever click.
I’ve never missed the mobile Flash that Adobe
promised more than two years ago on my
iPhone, and I certainly do not miss it on my
iPad.—Rick Pettys

computers, regardless of their individual
specs.—Rod Murphy
We heard a lot about this topic, and the
majority of writers supported Apple’s
decision. Rick’s comment above is
especially on point; Flash just isn’t ready
for prime time on mobile devices yet. And
to be clear, Paul’s editorial was entirely
concerned with how Apple is publicly
handling this matter; he agrees that Apple
made a good decision on Flash and iOS.
Besides, now that Farmville is in the App
Store, the debate should be over, right?
Isn’t farming virtual crops what Flash was
made for?—Robbie

I agree that Apple should tread very carefully
on how they tackle the Flash debate. I am
a budding web developer, but I am not
yet competent in Flash design. Still, I’m
conversant with the principles of web design,
and I fully appreciate what Steve Jobs is
saying. I personally believe that with the
further development of HTML5, CSS, and
JavaScript, eventually we will see a World
Wide Web with minimal Flash components.
In my experience, currently there are only
a small number of sites that will show the

Brothers In Arms

infamous “Flash Player required” graphics
and messages. The Flash elements also
generally don’t form the integral part of the
site (or shouldn’t), with the exception of video
players. And most major sites, I believe, are
converting their video formats to cater to
Apple’s devices anyway. With the development
of the video tag in HTML5, we could see the
total removal of the need for a Flash video
player altogether.
In short, I’m excited by the prospects of
using fewer “add-on” programs to develop
websites, which in the long term will be
accepted by more browsers and more
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Brothers In Arms: Double Time (Jul/10, p76)
is the latest game in the Feral Legends series.
Feral Interactive created the Legends label
to release older games that were critically
and commercially popular, but have not yet
had a chance to shine on the Mac. We tried
to provide Mac gamers with extraordinary
value by combining two games—Double
Time includes two separate episodes of the
Brothers In Arms series, Road to Hill 30 and
Earned in Blood. Consistent with other Feral
Legends releases, the retail price is $29.95,
below many other new commercial games. As
such, we think your reviewer misunderstood
the positioning of the game. He compounds
his conceptual error with ill-considered
criticisms of the game’s graphics and
preferences.
Feral worked in partnership with Gearbox
Software and Ubisoft, the game’s original
developer and publisher, respectively, to make
sure that Double Time for the Mac offers
an authentic Brothers In Arms experience.
As a matter of course, we must use the art
assets that we’ve been licensed to make
the game. Regarding preferences, while the
two episodes may look superﬁcially similar,
they’re actually quite different under the
hood. Sharing preferences between them was
simply not technically feasible.
We feel the game offers an equal balance
of price, performance, and entertainment
value often overlooked in higher-priced
games. Feral has earned a reputation for
bringing AAA games to the Mac with ﬁrstclass ports. We spend a great deal of time,
care, and money in that process. We are lucky
in that hitherto we have been able to rely on

a similar level of professionalism from the
magazines that review those games. In this
case, we feel that went missing, and that your
readers have been ill-served by an inaccurate
and misleading review.—David Stephen,
managing director, Feral Interactive
We have huge amounts of respect for the
hard work that companies like Feral put
into making their products. Unfortunately,
we don’t agree that Double Time represents
a good value. A quick check of Amazon
shows that the two games it bundles can be
bought as separate PC versions for a total
of under $20 new or under $4 used. Price
quibbles aside, as someone who’s reviewed
videogames for 15 years before coming to
Mac|Life, I’m a huge fan of the Brothers In
Arms series and have played every second
of it on other platforms, so I was rooting
for this game to make a big splash on
Macs, too. As our review already explained,
I’m disappointed with this version, and I
stand by the reasons for those criticisms.
Giving bad reviews is never fun, but we do
it because our readers deserve our honest,
considered
opinions,
whether the
product’s
creator
agrees with
them or
not.—Paul

Correction
In our review of Adobe Premiere Pro CS5
(Jul/10, p61), we mistakenly stated that the
Mercury Playback Engine is only available
with Nvidia cards. While hardware
acceleration only works with Nvidia cards,
software acceleration will work with any
video card.

WRITE TO US: letters@maclife.com or
Mac|Life, 4000 Shoreline Court, Suite 400,
South San Francisco, CA 94080
FOR SUBSCRIPTION QUERIES: Call toll-free
1-888-771-6222
By submitting unsolicited material to us, you grant Future a
license to publish the material in whole or in part in all editions
of the magazine, including licensed editions, in any and all media
throughout the world. Future is not responsible for loss, damage
to, or return of any unsolicited materials.

maclife.com SEP• 10

9

>>>Start

FEED YOUR MIND. FEAST YOUR EYES.

Mixing MuSic with thE iPad

Rana Sobhany, the world’s ﬁrst iPad DJ, discusses her new favorite hobby and how it
will pave the way for the next generation of electronic music makers. BY FLORENCE ION
It’s an uncharacteristically rainy spring day in San Francisco, and Rana
Sobhany is at the Hotel Kabuki preparing to go on stage at the SF Music
Tech Summit with her iPad. But this time, the iPad DJ isn’t on stage to
rile up a Saturday night crowd looking to get their groove on. Instead,
she’s demonstrating the beneﬁts—and limitations—of making music
with the iPad to a room full of music and tech geeks.
Sobhany has become
an iPad evangelist of
sorts, and her goal is
simple: To show the world
what this beefy, fullfeatured tablet can do
with a bit of investment in
the App Store and plenty
of practice. “Music and
technology have found
this beautiful point of
intersection where I can
do both of the things
I love,” she says. “You
add in the mix of mobile
[technology], and it’s a
wonderful time to be
where I am right now.”
The revelatory idea
of using iPads as a
substitution for turntables
came to Sobhany while
in line for the Wi-Fi iPad
back in April—a time
when Apple fans all
over the internet were
discussing the potential
capabilities of the longRana’s setup is light,
anticipated tablet device,
versatile, and did we
mention light?
including its ability to
substitute for musical
instruments. “The ﬁrst
things I did were to buy
these iPads, hook them
up, become a ninja with
[the music-making] apps,
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and learn what the restrictions are. And then, I ﬁgured out a way to
resolve them.” Sobhany has also ﬁgured out how to use the Camera
Connection Kit to power USB switches to connect things like drum pads
and a keyboard, which enables her to create music organically while
mixing it in with iPad apps. “It’s only been a month since I’ve been doing
this, and I don’t think people realize how hard it is.”
Sobhany’s YouTube
videos make iPad DJing
look easy because
the apps she uses are
available to anyone.
But it’s really more
than just dragging and
dropping beats in the
Korg iElectribe app,
or matching beats
per minute. Sobhany
also uses hardware to
synchronize both iPad
devices and record
them through her
MacBook Pro, including
a Numark M3 mixer and
three RCA-to-minijack
cables to connect the
iPads to the mixer and
provide audio ouput.
While she’s not
suffering back
strain from carrying
equipment up the
stairs, she stresses that
mastering the art of
iPad DJing still takes a
lot of hard work. “You
have to practice as if it’s
a real instrument. You
can’t just wake up and
buy turntables and say,
‘I’m a DJ.’”
Sobhany creates
music samples on

Rana’s YouTube video
(posted by Scobelizer) got
more than 500,000 views
in just over a month.

her Mac with a Roland Fantom G7 electronic keyboard and the music
production software Logic. She imports them to her iPad via Wi-Fi
or Bluetooth with apps like Looptastic, though limitations with the
transfer rate between the iPad and her computer limit how quickly
and frequently she can upload samples. Sobhany has also utilized her
savvy tech skills to work on implementing organic sounds into her
music with the app AmpliTube (see Aug/10, p54) and her electric guitar.
This is one dexterous techie who’s furiously testing every possible
way to make music with the iPad. “When the ﬁrst person realized that
you could scratch on vinyl, they weren’t great, they just ﬁgured it out.
And then, this art form developed around it. With practice, with time,
with better apps, with
better peripherals, there’s
going to be this
great ability to use
iPads in music
production.”
“When the ﬁrst person
Sobhany
also managed
realized that you could
to ﬁgure
out the iPad’s
scratch on vinyl, they
inabilities
by trial and
weren’t great, they just
error,
as well as
ingeniously
trolling through
ﬁgured it out. And then,
the iPhone
OS
3.2 SDK.
this art form developed
“When you
look at the SDK,
around it.”
you can see
that the capabilities
exist, they’re
just not activated
yet.” She recalls the
frustrations with her iPad,
like the frequent crashes caused by the Camera Connection Kit, as well
as the device’s inability to record multitrack recordings.
Still, there is so much more to making music than simply piecing
together samples in a $10 app. Sobhany wants aspiring DJs to realize
that they have a cheaper alternative to ﬁguring out if this kind of music
making is really their thing. “I couldn’t afford turntables just to ﬁgure
out I didn’t even like it. If that’s going to be somebody’s entrance point,
it’s very important that the iPad is presented as an alternative.”
Sobhany believes the iPad’s real beauty is how it can inspire others
to make music by taking advantage of the device’s versatility. “I truly,
from every ounce of my being, believe that this is the future of music,”
she says. “I think it’s going to be mobile, portable, compact, all-inclusive,
and have everything on it.” Because of the iPad, Sobhany has actually
invested in a real pair of turntables. “I look at it as an additional element
in my arsenal,” she says. “If I know what it’s like on the turntables, it
helps me understand how I can make it work better on the pad.”
In June, Sobhany returned to San Francisco for a WWDC party. This
time, she was on stage with her entire iPad DJ setup performing for
hardcore Apple nerds and electronic music lovers. However, Sobhany
knew that it was going to be a challenge getting the crowd to follow
her beat, and wasn’t surprised that they met her with uncertainty at
ﬁrst. “I know that it’s not the same as when I’m making music using
my computer. It’s an experiment for that exact reason. I know that it’s
something that has a long way to go.”
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GET THE PARTY STARTED
Interested in creating your own music with your trusty iPad?
Rana Sobhany shows you how in ﬁve easy steps.
1. BUY TWO IPADS
Two “turntables” are standard in any DJ setup, so be sure to
purchase a pair. It will cost you $1,000.
2. BUY A MIXER
Choose a mixer. I really like Numark mixers, and I use a
Numark M3 in my current setup.
3. GET CONNECTED
My setup consists of three RCA-to-minijack cables. Two of
the minijack inputs go into the iPads, and the RCA cables get
plugged into the back of the mixer. The third cable is for audioout, and I always keep a 1/8 inch–to–1/4 inch adapter handy in
case the speaker system requires a different-sized cable.
4. PICK YOUR POISON
Decide what kind of music you want to make and download
some apps that correspond to it. Fortunately, approximately
5,000 apps are available for download on the iPad store, and
most iPhone apps work on the iPad as well, so the possibilities
are endless. If you’re into hip-hop, for instance, download the
IK Multimedia Groovemaker Hip-Hop app and start from there.
You can always download and install new apps, so get creative
with your arsenal of sounds and loops.
5. PRACTICE, PRACTICE, PRACTICE!
If you’re already a DJ, practice using the touchscreen and
adjust to the lack of hardware controls on the apps. If you’re
a beginner, learn timing and matching beats per minute
between the iPads. Becoming familiar with the sound libraries
is paramount to controlling the sounds you’re creating. Spend
the time incorporating various elements and testing out
different apps.
Then you’re
ready to ﬂex
your iPad DJ
muscles!

The Korg
iElectribe app
($9.99) is one of
Rana’s favorites.
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Future StarS:
e3’S
BeSt
Mac
&
iOS
GaMeS
This year’s gaming über-expo had plenty for the Apple crowd
to get excited about too. By SUSIE OCHS

T

he Electronic Entertainment Expo (E3) is a gamer’s paradise—it’s the annual trade show extravaganza where all the big companies trot
out their coolest games and newest, most innovative hardware. Problem is, the vast majority of it is for Nintendo Wii and DS, Xbox 360,
PlayStation 3, and our old friend the PC. Most—but not all. For two foot-punishing days, I scoured the show ﬂoor and the maze of meeting
rooms in search of the best Mac, iPad, and iPhone games E3 had to offer. And this year, the getting was good.

POrTal 2

lEgO UnIvErSE

Valve pulled lucky journalists into a tiny, dark room to show off new
gameplay videos of puzzle-action sequel Portal 2 (thinkwithportals
.com), just days after announcing its delay until 2011. Even so, the
footage made me salivate. Valve has dreamed up tons of new portal
types, gameplay mechanics, Escher-esque puzzles, and even a twoplayer co-op mode from the perspective of a pair of robots. Valve’s Erik
Johnson explained, “People were already playing Portal as an unofﬁcial
co-op,” just in the you-play-I-watch sense; the new mode will give each
player their own set of portals, and you can travel through all of them.
Portal 2 will land on Mac and PC simultaneously next year via Steam.

This MMO (universe.lego.com) should appeal to anybody who’s ever
stuck two Lego bricks together, especially if you also dreamed up
elaborate backstories and adventures for your Lego friends. Lego
Universe combines all the questing of a huge MMO with the unlimited
creative potential of constructing your own Lego planet using the
bricks you ﬁnd throughout the lush game world. Your friends can
come visit your creation, and you can even use a basic programming
language to bring Lego creatures to life. The polish, creativity, and
completeness (every Lego brick ever made?!) simply blew me away, and
I can’t wait for its October 26 release on Mac and PC.
Portal 2

Portal 2

OnlIvE
OnLive’s “games on demand” service had a big presence at the
show with hands-on demos running on MacBooks and PC laptops,
streaming games from a data center 400 miles away. But sure
enough, they played as well as if they were installed on the Mac in
front of us, delivering smooth controls and no noticeable lag. Xboxstyle gamepads worked ﬂawlessly, and OnLive’s extra services, like
game spectating and video “brag clips,” were up and running. The
launch details announced at E3—free service for two years, not
including game rentals or purchases; see onlive.com for details—
and the service’s initial lineup sweeten the deal. We’ll have a full
review in the October issue, and you can follow OnLive coverage at
maclife.com/tags/onlive.
Spectating a game of Mirror’s
Edge in Onlive
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lego Universe

TELLTALE GAMES
Indie publisher/developer Telltale showed off its new puzzle-based
point-and-click adventure Puzzle Agent (puzzleagent.com), a
collaboration with cartoonist Graham Annable. The unique hand-drawn
style and delightful voice acting pulled me into the dark, mysterious
story of agent Nelson Tethers of the U.S. Department of Puzzle
Research, on assignment in frozen Minnesota. Released in June, Puzzle
Agent is $9.95 for Mac, but planned iPad and iPhone versions weren’t
yet live in the App Store at press time. Telltale also giddily unveiled a
new deal with Universal to create games based on Back to the Future
and Jurassic Park, planned as multi-game, episodic “seasons” in true
Telltale style, starting with Back to the Future this winter.

Kid Icarus:
Uprising for
the Nintendo
3DS

NINTENDO’S 3DS:
AN iPOD TOUCH KILLER?

Puzzle Agent

iOS GAMES
Disney Interactive’s Jelly Car 2 was incredibly hard to tear myself away
from—its bright and cheery hand-drawn style belied a deep, physicsbased puzzler that even lets you create your own levels. It’s $2.99 for
the iPad and 99
cents for iPhone
and iPod touch.
Capcom’s Street
Fighter IV ($9.99)
for iPhone and iPod
touch is great as
ever, especially with
a new update that
adds Cammy and
Zangief. And Venan
Entertainment
showed off its
addictive iPhone
climbing adventure
Ninjatown: Trees
of Doom! ($1.99),
as well as an indevelopment iPadnative version.

Ninjatown: Trees of Doom!
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Nintendo’s press event was a ﬂashy, Steve Jobs–caliber show
featuring lavish trailers, impressive gameplay demos, and
videogame superstars like Shigeru Miyamoto (the creator of
Mario and Zelda) and Nintendo president Satoru Iwata. But
the showstopper was the Nintendo 3DS, a new two-screened
handheld gaming system that boasts a glasses-free 3D screen
on top and a touchscreen on the bottom. Two outer cameras
let it take 3D photographs, and it has an accelerometer and
gyroscope for motion-based game controls, as well as an
analog stick, four buttons, and a D-pad. Wireless connectivity
lets it download game updates and exchange data with other
3DS units, even while asleep. With features like that, the
subtext was clear: Sony’s PSP is in the handheld gaming’s
rearview mirror, and the 3DS is targeting iOS devices as its
main competition. So how does it measure up?
The addition of the motion controls open iPod touch–like
gameplay possibilities not possible in older Nintendo handhelds,
and the no-glasses-required 3D screen is no gimmick. Jawdroppingly crisp, it even has a slider that lets you dial down the
effect or turn it off entirely. “The moment you approach the
machine, it’s like peering into a window, not so much a screen,”
wrote our colleagues at GamesRadar.com. “There’s genuine
depth with objects and backgrounds, yet there’s next to no eye
strain even on the highest 3D setting.”
The 3DS, set to launch in March 2011, already has robust
publisher support, including Electronic Arts, Capcom, Konami,
Namco Bandai, Sega, Square Enix, Ubisoft, and tons more—and
Nintendo hits like Animal Crossing, Nintendogs + Cats, Mario
Kart, Kid Icarus: Uprising, and others will only lure in more
gamers. Apple boasts that the App Store features vastly more
“game and entertainment” titles than the Nintendo DS line and
Sony PSP can play, but that “entertainment” category pads the
total with fart apps, horoscopes, and other non-game nonsense.
Still, downloading iPod touch games for 99 cents, $3, or even
$10 a pop is still a cheaper and easier way to play than buying
$20 to $30, physical-object Game Cards for your 3DS.
Ever-polite Nintendo declined to utter the words “Apple,”
“App Store,” or “iPod touch” in its whiz-bang presentation. But
the unofﬁcial battle for handheld gaming supremacy is deﬁnitely
on, and it’ll be nearly as exciting as a new Zelda game.
maclife.com SEP• 10
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MAKE CHEAP
iPHONE
RINGTONES
Pick the best way to create your own
ringtones from our list of nine favorites.
BY ZACK STERN

W

ith every new iPhone, a chorus of familiar questions
arises: “How do I get more ringtones? How much do
they cost?” Put your wallet away. We know not one,
not two, but nine great ways to make ringtones on the cheap.
Most are free or use software you already own. When ﬁnished,
just drag the ﬁle to iTunes to prepare it for sync.

One purchased ringtone (what were we
thinking?) and dozens of customs. No
boring rings for us!

RECYCLE AN iTUNES STORE PREVIEW
CHANGE THE EXTENSION
The iPhone uses the .m4r ringtone format. Ringtone ﬁles are so similar
to the standard AAC (.m4a) ﬁles already in your library, you can just
change the three-letter extension to .m4r to make them work. We
recommend that you ﬁrst trim the songs to your perfect ringtone
length within iTunes. Check out bit.ly/byArAO for more details.

You can turn any 30-second song sample within the iTunes Store into a
ringtone. Right-click the headline in an album’s iTunes Store page, and
pick Copy Link. Paste the link into a web browser. iTunes will reopen the
page; ignore it and return to the browser. Select View > Page Source,
and search for “.m4a”. Look to the right of the highlighted text; if that’s
the name of the song you want, copy the full URL attached to .m4a,
such as http://a1.phobos.apple.com/us/r1000/028/Music/05/c2/24/mzi
.mtwarvhw.aac.p.m4a. (If the ﬁrst .m4a result isn’t the right song, keep
searching.) Open the URL in a new webpage. Click the down triangle all
the way to the right of the play bar, and pick Save As Source. You now
have the 30-second preview clip as an AAC; turn the .m4a extension
into .m4r to make it a ringtone.

Just swap in .m4r to rock the ringtone.

TAP INTO ANY AUDIO
Capture audio from any program on your Mac and use the other
methods here to make the ringtone. Audio Hijack Pro ($32,
rogueamoeba.com) and WireTap Studio ($69, ambrosiasw.com) record
any sound, such as a streaming Hulu show—and they come in handy
for non–ringtone recording too.
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Once you isolate the preview on a webpage, you can save it to your hard drive.

FIND SONGS ONLINE

CONVERT IN YOUR BROWSER

You can ﬁnd countless songs and ringtone ﬁles online. To speed up your
search, visit Google, and use the term “ﬁletype” to narrow down hits.
For example, try “Black Eyed Peas ﬁletype:m4r” or “Black Eyed Peas
ﬁletype:m4a”. The former will come up with premade ringtone ﬁles, and
the latter will show songs you can convert. And yes, ringtones should
use the most obnoxious, bombastic bands possible.

Upload your favorite song in any format to Audiko (audiko.net)
to convert online. You’ll even trim the length and set fades. As an
alternative, download one of the many premade ringtones already
available at the site. You’ll ﬁnd other similar websites, but we like
Audiko because you can complete the process without entering any
personal information.

USE A YOUTUBE CLIP
Find a great YouTube clip—we recommend Auto-Tune the News, as
usual—and convert it into a ringtone. Many utilities download YouTube
clips, but the free service Tube2Tone.com automatically converts your
selection into the ringtone in your browser.

Click “Create ringtone” after making the selection.

GO QUICKTIME PRO
QuickTime 7 Pro ($29.99, apple.com)
makes simple edits and can convert
ﬁles to .m4r ringtones. It’s a great
option, especially if you own it already.
Visit the MacLife.com article found at
bit.ly/b6nrGb for more details.

Every ringtone sounds better Auto-Tuned.

TURN TO AN AUDIO EDITOR

DOWNLOAD FREE OR CHEAP SOFTWARE

An audio editor can craft precise edits that
will loop smoothly, and you can just export
as an .m4r when you’re ready. Turn to iLife’s
GarageBand ($79, apple.com), Sound Studio
($79.99, freeverse.com), or Fission ($32,
rogueamoeba.com). For instructions on
creating ringtones with GarageBand,
visit the MacLife.com article
at bit.ly/b6nrGb.

Freeware and shareware ringtone utilities are ideal if you want to make a lot of
ﬁles. Try MakeiPhoneRingtone (free, rogueamoeba.com/freebies/), iFuntastic
(free, ifuntastic.com), Ringer ($15, pixelresearchlabs.com), iToner 2 ($15,
ambrosiasw.com), or iPhone Ringtone Maker ($19, iskysoft.com).

Editors care about an Oxford comma. That’s who.
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SHAREWARE PICKS
BACK TO SCHOOL
Look at the big brain on Mac!

Study for Mac 1.2

Mental Case

bloo7, bloo7.com
Price: $29.95 ($14.95 for teachers and students)

The Mental Faculty, macﬂashcards.com
Price: $29.99 ($19.99 for teachers and students)

Master tricky subjects with Study’s customizable ﬂashcards.
Smart sorting will prioritize any ﬂashcards you missed the last
time. And the desktop app syncs with Study Flashcards HD for
iPad ($2.99) and Study Flashcards for iPhone and iPod touch
($2.99)—how intelligent.

Mutter the
answer to
yourself,
then click
Show Answer
and score
yourself
with Right
and Wrong
buttons

WIN

Mental Case can import ﬂashcards from online source Flashcard
Exchange (ﬂashcardexchange.com) or from comma-separated,
tab-separated, and Study Archive ﬁles. You can also sync cards
wirelessly to Mental Case Flashcards for iPad ($7.99) or Mental
Case Flashcards for iPhone and iPod touch ($4.99), or easily
create new cards
on your device.

Study at your
Mac or on the
go, thanks to
companion apps
for the iPad
and iPhone.

You Rise to the Challenge
We Reward You with Cool Prizes

PowerPoint and Laugh
When we snapped this shot of the PowerPoint logo dancing at Macworld
Expo, we couldn’t resist having a little fun. So we asked you guys to
write a caption for it.
After wading through the
entries—some of which
we deﬁnitely couldn’t print
in the pages of this familyfriendly magazine—our
favorite was this entry
from Andrew Schroeder:
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Andrew’s prize is the i1166
multimedia player from iLuv
($299.99, i-luv.com), which
he can use to play content
from an iPod, DVDs, USB ﬂash
drives, or SD cards on the 8.9inch widescreen display.

>>>>

Who’s got
two thumbs
and wishes
he was
Keynote?
This guy!

OUR
CONTESTS
HAVE MOVED!
For details on this
month’s contest, visit
www.maclife.com/
Sep_10_Win. This month,
we’re giving away a pair
of Beats by Dr. Dre Solo
from Monster ($199.95,
beatsbydre.com), direct
from the Mac|Life test
lab. We liked them so
much, Ray gave them
four stars
back in
June
(p58).

Problems?
Fix them yourself and save
money on costly repair bills.

Save Money! Install TechTool Pro Now!
• Keep your computer running smoothly.
• Help prevent problems in the future.
• Fix most of your problems on the spot.

Also From Micromat

DiskStudio &
TechToolProtege

Micromat, Inc., 5329 Skylane Blvd., Santa Rosa, CA 95403, USA
800-829-6227 707-566-3831 info@micromat.com www.micromat.com

AcademicSuperstore.com

campustech.com

frys.com

drbott.com

bestbuy.com

navarre.com

macmall.com

store.apple.com

©2009 Micromat, Inc. All rights reserved. TechTool is a registered trademark of Micromat, Inc. DiskStudio and Protege are trademarks of Micromat, Inc.
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Crave

the gear we’re lusting after…this month

ROBERTO
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iCrystal DoCking station
speakal.com
$79.99

>>>When I want to listen to music in the
kitchen, I usually just turn up my iPhone
and throw it in a bowl. It works okay, but it’s
hardly high ﬁdelity. The iCrystal promises
(much) better sound than my DIY bowl
speaker, and it looks a lot classier, too.

FLORENCE

Goflex Desk
seagate.com
$249.99
>>>You can never have enough storage.
Seagate’s new 3TB GoFlex Desk offers the
massive storage I need. Plus, the swappable
adapters mean I can use it to share ﬁles
between my USB 3.0–equipped PC and my
Mac with minimal fuss.

PAUL

6150
kodak.com
$229.99
>>>It prints, scans, faxes, and copies. And at
up to 32 pages per minute, the 6150 makes
a great home ofﬁce machine. Plus, the free
Kodak Pic Flick app can print photos directly
from your iOS device. Sweet!

SUSIE

i4
idaptweb.com
$59.99
>>>iPhone, iPad, digital camera…and all of
those require their own separate charger. The
i4 from iDapt can charge four devices at once
and sports interchangeable adapters, making
it future-proof. And hopefully, it’ll also put
an end to those constant searches for power
cables at home.

NIC

hf3
etymotic.com
$179
>>>In-ear headphones usually don’t work
for me because they just don’t stay in my
ears. Etymotic’s new hf3 headset promises
great sound, and for an extra 100 bucks, the
new Custom•Fit earmold program makes a
personal ﬁt affordable for average Joes with
picky ears.
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The iPhone 4 is a quanTum LeaP forward—a TruLy nexT-LeveL device. To heLP you
geT The mosT ouT of aPPLe’s LaTesT innovaTion, we’ve Packed This guide To iPhone
4, ios 4, and mobiLe imovie wiTh surefire TiPs and Tricks guaranTeed To make you a
Power user in no Time. BY THE MAC|LIFE STAFF

L

PHOTOGRAPHY BY MARK MADEO

ining up for the new iPhone has become
part of the rhythm of our summers. As
the days grow longer and shorts weather
settles in, we all check our upgrade status and
decide whether Apple’s latest smartphone is in
our near future or perhaps a bit farther off. But
this summer, the iPhone 4 changed all that. As
our deﬁnitive review on the next page reveals,
the iPhone 4 is not the minor upgrade we saw last
year. It’s a massively improved smartphone that’s
also a top-shelf pocket camera and camcorder
with slick features like FaceTime, which opens up
new frontiers in communication. Even the new
iOS 4 delivers critical upgrades that pay off in
big ways.
That’s why we focused the rest of this story on
getting the most out of the iPhone 4. We’ll show
you the best new hardware features and delve
deeply into iOS 4 to make sure you maximize
the power lurking in its nooks and crannies. And
since those spiffy HD videos are our favorite part
of using the iPhone 4, we wrap up with an expert
guide to shooting and editing great footage so
you can capture and enjoy all the good times that
summer—and the rest of the year—bring.
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iPhone 4

the iPhone 4 review
the hype swirling around the iPhone 4 has been unmissable.
But is apple’s newest smartphone really that great? to ﬁnd out,
we put three of them through an extensive regimen of testing,
tapping, taking pictures, and much more.
The iPhone 4 isn’t particularly well-named.
That’s because one of the things you’ll
use this ingenious little device for least is
making boring old phone calls. Between the
terriﬁc dual cameras, the zippy performance,
and the luscious Retina Display, we were
quickly absorbed in photography, games,
web-browsing, and loads more. It’s truly a
dramatic leap forward from the not-shabbyat-all iPhone 3GS.
Point-n-Shoot Star
With so many meaty new features, it’s hard
to play favorites, but after a couple weeks of
use, the dual cameras emerged as the iPhone
4’s biggest upgrade. The rear camera gives
you 5-megapixel still photos and 720p video,
and our test shots produced impressive
results. That’s in part because Apple began
using a back-illuminated sensor in the iPhone
4’s camera, which is techno-jargon for a more
sensitive, er, sensor that lets you capture

remarkably crisp, detailed shots in even
low-light settings. In fact, the new LED ﬂash
really only trips for fairly dark scenes—and
you’ll want to do your best to avoid using it
because its harshness often washes out a lot
of detail. When shooting video, the main thing
to remember is there’s no stabilizer, so if you
get jiggly with it, you’re in for some seriously
shaky footage. But the overall quality of
photos and video is fantastic—so much so
that I stopped carrying around my nowredundant point-n-shoot.
But that’s just half the story. The front
camera is 640x480 VGA quality (or roughly
0.3 megapixels), so it works decently for
those casual self-portrait moments. But
where it really struts its stuff is during
FaceTime calls. Once you enable these video
phone calls in the Settings menu, they “just
work” in that effortless Apple way. True,
FaceTime calls are only possible over Wi-Fi,
but that wasn’t a problem as we mostly used
this feature at home with family (where
Wi-Fi is always available). In that setting,
we particularly loved the ability to switch
to using the rear camera to show off, for
example, the antics of our kids for the loved
ones on the other end of the line. We did
make a few business calls with FaceTime,
including one cross-country conversation
to New York, and video calls always
performed smoothly for us, though
the picture sometimes gets
blurry. Still, it’s downright
awkward to stare at
a colleague or

someone you’ve never met before during a
call. But that’s not Apple’s fault—it’s just a
cultural truth of the moment.
PowerhouSe Performer
When it comes to horsepower, the iPhone 4’s
A4 processor and 512MB RAM make it feel
speedy and agile. That impression was backed
up in our lab, where it sailed through our tests,
posting performance gains of 164 percent
over a 3G running iOS 4 and 34 percent over
a 3GS running iOS 4 in the benchmarking app
Geekbench 2. That power is put to excellent
use with iOS 4, which delivers great new
features like multitasking, folders, a uniﬁed
email inbox, Bluetooth keyboard support, and
loads more. (Turn to p24 for our in-depth
guide to all that iOS 4 has to offer.)
Moving through the other key specs, our
battery rundown (playing video at 50 percent
brightness and 50 percent volume) clocked
in at 10.67 hours on a brand-new device,
and while that’ll decline over time as battery
capacity diminishes, this battery sure comes
out of the gate with a bang.
Better yet, the new Retina Display is one
of the sharpest-looking we’ve ever seen,
and at 326 pixels per inch, it should be. The
3.5-inch screen is the same size as the 3GS’s
but packs in four times as many pixels. While
its superpowers don’t extend to defeating
bright sunlight (which washes it out, as the
sun’s glare does to every display we’ve taken
outside), it’s noticeably more clear, detailed,

Holding the phone at the proper angle for a
FaceTime call can get kinda awkward…
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The front camera is perfect for self-portraits (above left), while the rear lens shoots vivid, detailed stills (above right) that rival many point-n-shoots.

and just plain pretty than anything you’ve
seen on a mobile device before. All told, that’s
a lot of pep in a fairly small box.
RAISE YOUR ANTENNA
Speaking of which, our biggest complaint
about the iPhone 4 is that its boxy shape just
doesn’t sit as comfortably in the hand as the
beveled edges of its
predecessors did.
HAVE AN
iPHONE 3G OR
Don’t get us wrong—
3GS TO SELL?
the iPhone 4’s design
is gorgeous, and
If you don’t have a
we love the look of
family member who’s
its steel band and
eager to relieve you
the crisp action of
of your old iPhone, we
the new volume
have the skinny on how
buttons. But between
to prep your old phone
that boxiness and
for sale and where to
get the best price at
the oleophobic
maclife.com/ﬁre-sale.
coating on the
aluminosilicate glass,
the iPhone 4 feels slippery and harder to grip
than its predecessors, especially when taking
photos. Still, that’s a fairly small downside,
and on the whole, the elegant design quietly
convinces you that you’ve got a high-quality,
carefully constructed device in your hands.
And yes, that means the widely publicized
“death grip”—where gripping the iPhone
around the black band in the lower-left corner
of its steel siding seems to disrupt its 3G
connection—is not our biggest complaint. At
the end of the day, the iPhone 4 absolutely
must function as a phone, and in our testing,
we detected a noticeable improvement in call
performance. Unfortunately, Apple removed
the ﬁeld-test mode from this model of phone,
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so we had to make day-to-day observations
of its phone-calling prowess rather than
crunching hard numbers. I spent a week using
an iPhone 4 with one of Apple’s Bumpers
(which, like other cases, blocks the “death
grip” effect) and another using it without one
in a remote-ish area with deﬁnite patches in
AT&T’s coverage, and found no difference.
At the same time, I dropped fewer calls than I
did in the same area with my old 3G. So while
it hardly added up to a gigantic improvement
in AT&T’s generally poor service in the San
Francisco Bay Area, the iPhone 4 kept me
talking a little more reliably.
At press time, Apple held a press
conference to address snowballing concerns

about the “death grip.” While Steve Jobs
staunchly defended the iPhone 4’s hardware
and its antenna, Apple also announced that
anyone buying an iPhone 4 before September
30 could get a free case at apple.com, and
anyone who’d already bought an Apple
Bumper would get a refund. Also, iPhone 4s
can now be returned within 30 days with no
restocking fee. While that’s a mixed message,
we understand that Apple’s trying to quell
consumer concerns while working on a ﬁx for
what we’d guess is a software issue. So we’re
giving the iPhone 4’s calling performance the
beneﬁt of the doubt for now, but we’ll update
this review and score if needed as this unfolds.
The bottom line. The iPhone 4’s impressive
leaps in performance, its hefty roster of new
features, and that lovely screen cement its
position as a powerful pocket computer and
camera that also makes phone calls. Whether
you just bought a
iPHONE 4
3GS last year or
you’re considering
your ﬁrst iPhone
purchase, it’s the
kind of essential,
must-own device
that you’ll delight
in using every
day.—Paul
Curthoys

Folders are the iOS 4 feature we gravitated to
ﬁrst, but once you learn the ins and outs of the
multitasking bar, it’s pretty handy too.

Apple
apple.com/iphone
Price: $199 for 16GB model;
$299 for 32GB model
Requirements: Two-year AT&T
contract with monthly plan starting
at $64.99. Mac OS 10.5.8 or later,
iTunes 9.2 or later.
Fantastic new dual camera with
ﬂash enables 5MP stills, HD video,
and FaceTime calls. Gorgeous
screen. Signiﬁcant battery-life
improvements. Zippy A4 processor
runs iOS 4 smoothly. Better, faster
3G and Wi-Fi connectivity. Lovely
design.
AT&T is sole U.S. carrier. Doesn’t
sit in hand as comfortably as older
iPhones. Glass ﬁnish is slippery and
smudgy. Must be docked to upload
HD video to YouTube.
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Tap the Power of iOS 4
Apple tells us that iOS 4 adds more than 100 new features, which means you’ve got a lot to learn!
Fortunately, we’ve done all the work for you—just check out our in-depth guide to getting the best
features of the new iOS up and running on your iDevice. BY ROBERTO BALDWIN

MULTITASKING
The biggest new toy in iOS 4 is multitasking,
which means you can have more than one
app running at a time. Want to listen to
Pandora while checking your email? iOS 4
can do that. To see which apps are running
and quickly switch between them, doubletap the Home button, then tap your app of
choice and it’ll load. Magical! But…each app’s
developer must update their app to specify
how it behaves when multitasking, and until
that’s done, apps just relaunch from scratch. So the fully glory of this
feature will take time and lots of app-updating to emerge.

iPOD CONTROLS
Prior to iOS 4, when you double-tapped the Home button, you were
presented with the iPod controls. Now that multitasking has taken
over the Home button double-tap, it’s done differently. To reach the
iPod controls, double-tap the
Home button, and when the
multitasking drawer pops up,
slide to the far left—wham,
there they are. Bonus #1: You can control audio apps like Pandora
from the iPod controls in the drawer. Bonus #2: If your iPhone is
locked, the double-tap still brings up the iPod controls.

PICK A SEARCH ENGINE
Tired of Google? You can switch to
Yahoo or Bing for all your search
needs. Navigate to Settings > Safari >
Search Engine, pick your search
engine of choice, and have a nice day.

PUSH MESSAGES
If you receive more than one push message,
they’ll stack up in front of each other. Close
one, and an earlier one will appear.
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QUIT AN
APPLICATION
Multitasking is great, but sometimes you
want to quit a program. First, enter the
multitasking drawer by double-tapping
the Home button. Tap and hold on an app
icon. The apps will begin jiggling, and a
red circle with a minus sign will appear in
the top-left corner. Tap on that red circle to close that app.

PORTRAIT-ORIENTATION LOCK
Tired of your iPhone switching to landscape in your favorite apps?
You can now lock the orientation of your iPhone so it stays in
portrait mode. Double-tap
the Home button to bring
up the multitasking drawer,
swipe to the far left, and
you’ll see the orientation lock to the left of the iPod controls. Tap
it to lock in portrait mode, and note that you can now see the
orientation-lock status in the menu bar.

MORE SEARCH
Instead of launching Safari to search the
internet or Wikipedia, you can do it from
Mobile Spotlight. Navigate to the Search
screen from the main Home screen by swiping
your ﬁnger to the right across the whole
screen. Type in what you’re looking for, and
you’ll be given the option to choose the web
or Wikipedia. Mobile Safari will launch and take
care of biz from there.

YOUTUBE VIDEOS
IN PORTRAIT MODE
Widescreen too wide for you? Now you can
watch YouTube videos in portrait mode—just
hold your phone that way.

Unbeatable power protection
now beats energy costs, too.

Only APC Back-UPS delivers unsurpassed
power protection and real energy savings.
Today’s cost-saving Back-UPS
For years you’ve relied on APC Back-UPS™ to protect your business from expensive
downtime caused by power problems. Today, the reinvented Back-UPS does even more.
Its highly efficient design noticeably reduces energy use, so you start saving money the
minute you plug it in. Only APC Back-UPS guarantees to keep your electronics up and
your energy use down!

Unique energy-efficient features
Power-saving outlets automatically shut off power to unused devices when your
computer and peripherals are turned off or on standby. Automatic voltage regulation
(AVR) adjusts the undervoltages and overvoltages without using the battery. With
our patent-pending AVR bypass, the transformer kicks in only when needed and
automatically deactivates when power is stable. Plus, APC’s highly efficient designs
reduce power consumption when power is good and extend runtimes when the lights
go out. Together, these power-saving features eliminate wasteful electricity drains, saving
you about $40-50 a year. And managing today’s Back-UPS couldn’t be easier thanks
to an integrated LCD that provides diagnostic information at your fingertips.

Trusted insurance for all your business needs
The award-winning Back-UPS provides reliable power protection for a range of
applications: from desktops and notebook computers to wired and wireless networks to
external storage. The reinvented APC Back-UPS is the trusted insurance you need to stay
up and running and reliably protected from both unpredictable power and energy waste!

Keep your electronics up
and your energy use down!
Back-UPS models are available with the features and runtime
capacity that best suit your application, and many models have
been designed with power-saving features to reduce costs.

The high-performance Back-UPS Pro series
High-performance Back-UPS Pro units deliver cost-cutting, energy-efficient
features. Power-saving outlets automatically shut off power to unused devices
when your computer and peripherals are turned off or on standby, eliminating
costly electricity drains. (BR700G shown above)

The energy-efficient ES 750G
The ES 750G boasts innovative power-saving outlets,
which automatically shut off power to controlled
outlets when the computer plugged into the
host outlet is deemed asleep, eliminating wasteful
electricity drains.
• 10 Outlets • 450 Watts / 750 VA
• 70 Minutes Maximum Runtime
• Coax and Telephone/Network Protection

The best-value ES 550G
The ES 550G uses an ultra-efficient design that
consumes less power during normal operation
than any other battery backup in its class, saving
you money on your electricity bill.
• 8 Outlets • 330 Watts / 550 VA
• 43 Minutes Maximum Runtime
• Telephone Protection

TM

Enter to win one of seven Back-UPS BR 700G units (a $130 value)!
Visit www.apc.com/promo Key Code t211w • Call 888-289-APCC x8319 • Fax 401-788-2797
©2010 Schneider Electric Industries SAS, All Rights Reserved. Schneider Electric, APC, Legendary Reliability, and Back-UPS are owned by Schneider Electric, or its affiliated companies in the United States and
other countries. e-mail: esupport@apc.com • 132 Fairgrounds Road, West Kingston, RI 02892 USA • 998-2510
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FOLDERS

COPY VS. SHARE IMAGES

If you’re running out of home screens for all your apps or if maybe
you just want a better way to organize your apps, folders are a
great feature. Tap and hold on an app to start your apps jiggling.
Drag two apps together to create a folder.
While your iPhone will create a folder and
automatically give the folder a name based
on the category of the apps inside it, you
can also change the name to something
more appropriate. You can then drag up to
12 apps into your folder. To remove an app
from a folder, open the folder, tap and hold
on the app you want to remove, and drag it
out of the folder.

With iOS 3, you could copy as many photos as your iPhone’s
RAM could handle into an email, but with iOS 4, Apple closed that
loophole. Now you can only copy ﬁve images into an email and nine
into an MMS. Before sending the email, you’re given the choice of
image size. If you’re still interested in sending more than ﬁve images
in an email, you work around
these limits by copy-pasting
ﬁve images at a time into an
email. In other words, copy
ﬁve images, paste them into
an email, then copy-paste ﬁve
more and repeat until done.

FOLDERS IN iTUNES
If the idea of creating folders and moving apps around on your
iPhone’s small screen gives you cold sweats, don’t worry. You can
also create and edit folders within iTunes on your Mac. Plug your
iPhone in, click on the Apps tab in
iTunes, and drag your apps in and
out of folders until you’re satisﬁed
with your app placement. Don’t
forget to hit the Apply button
when you’re done!

A BETTER, STRONGER INBOX
If you have multiple email accounts, you know what a pain it is
to check the inbox of one account, then back out of that account
and check the inbox of another account.
Thankfully, Apple recognized this and
created a uniﬁed inbox for the Mail app,
which neatly lumps all your inboxes into one
mega-inbox. If you prefer more separation,
your life will still improve with iOS 4 thanks
to the fast-inbox access, which lets you
go directly to the inbox of a speciﬁc email
address. These options appear at the top of
Mail’s main screen.

HOME SCREEN WALLPAPER
To place a background image on your home screens, navigate to
Settings > Wallpaper. Click on the wallpaper and choose either the
iPhone’s wallpaper choices or an image from your Photo library.
Once you’ve chosen an image, click
Set. From there, you can choose
to place it as a lock screen, a home
screen, or both. You can also choose
an image from your Photo app and
click the Share button. Then just
choose Use as Wallpaper.

SPELL CHECK
In addition to auto-correct and
its ability to take your anger and
transform it into “he’ll,” iOS 4
now tells you when a word is
spelled incorrectly by placing a red
scribble line underneath misspelled
words. To change the spelling of your misspelled word, tap it once,
and the iPhone will give you one or more options. Tap on the correct
word, and your tweets and emails will suffer from fewer mistakes.
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THREADED EMAIL MESSAGES
If you’re a fan of threaded messages in OS X’s Mail client or in
Entourage, you’ll be happy to hear that
threaded messages are available in iOS 4
Mail. To turn the feature on, navigate to
Settings > Mail, Contacts, Calendars, scroll
about halfway down, and turn on Organize
By Thread.

VOICE CONTROL
OF…TIME!
Listening to music but need to know the
time without pulling your iPhone out of
your pocket? Click and hold down on the
center button on your headset, or click
and hold down on the Home button on
the iPhone, then ask “What time is it?”
Your iPhone will tell you the time in its
creepy girl-robot voice.

BLUETOOTH KEYBOARD SUPPORT

DIGITAL ZOOM

Next time someone tells you that the iPhone doesn’t have a
physical keyboard, bust out a full-size Bluetooth keyboard and
compose an email to them in record time. You can sync a Bluetooth
keyboard the same way you sync a
Bluetooth headset. Navigate to Settings >
General > Bluetooth. Make sure your
keyboard is on and discoverable. You’ll
probably have to type in a “secret number”
on your keyboard to ﬁnish the sync. Sync
and start typing. Bonus: You can control
the iPod app with some keyboards.

The Camera app now has the ability to zoom
in photo mode. The 5x digital zoom can
be enabled by tapping once on the screen,
which brings up the zoom slider. Slide
toward the plus sign to zoom in and toward
the minus sign to zoom out. But remember
that this is digital zoom, so the more you
zoom in, the more digital noise will appear in
your photos.

LOCATION SERVICES
MESSAGING
CHARACTER COUNT
If you’re concerned about how many
characters you’re sending via MMS/SMS,
you can use Character Count by navigating
to Settings > Messages and turning on
Character Count. Once you go over 30 characters, the count will
pop up while you’re composing a message. If you go over 160
characters, some carriers will split your message in two.

HIDE CALENDARS
If you sync calendars you need to see on
multiple computers but you really don’t need
them on your iPhone, you can now hide those
unwanted calendars. Launch the Calendar
app. Tap on the Calendar button in the upperright corner. Tap on a calendar’s checkmark to
remove the checkmark and hide the calendar.

Location Services got an upgrade that lets
users see when an app is utilizing Location
Services by displaying a tiny arrow in the
upper-right corner. If you no longer want an
app to track your movement, you can turn
Location Services off on a per-app basis.
Navigate to Settings > General > Location
Services and make your selections.

MORE SECURE
PASSCODE
If numbers as a passcode aren’t secure enough
for you, you can now create an alphanumeric
passcode. Navigate to Settings > Passcode
Lock. Turn off Simple Passcode. Go to Turn
Passcode On and foil the KGB by setting your
new super-long alphanumeric passcode.

TURN OFF CELLULAR DATA
FOCUS WHILE SHOOTING VIDEO
While shooting video, you can now tap
the screen to focus on a certain area.
Just remember to lightly tap an object
on the screen to focus—a hard tap will
jar your video.

If you’re cruising with the new 200MB
AT&T data plan, turning off data could
be a money-saver. Navigate to Settings >
General > Network to turn off cellular data
when it’s time to scrimp and save.

PHOTO PLACES
SEARCH YOUR
SMS MESSAGES
Now you can search your text messages via
a search box at the top of your message list.
Yup, it’s that simple.
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Some of the nifty features in iPhoto ’09 have been transferred to
the Photos app, and photos with
geo-location data will now be
added to the Places feature. A
Google map drops pins to all the
locations at which you’ve taken
pictures, including the ones shot
on your phone.
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WIGGLE ROOM

TURN OFF LYRICS AND
PODCAST INFO

We know you’re excited to load up your new
phone, but don’t completely ﬁll your iPhone.
Leave at least 500MB of unused space, which
the iPhone uses for loading apps and saving
documents. If you ﬁll it to the rim with media,
chances are you’re going to have a very slowrunning iPhone.

If a podcast ﬁle or song has lyrics or other
metadata, you may have noticed that when
that ﬁle plays in iTunes, the metadata shows up
over the art. Up until now, there was no way to
turn that off. Now you can in Settings > iPod—
just turn off the Lyrics & Podcast Info toggle.

CREATE A REAL PLAYLIST

PHOTO FACES

Sure, On-the-Go playlists were nice. But they all ended up with that
lame name when you synced your iPhone back to iTunes. Now you
can create a custom playlist from your iPhone with a custom name
that’ll sync with iTunes. First, navigate to the Playlist option at the
bottom of the iPod app. Tap on
Add Playlist, and you’ll be prompted
to give the playlist a name; then you
can add artists, songs, albums, and
other playlists.

While your iPhone won’t be looking at all your
photos and determining if your face is in the
photo, it will grab Faces information from
iPhoto ’09 as it imports photos during a sync.
Set this up in iTunes on the Photos tab after
you plug in your iPhone. Scroll down to see the
Faces you’ve set up in iPhoto. Click to sync the
people you’d like to see on your iPhone. Click
Apply in iTunes. Voilà!

WHAT iOS 4 FEATURES WORK WITH WHICH iDEVICES?
Wondering how to get iOS 4 in your life? Make sure
iTunes is updated to the 9.2 version and sync your
iDevice to iTunes, which will create one last backup.
Select your iDevice in the iTunes sidebar and click
Check for Updates in the Summary tab. While you wait
for the update to ﬁnish, check out our nifty chart to
see what features do and don’t work on your iDevice.

iPhone 4

iPhone
3GS

iPhone 3G

iPod touch
3rd Gen.

iPod touch
2nd Gen.

Email improvements (uniﬁed inbox,
threaded messages & more)

✓

✓

✓

✓

✓

iBooks

✓
✓
✓
✓
✓
✓
✓
✓
✓
✓
✓
✓
✓
✓

✓
✓
✓
✓
✓
✓
✓
✓
✓
✓
✓
✓
✓
✓

✓
✓
✓
✓
✓
✘
✓
✘
✘
✘
✘
✘
✘
✘

✓
✓
✓
✓
✘
✘
✘
✓
✓
✓
✓
✓
✓
✓

✓
✓
✓
✓
✘
✘
✘
✘
✘
✘
✘
✘
✘
✘

FEATURE

Creating playlists
Spellchecking
Exchange 2010 support
5x digital zoom
Tap-to-focus during video recording
Searchable SMS/MMS messages
Multitasking
Home screen wallpaper
Bluetooth keyboard support
Rotation lock
Passcode as encryption key
Accessibility enhancements
Audio-playback controls (via multitasking)
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iPhone 4 Powers…Activate!
After all the hype and the hours of waiting, you’ve ﬁnally landed a new iPhone. Thanks to its new
technology, your iPhone 4’s substantially different from any model that’s come before, so this quick
crash course will help you reap all the beneﬁts of your new hardware. BY ADAM BERENSTAIN

THE RETINA DISPLAY

FACETIME

The most obvious new hardware in the iPhone 4 has to be the
Retina Display, but you won’t see its full beneﬁts right away.
Developers must update each app with higher-resolution artwork
and textures, so for now, many of your apps are in standard-def.
While you’re waiting for Apple’s approval process, make sure
“Prefer standard deﬁnition videos” isn’t checked in the iTunes
Summary tab when you sync your iPhone 4 to your Mac. This will
ensure that the HD versions of your iTunes Store movies and TV
shows will sync to your phone. Not only will you get a better picture
on your phone, but you’ll also be able to take your HD ﬁles with
you to watch on a
big screen if you
connect it with an
Apple Component
AV Cable.

Wi-Fi hiccups aside, FaceTime sure looked easy to use during its
debut at WWDC. But it’s not quite as magical as Steve made it
seem. Before you can make a FaceTime call, you need to manually
activate the feature by
navigating to Settings >
iPhone. Just switch on
FaceTime. Then you’re good
to go. Now make a call as you
normally would, tapping the
FaceTime icon in the middle
of your screen to show
grandma what you’re up to.
One question...how did she
get her iPhone 4 so quickly?

THE FRONT AND MAIN CAMERAS
Twice the cameras means
twice the complexity, right?
Not so fast. Camera options
are right where they’ve
always been—onscreen in
the built-in Camera app—and
controls for iPhone 4’s
new camera ﬂash are no
exception. Just tap the ﬂash
icon in the upper-right or
left corner of your screen
(depending on your phone’s
orientation) to call up a trio
of options: On, Off, and Auto.
It’s just as easy to switch
between the front and
rear cameras. Tapping the
“spin the camera” icon
ﬂips you from one to the other, and just like ﬂash controls, this
works in video and still modes. Of course, both these controls are
also available from other apps, like Contacts and Facebook, that
have always been able to access the iPhone’s camera. And yes,
we’re happy to report that the iPhone 4’s ﬂash ﬁres off a redeyereducing pulse before a picture is taken. Huzzah!
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THE HOME BUTTON
It’s nice to know some iPhone hardware, like the trusty old
Home button, has stayed the same. Unfortunately its new iOS 4
feature—double-click to call up the multitasking drawer—wipes
out old favorites like double-tapping to access the iPhone’s camera,
iPod controls, or Phone Favorites. Bummer. As of today, the only
other tricks your Home button can perform are toggling VoiceOver
or inverted
screen colors
after a trip to
the Accessibility
section of your
General settings.
Welcome as
those features
are, here’s
hoping future
software updates
teach the Home
button some of
its old tricks.
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Become an iPhone Video Star!
Apple’s latest dynamic duo—iPhone 4 and iMovie—makes shooting and editing videos easier than
you’d guess, and our expert guide to the process will remove any lingering doubts you might have.

i

f you think the idea of editing video on a cell phone is crazy, you probably haven’t tried
it yet. when you pair an iPhone 4 with the $4.99 iMovie app, almost anyone can capture
footage, assemble the best bits, and share the ﬁnished results in minutes—all from the
palm of their hand. But we understand that even the phrase “video editing” scares off
many of you. So we’ve put together a guide to quickly making great videos that’ll help both
newcomers and old pros get the most out of this powerful combo of hardware and software.
BY J.R. BOOKWALTER

Let there
Be Light
More than a simple camera
ﬂash, the LED light on the
back of the device can also
act as a lamp that lights your
movies. Just tap the lightning
bolt icon in the upper-left
corner to toggle between
Auto (where the light comes
on only when necessary), Off,
or On. We recommend using
it sparingly, however—and
not just because it’ll drain
your battery faster. In many

FrAMe ShotS For tV

Be wideScreen

Last year’s video-enabled iPhone 3GS brought with it a new
phenomenon: the vertically lensed movie (or what many have
dubbed “tallscreen”). While they get the job done, vertical movies
(shot by holding the iPhone in portrait orientation) aren’t very
TV-friendly, so if you plan to eventually present your creations that
way, do yourself a favor now and remember to hold your iPhone 4
in landscape orientation while shooting to keep your video properly
horizontal. This is particularly important now that the rear camera
is working in the wider 16:9 aspect ratio inherent with 720p HD
video—you’ll get results that completely ﬁll the frame of your
HDTV, rather
than displaying
a thin vertical
image with
mostly black at
the sides.

720p HD video is wider than
the iPhone 4 can display, so
by default, the screen shows
you a cropped version of what
you’re shooting. To see the
whole widescreen view, open
the Camera app, switch to
movie mode, and double-tap
in the center of the screen.
Now you’ll see a wider image
with black bars ﬁlling the rest
of the frame—this is the full
image area you’re recording.
While you’re at it, don’t forget
to tap on your key subject
to focus the camera. In our
tests, the iPhone 4 does quite
a nice job of keeping things
in focus when the subject is
moving. But in general, the
closer the subject, the more
you’ll need to tap to focus.

incLude YourSeLF in the Fun

settings with at least a little
bit of light, a grainy video is
often preferable to a gaudy
blast of LED light…complete
with your subjects having
glowing retinas right out of
Village of the Damned.
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The best part of a handset with two cameras is that the front-facing
camera is always just a tap away. Using the front camera, not only
can you see exactly what the device is capturing, you can also
include yourself in the fun. The results won’t be in HD (the front
camera only records 640x480 video, similar to the 3GS’s camera).
In a pinch, it’s better
than nothing, and
the resulting video
can also be added to
iMovie projects. Such
footage will have those
black bars on the
sides, and we cover
dealing with those on
the next page.

respeCt
those
Copyrights
Just because Apple allows you
to use music from your iPod
app in iMovie doesn’t mean
that the copyright holder will
be happy about it. You’re free
to use commercial music in
your iMovie projects for fun
or to show off to loved ones,
but be careful about posting
movies containing such music
on sites such as Facebook
or YouTube. If a particular
copyright holder doesn’t
want you to use their work,
YouTube’s Content ID service
(bit.ly/16fbCo) may ﬂag it and
have it removed. You’re better
off sticking to Apple’s supplied
theme music or creating
something of your own using
GarageBand, syncing it to
your iPhone 4, and using that
for the soundtrack on your
original movies.

editing insights
When it’s time for the nitty-gritty work of editing, know that Mobile iMovie has its limits. Clips can only be
trimmed at the head or tail, and you can only insert a new clip before or after another one, rather than in
the middle of an existing clip. There’s no splitting of clips, although you can awkwardly get the same end
result by importing the same clip twice. Here’s how: On the ﬁrst clip, trim the out point (“out points” are
the ending points of an edit). On the second clip, trim the duplicate’s in point (or the starting point of the
edit). It’s kludgey, but it’s the only way to get it done.
To quickly make adjustments with long clips, tap
a clip to select it, then tap on the handle, hold and
swipe it—right for in points or left for out points.
The handle will then snap back to the center,
ready for another swipe so you can ﬁnd the edit
point you’re looking for with less effort. Move the
handle slower for ﬁner control over your selection.
For even faster editing within Mobile iMovie, keep
your iPhone 4 videos short—maybe 30 seconds
or less—and try to capture the action from a few
different angles, which will make your edited project
more interesting.

don’t Forget those iphone 3gs videos
If you upgraded to the iPhone 4 from the 3GS, any Camera Roll videos from your last phone came along
for the ride when you set up the new handset in iTunes. The good news is that videos shot with the 3GS will
import into iMovie just ﬁne, and you can even mix and
match them with new video shot on the iPhone 4—3GS
videos will be automatically “pillarboxed” with black at the
sides to ﬁll out the wider 16:9 aspect ratio of the 720p HD
frame. If you’re editing a Mobile iMovie project composed
entirely of 3GS video, we recommend using the Medium
(640x360) export option, which is the least likely to
degrade your original footage. (The others will enlarge it.)

Copy Movies to your CoMputer…
iMovie for iPhone 4 is strictly limited to exporting at one of three sizes—Medium
(360p), Large (540p), and HD (720p). These ﬁles (as well as any photos you’ve
taken with the device) are available for importing into iPhoto or the desktop
version of iMovie, but you can also copy them straight to your computer via the
Image Capture application included with Mac OS X. Just open the app with your
iPhone 4 docked, select the ﬁles you want to
import, and either drag and drop them to the
folder of your choice, or use the Import button.
Thanks to Apple’s $29 Camera Connection
Kit, you can also copy movies straight onto
your iPad and enjoy them on the larger screen.
Plug the USB dock adapter into the iPad and
use a standard dock cable to connect it to
your iPhone 4, then select the ﬁles you want
to import (or import them all), and watch the
magic unfold on a bigger display.
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…or share
with the world
Thankfully, Apple has built
additional sharing methods
into iOS 4 via the Camera Roll,
which includes emailing, MMS, or
sending directly to MobileMe or
YouTube. While these methods
are ﬁne for quick sharing
with family or friends, one big
disadvantage is that your beautiful 720p HD video will
get reduced to a smaller ﬁle size when going this route,
even if you’re using a Wi-Fi connection. (The same also
applies when uploading via apps such as Dropbox—it’s
an iOS 4 limitation.) If you want to share your work with
the world in glorious HD, export it to your computer
ﬁrst and then upload it to the service of your choice. <<<
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By Craig grannell

It mIght be the hardestworking app in show
business, but itunes can
rock a lot harder when
you tune It up wIth addons and applescrIpts—
and learn how smart
playlIsts brIng more of
your favorIte songs to
center stage.

Scan & PDF: worldmags & avaxhome

Tunes started out as a smart, simple music player, but
over the years, it’s evolved into one of Apple’s most
important applications. Although it’s still used for
managing and playing your music collection, iTunes now
also stores apps, ﬁlms, TV shows, podcasts, ringtones,
and books—maybe “iStuff” would be a better name?—and
of course, it’s the sole Apple-approved method for syncing
content with iPods, iPhones, iPads, and Apple TVs.
But that doesn’t mean you should take it at face value.
Like many of Apple’s applications, iTunes is multilayered.
Underneath its simple, straightforward hood, it’s surprisingly
feature-rich, offering many powerful conﬁguration options.
And it’s time to make that power work for you with our
guide to tapping into iTunes’ lesser-known but highly useful
features. We also delve into the add-ons that expand the
iTunes experience, including the very best third-party
applications and highly useful scripts. So ﬁre up iTunes 9.1 or
later (it’s currently at 9.2), and get ready to rock!
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iTUNES 9.2’s GREATEST HITS
If iTunes were a rock band, it’d only play stadiums. Besides storing and managing your music, the application has to
deal with video, books, apps, ringtones, and more. To Apple’s credit, iTunes remains pretty usable, and much of its
complexity is kept hidden under the hood. But don’t forget about these useful features.

LIBRARY SOURCES
To change the default media types
shown in the Library section of
the sidebar, use the checkboxes in
iTunes > Preferences > General. If
any sources are grayed out in that
menu, they’re probably disabled via
parental controls. Those settings can
be adjusted in the Parental section of
the Preferences window.

MULTIPLE WINDOWS
Although primarily designed as a single-window app,
iTunes lets you open most sidebar components (Music
and Connected Devices being exceptions) in their own
windows by Control- or right-clicking and selecting “Open
in New Window.” If you’ve got a large monitor, it can be
handy, for example, to view your music library and the
iTunes Store simultaneously.

Uncheck any media types
you don’t want cluttering
up your sidebar.

IMPORT SETTINGS
By default, iTunes imports audio using the AAC Encoder set to 256kbps, which is
how iTunes Store music is sold. AAC is ﬁne for iPods, but if you use a non-Apple
player, you might prefer
MP3—head to iTunes >
Preferences > General, and
click Import Settings. If you’ve
got tons of storage, Apple
Lossless is the best encoder,
and iTunes 9.1 and later can
automatically convert songs
to space-saving 128kbps AAC
when you sync an iDevice (in
the device’s settings pane).

Open sesame.

SOUND ENHANCEMENT
The often-overlooked Equalizer (Window > Equalizer, or
Command-Option-2) has sliders you can ﬁddle with to
adjust the sound, along with presets in the drop-down
menu. iTunes can save your custom settings if you choose
Make Preset
from the dropdown menu.

Set the import format here.

VIEW
MENU
VI
U
N
E
M
S
L
O
R
T
tio As List
p
-O
d
n
a
m
o
se
tio As Grid
p
-O
d
n
a
m
o
t
tio As Cover Flowo
p
-O
d
n
a
m
s
u
io
v
Show/Hide
Column Browser
Sh
t
c
Artworko Column
- Show
d
n
a
m
Sh
N
M
E
R
Genius o
Sidebar
ift Show
h
-S
d
n
a
m
Sh
k
Switch
to/from Mini Player
Sw
rd
a
w
e

34

maclife.com
SSEP•10 m

Scan & PDF: worldmags & avaxhome

N
Command-Option-3
C
up
e 3
c
a
Command-Option-4
C
xm
to 4
h
–rig
d
n
a
Command-Option-5
C
em
ftro 5
–le
d
n
a
Command-B
Bem
d
n
a
Command-G
C
G
O
Command-Shift-G
C
G
cm
d
n
a
Command-Shift-M
M
r m
d
n
a
mm
ift
h
-S
d
n
a

Pump up the
bass, yo!

CO
U
CONTROLS
MENU
Pa S
[
]
Pause
[Space]
Ne o
C
w
Next
Command–right
arrow
Pr o
C
w
Previous
Command–left
arrow
Ej o
C
E
Eject
Command-E
ST
U
STORE
MENU
Ba o
Back
Fo o
Forward
Ho o
Home

C
[
Command-[
C
]
Command-]
C
H
Command-Shift-H
>>>

WHAT
WILL
YOU
MAKE
WITH
PLUS?

Introducing The Plus Series,
the next generation of the
Pantone Matching System®.
566 new colors. One big Plus.
pantone.com/plus
PANTONE® and other Pantone trademarks are the property
of Pantone LLC. Pantone LLC is a wholly owned subsidiary of
X-Rite, Incorporated. © Pantone LLC, 2010. All rights reserved.

Scan & PDF: worldmags & avaxhome

TURN iTUNES UP TO 11

SMARTER iTUNES PLAYLISTS
Power up your iTunes playlists with minimal effort

T

echnology moves pretty fast. People
used to spend entire Saturdays
happily compiling a “mix tape” by
carefully recording favorite tracks on a
cheap cassette deck, but once digital music
hit its stride, such endeavors were seen
as a startling waste of time. With a music

Control-click and select Start Genius). iTunes
will create a 25-item playlist containing that
track and similar songs. By using the controls
above the playlist, you can extend it to 50,
75, or 100 items; refresh it; or save it.
Saved Genius playlists appear in the
sidebar’s Genius section, but Genius Mixes

Select any track in your library, click the Start Genius button, and presto, you have a unique playlist!

collection sitting on your hard drive, mixes
could be made quickly thanks to the magic of
drag and drop.
iTunes easily creates static playlists, and
always has. Click the invitingly large Plus
button at the lower left of the main iTunes
window (or go to File > New Playlist), name
your playlist, and then drag in tracks from
your library. Tracks can be reordered, and
you can also drag songs from one playlist
to another; note that the track also remains
in the playlist it was dragged from—it isn’t
removed. It’s also worth noting, in case
you’re concerned, that playlists contain
“shortcuts” to the original tracks. Delete a
playlist or an item from a playlist, and the
original track remains in your library.
AN AUTOMATED APPROACH
With iTunes 8, Apple introduced its Genius
technology, which tries to predict listening
habits based on the collections of millions of
iTunes users. This lets you create a playlist
of tracks based on a favorite song. Select a
track in your library, then click Start Genius
at the bottom right of the iTunes window (or
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are included by default. Select this to access
mixes that are genre-based, randomized,
and sealed. You can’t access Genius Mixes
to see which tracks are up next, nor can
you view a full list of albums and artists, but
they’re still a handy “personalized radio” for

those days when even starting up a Genius
playlist seems a bit too much like hard work.
SMART PLAYLISTS
Introduced in iTunes 3, smart playlists are
dynamic; they’re based on user-deﬁned
criteria. This same idea is used elsewhere on
your Mac—smart folders in the Finder, smart
mailboxes in Mail—although the iTunes
implementation is the most advanced and
ﬂexible at the time of this writing.
To create a new smart playlist, go to File >
New Smart Playlist or use the keyboard
shortcut Command-Option-N. This brings up
the Smart Playlist dialog. To create a basic
smart playlist, leave all the settings alone,
but add your favorite artist to the empty
ﬁeld, and then click OK. Your new playlist will
be added to the sidebar and highlighted. In
the main iTunes view area, you should see a
list of tracks from your speciﬁed artist.
Since they’re dynamic, smart playlists can
be updated with new settings. Select your
playlist and go to File > Edit Smart Playlist
(or Control- or right-click it and select Edit
Smart Playlist). Click the Plus button to add
a new rule. The left-most menu includes
many criteria you can pick from. Add as
many rules as you like, and deﬁne speciﬁc
values for them. The Match menu lets you
choose whether the playlist includes tracks
determined by all of the rules or any of them.
The former could be used to create a playlist

File > New Playlist Folder adds a handy folder to the sidebar, into which you can drop static and smart
playlists for easy access.
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An example of a nested playlist—these can be
as simple or as complex as you like, so go crazy!

of tracks by your favorite band, not including
that one lame album (Album > is not > [album
name]), and only from the 1990s onwards
(Year > is greater than > 1989). To remove
a rule, click the adjacent Minus button,
although be aware there’s no undo.
ADVANCED RULES
The Smart Playlist dialog has a few options
that can further reﬁne your playlists. The
Limit checkbox enables you to set a speciﬁc
track count and also a selection criterion
(random, recently played, and so on). If the
Live Updating box is checked, relevant tracks
subsequently added to iTunes will be added
to the playlist without you having to do
anything.

With iTunes 9, Apple ﬁnally
added a change that smartplaylist gurus had demanded for
years: nested playlists. Before
iTunes 9, complex playlists
of the form “A and (B or C)”
required you to make the “B or
C” playlist ﬁrst and then a second
playlist to work with its output.
Now, however, you can use the
“…” (ellipses) button to create
nested rule groups and therefore
playlists with complex logic.
If this concept sounds tricky in
the abstract, here’s a practical application
for nested smart playlists. Say you want
to create a playlist comprising tracks from
10 of your favorite bands, only using songs
rated above four stars and that have not
been played in over a month. Previously, this
would have required two playlists, because
the bands are an “any” match, whereas the
other rules are an “all” match. With iTunes 9,
you set up a single match-all smart playlist
with the time and ratings rules, and nest
a match-any set that deals with the band
names. An example is shown above, but the
sky really is the limit with smart playlists,
and once you’ve set a few up, you can let
iTunes do all the hard work of adding tracks.
It’s a long way from waiting for a cassette to
run out of tape!

BASE YOUR PLAYLISTS ON RATINGS
The best smart playlists are often the simple ones: If you rate your tracks, create a
smart playlist where track ratings are greater than 3 and call it “4+ tracks.” For your
very best tracks, create a smart playlist with tracks rated 5. If you’re always forgetting
what music you’ve added over the past couple of months, create a smart playlist with
the rule: Date Added > is in the last > 60 days, and where Media Kind is Music. Create a
similar playlist, but change 60 days to 12 months to include songs you’ve added over
the past year. Or if you’d like to unearth lost favorites, create a playlist called “4+
neglecteds” and set rules based around track ratings (Rating > is greater than > ***)
and when the tracks were last played (Last Played > is not in the last > 30 days).

TARGET YOUR iPODS
Unless you have a 120GB iPod classic,
your Apple music player has a relatively
limited capacity. That’s ﬁne if your music
collection is small, but if it isn’t, you
can always create a playlist with nested
rules to ﬁll it full of favorite tracks.
In the example below, the Time rule
dispenses with very short (under 40
seconds) and very long tracks (over 5
minutes), classical music, and anything
with a very high bit rate (although you
can automatically “downsample” audio
during syncing in iTunes 9.1). The Media
Kind rule restricts the playlist to music,
ﬁltering out spoken audio and the like.
Our nested rules follow this logic:
Tracks are only added to the playlist if
they’re rated over 3—unless they’ve
been added within the previous 14 days
and don’t have a rating of 1. This means
that you always get recent tracks
(including all unrated ones) unless
you’ve already decided to mark them as
rubbish, but older tracks are ﬁltered by
your rating.

If you’ve got an iPod shufﬂe, ﬁll it with highly
rated, short-ish tracks.
This simple smart playlist ﬁnds favorite tracks you haven’t heard recently.
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THE BEST iTUNES ADD-ONS
iTunes gets even better with one (or all) of these apps as its backup singers

THE BEST iTUNES
ADD-ONS
NES AD
S

Once you set the preferences, the app stays in
your menu bar.

Tinker with these additional settings when iTunes
isn’t running.

iTunesMenu stays out of your way.

I LOVE STARS
Price: Free
potionfactory.com/free
Even if your library is modest, rating all
your tracks can seem daunting. But a rated
collection gives you more possibilities for
smart playlists, and I Love Stars lets you rate
as you go. The app sits in the menu bar and
shows the currently playing track’s rating. To
change the rating, click on the relevant star.
Control-click to access the preferences and
deﬁne systemwide keyboard shortcuts for
rating tracks. I Love Stars can even alert you
(optionally) when an unrated song is almost
done playing.

iTUNES PREFERENCE PANE
Price: Free
megabytecomp.com/apps.aspx
As with Mac OS X itself, Apple hides a number
of iTunes preferences, not making them
accessible via a graphical user interface.
iTunes Preference Pane installs into System
Preferences and provides options for
tweaking iTunes. Perhaps the most useful
setting is Invert Library Links, which turns the
library arrows into links to your own library
rather than the iTunes Store (Option-click
for the default functionality). The ability to
apply half-star ratings will beneﬁt anyone
who considers Apple’s default system too
restrictive. Note: Make changes to the
settings only when iTunes isn’t running.

iTUNESMENU
Price: Free/$1.99
mrgeckosmedia.com/applications
Plenty of iTunes-notiﬁcation apps exist, but
most take up valuable space on your screen,
or get hidden by other windows. iTunesMenu
uses your menu bar to display the name of
the song currently playing in iTunes, along
with other information, such as the artist and
album. The drop-down menu also provides
access to basic iTunes controls, although we
recommend your Mac’s keyboard for those.

HOW TO SET UP iTUNESMENU

1

GET STARTED
iTunesMenu communicates with iTunes
to ﬁnd out what the currently playing
track is. The track artist is displayed in the
menu bar, updating as new songs begin. Click
the artist name to access the app’s menu.
Choose Preferences to conﬁgure the display.

40

SEP•10 maclife.com

Scan & PDF: worldmags & avaxhome

2

CONFIGURE THE DISPLAY
Select General and decide what you
want displayed in the menu bar. To
show the title and artist, separated by a bullet
and with a space afterward, type %Title •
%Artist into the Status Menu Order ﬁeld,
then click Save Preferences. (Ensure Scrolling
is set to None.)

3

FONTS AND HOTKEYS
To change the iTunesMenu font, click
Select and choose a new one from the
Mac OS X Fonts panel. If your Mac keyboard
lacks media keys, use iTunesMenu’s Donate
section to give $1.99, enter your activation
key, and use Hot Keys to deﬁne iTunes
controls.

Bowtie has a few looks, and you can download
more.

Lounge resembles the Now Playing screen on
Apple TV.

Match all your albums to their artwork in no time.

BOWTIE
Price: Free
bowtieapp.com
Bowtie is similar to iTunesMenu, but instead
of displaying the current track’s name in text,
it displays the album artwork. Preferences
let you deﬁne the artwork window’s depth
(Desktop level, normal, or always on top).
Bowtie includes two alternate themes:
one purely text-based, and one with a tiny
vinyl record poking out from the artwork.
Additional themes can be downloaded
(search Google for “bowtie theme”), or if you
have knowledge of HTML and CSS, you can
make your own.

LOUNGE
Price: $9.95
snarbsoft.com/lounge.html
Lounge is an interesting mix of screen saver
and iTunes kiosk, and it’s perfect either for
parties or just as a good-looking screen saver
for any Mac. Instead of iTunes-style visualizer
pyrotechnics, Lounge displays the current
track’s artwork and information. Options let
you toggle keyboard controls for skipping
tracks and adjusting volume without exiting
the screen saver, ﬂip the screen periodically
to avoid screen burn, and even choose a
screen saver to switch to when a playlist
has ended.

ALBUM ARTWORK ASSISTANT
Price: Free
entropy.ch/software
Album Artwork Assistant beats its artworkseeking rivals by being comprehensive and
offering plenty of choice regarding potential
artwork to import. It also provides a queuing
system for when you’d like to work through
a bunch of albums, rather than immediately
applying new art every time. To use this
feature, switch Add Immediately for Add To
Queue in our walkthrough below (Step 2), and
when you’re done, open the Queue drawer
and click Process Queue.

HOW TO FIND ARTWORK FOR YOUR ALBUMS

1

INSTALL A SCRIPT
Quit iTunes and System Preferences. In
Album Artwork Assistant, select Install
iTunes AppleScript from the Application
menu, then click OK. Select a track or album
in iTunes to change its artwork. From the
Script menu, select Find With Album Artwork
Assistant.

Scan & PDF: worldmags & avaxhome

2

SELECT YOUR ARTWORK
Album Artwork Assistant will display
the tracks to be updated. Below this
list, the search string used is displayed, along
with image results with a resize slider. To
choose new artwork for your tracks, select an
image and then click Add Immediately.

3

FIND ALTERNATE ARTWORK
Album Artwork Assistant may not
ﬁnd artwork right away for obscure
releases. Try changing the search string.
Alternatively, select the Web Search tab to
activate the browser area. Once you ﬁnd
artwork to use, Control- or right-click it and
select Add Immediately.
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SCRIPTS MAKE iTUNES SING
Like a rock star’s guitar pedals, AppleScripts add even more variety to iTunes

A

ppleScript is something of an unsung
hero. It easily automates repetitive
tasks, but few users ever go near
it. If you’re an iTunes power user, scripts
are a must, but you needn’t hack away in
AppleScript Editor—many prebuilt iTunes
scripts are available online. All you need to do
is download them, plonk them in the iTunes
Scripts folder, wait a second or two, and the
extra functionality is yours.
The walkthrough on p43 shows you
how to set up and manage scripts, so we’ll
concentrate on the best available scripts. All
of the scripts mentioned are available for
free from the Doug’s AppleScripts for iTunes
website (dougscripts.com/itunes).

TRACK MANAGEMENT
If you’ve got a pretty big music collection,
keeping it in good shape can take time—way,
way, way too much time. Scripts can assist
you with management tasks, taking minutes
or seconds to accomplish what might take
you hours or more.
One of the best housecleaning scripts is
Super Remove Dead Tracks. This ﬁnds songs
in your library that are no longer available
on your Mac. Every 500 tracks, it throws up
a dialog to inform you of its progress, and
the optional text-based log ﬁle at the end
tells you which entries have been deleted.
On our 13,500-track test library, this entire
process took under a minute.

Tracks Without Artwork To Playlist is
similar—you select a library, playlist, or an
arbitrary bunch of tracks, and the script
copies songs without artwork to a new
playlist. On activating the script, all you
need to do is click Proceed, choose a name
for your playlist, and wait for a bit. On our
iMac, the script took about 5 minutes to
churn through our 13,500 tracks, ﬁnding
about 1,500 that lacked artwork. With a No
Artwork playlist in place, it’s simple to send
these tracks to Album Artwork Assistant
(see p41) to grab artwork online.
Another great playlist script is Gather
Up The One-Hits. It collects tracks where
the artists are each represented in your
library by just a single song. Chances are,
this will mainly comprise content from
compilations, but we found a bunch of oneoffs we’d grabbed from the iTunes Store and
subsequently forgotten about.
TRACK INFO AND PLAYBACK
Along with rapidly cleaning up your library,
scripts can deal with metadata issues, and
you don’t have to open a single Get Info
window. Quite often, iTunes downloads
inaccurate data when you import tracks
from CDs by obscure artists—a common

If you regularly use a script, apply a keyboard shortcut via Keyboard Shortcuts in System
Preferences.

error is the artist and track name ﬁelds
being reversed. The Swap This With That
script from the This Tag, That Tag Scripts
compilation can handle this. Launch the
script, select a tag to swap from and
another to swap to, and your songs’ data is

BACK UP YOUR iTUNES FOLDER
The add-ons mentioned elsewhere in this
feature do relatively little to affect the
content of your iTunes library. At most,
they add a little data here and there, such
as ratings and new artwork, and these
things are easy enough to revert or delete
at a later date. Scripts in iTunes can be a
very different matter, because some of
them automate complex and “destructive”
processes, including reworking and
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deleting tracks. We’re not trying to scare
you off—iTunes scripts can often be very
handy timesavers—but we do suggest
that you don’t just start using scripts
blindly. Before you work with scripts that
do anything major to your iTunes library,
ensure that you ﬁrst back it up. The iTunes
folder—including your music, other digital
content, and databases—lives in the
Music directory inside your user folder.

Back up your iTunes library folders before doing
anything major with scripts.

amended. However, be aware that there’s no
undo. If your metadata issues are subtler,
investigate Track Names To Sentence Caps
and Track Names To Word Caps (both of
which reformat cases in track names) and
Remove N Characters From Front or Back.
The last of those enables you to remove a
speciﬁc number of characters from the start
(‘front”) or end (“back”) of a selection of
song titles. So if some song titles have track
numbers at the start or “disc 1” at the end,
this script removes that information quickly
and easily.
Scripts can also assist with playback
controls. Needle Drop enables you to
audition a selection of tracks in automated
fashion, after deﬁning playback length and
an intro point. For example, you can play
10-second bursts from 2 minutes into every
track from a speciﬁed playlist.
Another favorite script is Make
Bookmarkable, which turns the ﬁle type
of selected AAC tracks into M4B, thereby
making them “bookmarkable,” so playback
resumes where you left off. Make UNBookmarkable reverses the process.
ExTErnal conSidEraTionS
Search Wikipedia and Google Video Search
search the web for more information about
your music, working in similar ways: You
select a script, and a dialog asks whether
you want to search based on the currently
playing track or the currently selected track.
You then select a category to base the search

Search for an artist or album on Wikipedia directly from within iTunes simply by using a little script.

on. For Wikipedia, you can select the artist,
album, or composer. For Google Video, you
choose between song, artist, and album. The
dialogs aren’t pretty, but they get the job
done and save time.
Another set of scripts enables you to
export track information from iTunes.
Although this can be done using File >
Library > Export Playlist, the resulting text
ﬁle is complicated, huge, and unwieldy.
Instead, we recommend Album-Artist
To HTML Table, which exports a list of
your artists and albums (and, optionally,
associated tracks, although processing that
information takes a long time, so we don’t

recommend it) to an HTML document that
you can open in a web browser. The script
has a couple of quirks: you need to reorder
your track list to Album By Artist for best
results, and don’t let the script open a
browser when it’s ﬁnished, or you’ll likely
get an error. Instead, click Done and then
manually open the HTML ﬁle it outputs.
Another export option worth a look is
Playlist To Papercdcase.com. It lets you
export up to 28 tracks from a playlist to
papercdcase.com (the site opens in Safari),
which cunningly formats the data into a PDF
ﬁle that can then be turned into a CD case if
your origami skills are up to snuff. <<<

hoW To managE your ScripTS FoldEr

1

crEaTE a ScripTS FoldEr
If you haven’t installed scripts before,
you won’t have a Scripts folder to use.
To add one, quit iTunes, use the Finder to
access ~/Library/iTunes (the Library folder
that’s found inside your user account’s home
folder), and if a Scripts folder isn’t present,
create a new folder called Scripts.
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2

inSTall and rEmovE ScripTS
Managing scripts is a case of drag
and drop. To install a script, drag it
into the Scripts folder mentioned in Step 1. To
remove one, drag it out of the folder or trash
it. It’s best to do such management when
iTunes is closed, but iTunes typically tracks
script changes well.

3

chEck ThingS in iTunES
Launch iTunes. After installing a script,
you’ll see a script icon in the menu bar
between the Window and Help menus. This
is where you can activate the scripts. Scripts
can even have keyboard shortcuts assigned
in System Preferences > Keyboard > Keyboard
Shortcuts, just like other menu items.
maclife.com SEP• 10
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lass notes. Rough drafts. Web
research. Outlines. Reminders.
Take control of it all with Circus
Ponies NoteBook, the award
winning application for managing
information. Get organized using a
familiar notebook interface, with
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Has NoteBook

pages and tabs, sections and subsections. Create voice-annotated
notes and review them from your
computer or iPod. Drop in lecture
slides and mark them up with text,
diagrams and sketches. “Clip” web
pages to your Notebooks for later

reference. Find anything instantly
using
NoteBook’s
patented
Multidex™. Share your Notebooks
as PDFs or as websites. And much
more. NoteBook has everything
you need to get organized for
school.
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The easy way to get organized on the Mac™
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A STAMPEDE OF NEW FEATURES FO R

BY CORY BOHON

THE NEWEST VERSION
OF APPLE’S WEB
BROWSER IS LEAN,
FAST, AND FILLED
WITH POTENT NEW
FEATURES. USE THIS
EXPERT GUIDE TO
HARNESS EVERY
OUNCE OF ITS
POWER.
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U

nusually, we hadn’t heard any
rumors about a new Safari, so we
were a bit surprised when Apple
announced the recent 5.0 version of its
signature browser. Even though Cupertino
took the stealthy route with its debut, this
update is no mere rehash. Safari 5’s new
features include some never-before-seen
innovations that make it our favorite little
browser on the Mac. We’ve sorted through all
that new power to come up with 11 ways you
can use Safari 5 to get the most out of your
intertubes. And as it turns out, some of the
cooler features don’t come from Apple—but
from the developers making some really
interesting extensions…
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Extensions...Finally, Extensions!
Block ads, download YouTube videos, remember your tabs, and more

1

The ability to customize Safari by
installing extensions is a feature we’ve
been wanting for a long time. The
process is somewhat similar to what you
might ﬁnd in other browsers like Firefox or

Chrome: when you install an extension, you
get a new tab in your Safari preferences
that allows you to manage them. We really
like the option provided there to turn off all
extensions with a single click of the mouse.
If you try to install an extension and get
an error saying that extensions have not
been enabled, then you can go to Develop >
Enable Extensions. If you don’t have a
Develop menu, you can enable it by visiting
the Advanced tab in Safari’s preferences.
When you download and try to install an
extension, Safari will alert you to make sure
you really want to install that particular
extension, similar to the way Dashboard
handles installing widgets. You might need
to refer to the extension’s website to ﬁnd out
how to use it because Apple lets developers
put options in a few different places. As
a rule of thumb, you can commonly ﬁnd
installed extensions in the toolbar or as a
right-click option.
Next, we’ll run you through a handful
of our most beloved extensions to get you
up and running with this powerful feature.
If you’re hungry for more, check out
pimpmysafari.com, which compiles the latest
Safari extensions.

In the General options, you can elect
to have text ads on Google search results
disappear, and you can also block ads inside
of YouTube videos. However, these features
are in beta, so don’t be surprised if they
don’t work every time.
Under Filter Lists, you can subscribe to
ad-blocking lists for your country of choice.
These lists are updated every ﬁve days or
manually as you wish. On the Blacklist tab,
you can manually block ads by their CSS
selector, or you can have the software do it
automatically by pressing Control-Shift-K on
any page that still has ads on it. This will add
the page to your ﬁlter list.
Under Whitelist, you can specify websites
where you actually wish to view ads (this
would be a good place to add your favorite
websites…like, cough, MacLife.com). You can
add these manually or have AdBlock do it for
you by pressing Control-Shift-L.

DOWNLOAD YOUTUBE VIDEOS
Do you like a particular YouTube video so
much that you would like to store it on your
computer for eternity? With an extension
called YouTubeDownloader, you can do just
that. After you’ve downloaded and installed
this extension (bit.ly/ctdiUQ), visit any
YouTube video, where you’ll notice two new
buttons near the top of the video. One will
let you download an FLV (Flash video) ﬁle

of the video, and the other will allow you to
download the video as an MP4. Sync the MP4
to your iPod, and you’ll never be without a
Rick Roll again!

SAVE TABS
BETWEEN SESSIONS
One of the biggest drawbacks to using Safari
over Firefox is that Safari won’t ask to save
your tabs when you close the application
and have multiple tabs opened. With the

SaveTabs Safari extension, however, you can
back up and restore tabs at will.
Once installed (bit.ly/cuETYV), you will
have two new buttons next to the address
bar—one shows a tab with a down arrow
and one with an up arrow. When you’re ready
to save your session and quit Safari, click on
the down arrow and close the application.
When you reopen Safari, click the up arrow,
and Safari will be populated with the tabs
that you previously had opened.

BETTER SORTING
FOR NETFLIX QUEUES
When you’re browsing your Netﬂix queue,
you don’t have a simple sort option that
will let you see your queue based on item
availability, title, or instant availability. With
the Netﬂix Queue Sorter extension, you gain
these and many other sorting options.

DISABLE ADS
One of the more popular plug-ins for other
browsers, the Safari version of AdBlock
lets you do just what its name says: block
advertisements on websites. When you
download and install the plug-in from the
developer’s website (safariadblock.com),
you’ll get a button next to the address bar
that looks like a stop sign with a hand on
it. Clicking this button opens a heap
of possibilities.
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When installed (bit.ly/bslgW6), the Netﬂix
Queue Sorter will let you sort by title,
instant, star rating, genre, and availability
date. This extension allows you to see at a
single glance what’s arriving soon or what’s
now available to play instantly on your
computer. Your Netﬂix queue browsing will
never be the same again.

And a Herd of Other New Features!

2

MORE SUPPORT
FOR HTML5

HTML5 is the future of the web,
and Apple is embracing it wholeheartedly
with Safari 5. This new version contains
support for many new HTML5 features
like full-screen video, closed captioning,
draggable attributes, and form validation.
Rarely do end users care about the

3

BETTER ONLINE
READING

5

Reading online articles can be a
misadventure, especially if you’re used
to reading on paper. Like the Readability
bookmarklet from Arc90 Labs, Apple’s
Safari Reader lets you click the Reader
button in the address bar to read an article
in a distraction-free space. The background
dims, and you’re left with simple text on a
white background. Mouse over the bottom
portion of the Reader page for ﬁve options:
zoom out, zoom in, email, print, and close.
The email and print functions only grab the
text and graphics related to the article, not
ads and other useless information. Nice!

technologies surrounding the creation
of different online tools, but HTML5 is
something that will deﬁnitely beneﬁt
everyone soon. It allows for a richer
web experience than you’ve had before.
You can see this in Apple’s recently
posted demos (apple.com/html5),
which showcase some of the strengths
of HTML5.

4

MORE PRIVACY

Safari 4 introduced the ability to
use private browsing. By turning
on this feature in Safari, you are able to
browse the web without logging any cache
ﬁles, cookies, or history. With Safari 5,
however, you can see a small icon in the
address bar that will let you know with one
glance if your web session is being logged.
When you’re done privately browsing, you
can click the icon, and Safari will ask if you
wish to end your private session.

BETTER TAB SETTINGS

If you’ve ever used Safari as your main browser
before, you’ve probably been annoyed when you
click a link in another program and it opens in a new window
instead of a new tab. If you’re a fan of tabbed browsing, you
can now select a setting where all links are opened in a new
tab and never in a new window. To do this, head over to your
Tabs preferences (Safari > Preferences > Tabs) and select
Always from the drop-down menu that says “Open pages in
tabs instead of windows.” And if you accidently close a tab,
Command-Z reopens it. Magical.
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6

SNAPPIER PAGES

Sure, Safari 5’s faster speed isn’t something that
you can physically see, but it is something that you
can feel, especially when loading a page that contains a lot of
JavaScript (such as Aviary’s many products or Google Docs).
According to Apple’s specs page, the new Nitro JavaScript
engine means that Safari 5 runs 30 percent faster than version
4, and 3 percent faster than Chrome 5.0. That makes the
JavaScript engine in Safari 5 the fastest when compared to
Chrome, Opera, and Firefox.
To make pages load even faster, Safari 5 also couples DNS
prefetching with an improved caching system. Translation:
Safari automatically searches through links on the page, looking
up addresses and loading cached items to deliver a faster webbrowsing
experience.
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7

BETTER WEB
DEVELOPMENT

A lot of web developers use
Firefox because they can download webdevelopment plug-ins to extend debugging
and development. Apple’s upped the game
with Safari’s Web Inspector. Right-click
anywhere and select Inspect Element to view
code from the webpage, and mouse over
parts of code to highlight those elements on
the page. It’ll also show resource ﬁles and
scripts (like JavaScripts), check proﬁles and
storage, and display a log in the console. It’s
a great resource for developers, and Apple
made it even better by adding a timeline
view that lets you track your website-loading
times for loading, scripting, and rendering.

8

BING SUPPORT FOR SEARCHING

As mentioned in June’s WWDC keynote for iOS 4 devices, Apple is now
supporting Bing for search in Safari. To switch your search preferences, you
can visit Safari > Preferences > General. Select Bing from the drop-down menu that says
“Default search engine.”
Google will remain the
initial setting, but you
can now opt for Bing
and Yahoo! too. Hey,
more choices is always
a good thing, right?

9

IMPROVED ADDRESS BARS

In a sorely needed upgrade, Safari 5’s address bar now lets you type in keywords
that match against titles of webpages you’ve visited in the past. It’s very similar to
what Firefox does with its so-called “awesome bar.” In addition to offering up pages in your
browser’s history and bookmarks, the address bar will also still match URLs as the previous
version did.

10

LOCATION SERVICES

HTML5 provides the ability to detect your location
using the location services in Snow Leopard so
applications like Google Maps can directly ask Mac OS X to pinpoint
the location of your computer in the world. To enable location
services all the time, visit Safari > Preferences > Security and check
the box labeled “Location services: Allow websites to ask for location
information.” Note that this doesn’t provide completely accurate
location data due to the way it retrieves this info. Your computer
is tracked via your IP address, which could be different from your
actual location, depending on where your ISP’s central ofﬁce is.

11

iPAD-SPECIFIC USER AGENT

Apple added a new iPad-speciﬁc user agent to Safari 5. A user agent
is a bit of information that tells a website which browser you’re using.
Under the Develop menu, Apple has had a few user agents to switch between,
but now you also have an iPad-speciﬁc one to choose.
That means that you can go to Develop > User Agent > Mobile Safari
3.2—iPad and be able to load iPad-speciﬁc websites, such as Apple’s
own documentation that’s specially formatted just for the iPad. If you’re a
developer, you can test your websites built for the iPad without having to own
an iPad or use the iPad simulator. You can also play around with user agents to
get to websites that are built for other platforms…yes, even Windows. <<<
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>>>Apps

DISCOVER THIS M ONTH’S
MOST INTERESTING iOS APPS!

BETTER BARGAIN-HUNTING
ON CRAIGSLIST?
THE UTILITARIAN BUY, SELL & SQUIRM SITE GETS THE APP TREATMENT,
BUT DO ANY OF THEM MAKE OUR LIST? BY NIC VARGUS

C

raigslist is the premier site for people
looking for a good deal. Unlike
Amazon and eBay, its searches are
reﬁned to sellers in deﬁned proximities—
usually people who are looking for quick pickups. Craigslisters who check often enough are
bound to ﬁnd something awesome for cheap,
which means that well-designed iPhone and
iPad apps could be huge.
We set out to determine if an iOS app
could top the Mobile Safari experience, and
it was no surprise to ﬁnd literally dozens of
Craigslist apps for the iPhone and iPad. It’s as
if developers realized that the infrastructure
was already set up, and all they had to do
was beautify the site. However, many of

CraigsPro+’s ability to keep searching even
when you’re not using it is a killer feature…
that’s hindered a bit by restricting you to 50
“free” notiﬁcations. (You can buy more.)
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them missed that mark, and we ended up
wading through a sea of glitchy, crippled
versions of the popular site—or apps even
less attractive than the infamously minimal
website. Still, a few interesting options
emerged, so let’s take a look at the best of
the bunch.
Craigsphone beefs up Craigslist’s
attractiveness by utilizing drop-down
messages, similar to Mail. On the browsing
end, it’s quick and easy to navigate, but it
doesn’t let you save searches or choose
neighborhoods within districts (a dealbreaker for metropolitan deal-seekers).
Posting is much more difﬁcult than browsing,
and Craigsphone is often unable to get
your listing up at all, so if your main task is
posting, you should look elsewhere.
CraigsFish is not the “elsewhere”
frequent posters are looking for. It offers no
way to log in to your Craigslist account, so
it’s impossible to post anything at all from
within the app. While it utilizes a similar
drop-down menu as Craigsphone, it isn’t
nearly as easy to navigate. After several
updates, CraigsFish is now technically usable,
but it remains glitchy and crashes often. At
this point, stick with another app until the
bugs are ironed out.
Craigslist Pro proves that a bit of polish
never hurts. It’s available on both the iPad
and iPhone, but they’re different apps with
vastly different interfaces. With the iPad
version, the only real issue was the miniscule
size of the text. Though most people won’t
have a problem reading the smaller font,
there’s no way to zoom in, so steer clear if
needlessly small text ain’t your thing. With
both the iPad and iPhone version, posting

When all is said and done, viewing the site in
Mobile Safari works better than any current
iPad app.

from within the app was a piece of cake. As
an added bonus, both applications permit
you to manage multiple accounts. All told,
they’re easy to navigate and work well as
a replacement for the site, but they aren’t
must-own apps.
CraigsPro+ is the best option for
Craigslisting on an iPhone. It was made by
the same development team as Craigslist
Pro (IOCo), which is evident by its matching
visual style. CraigsPro+ costs the same
amount as its plus-less counterpart and
boasts saved searches and tons of sorting
options. But it also has a bit of added
functionality: CraigsPro+ utilizes “agents”
to ﬁlter your searches even when you’re
not using the application. When something
comes up that matches your speciﬁcations,
it’ll send a push notiﬁcation. The only
problem with this ingenious feature is that

you’re limited to 50 notiﬁcations, and when
those run out, you’ll have to purchase more.
Craigly adds interesting functionality as
well—the ability to format listings in four
different views. It also lets you customize
searches by neighborhood, price, number of
bedrooms, and more. After sending an email,
it displays a nice subtlety overlooked by other
apps: a box that tells you “message sent.”
Regrettably, the interface is pretty clunky
and could use a major cleanup. For instance,
clicking on a posting displays it in a font so
large even short posts will require scrolling.
The bottom line: More than a handful
of apps mimic Craigslist’s functionality
and provide an almost-as-good-as-the-web
experience. But they’re all really only getting
it half-right, and there’s no reason to use an
app that doesn’t improve upon a perfectly
functional website. CraigsPro+ is the only app
that made ‘listing signiﬁcantly easier, but it’s
iPhone-only. For now, iPad users are better
off just using the site.

Craigslist Pro might be classy, but you’re going
to need to eat your carrots if you actually want
to read posts.

Though Craigly’s format options utilizing
the thumbnails are gorgeous, the text is just
too large.

CraigsPhone is able to use your current location and drop pins at postings around you, but
frustratingly, only for postings in the housing categories.

Craigsphone 2.0
Next Mobile Web
nextmobileweb.com/
craigsphone
Free
OKAY

iPHONE+iPAD

GOOD

CraigsPro+ 3.12
IOCo
www2.ladelo.com:8080/
craigspro/
$0.99
iPHONE
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Craigslist Pro 1.0.2
IOCo
www2.ladelo.com:8080/
craigspro/
$0.99
SOLID

iPHONE+iPAD
iPHONE+iPAD
CraigsFish 1.2.1
AlterTap LLC
No working URL (at
press time)
Free

LAME

OKAY
iPAD
iPHONE+iPAD

Craigly 1.6
Mother Tucker LLC
mothertuckerllc.com
$1.99
iPHONE+iPAD
iPHONE+iPAD

Frequent glitches and crashes make CraigsFish
a complete mess.
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SQUARE
Twitter cofounder turns every smartphone into a cash register
Blogs put a printing press in every home.
Smartphones provide internet access almost
anywhere. Square, an app for mobile devices,
turns anyone into a small business. Selling
your couch, but the buyer only has plastic?
No problem. Hawking T-shirts out of your
trunk on the concert circuit, but don’t want
wads of cash? No problem.
Square, founded by Twitter co-creator
Jack Dorsey, is looking to take a bite out of
the digital economy pioneered by PayPal.
With the Square app on your mobile and the
free hardware add-on (we’ll call it a dongle)
plugged in to the audio jack, Square enables
payments on the ﬂy. Users swipe their card
through the dongle, ﬁnger-sign on the
touchscreen, and get their receipt via email.
While PayPal dominates the digital market,
not everyone has an account or PayPal’s
mobile "bump" app. That’s Square’s opening
because nearly everyone does have a debit/
credit card.

OUR FAVORITE APPS

PAUL

My Stuffy Bear
This pick comes
on behalf of my
six-year-old
daughter, who’s fallen
hard for this app. It lets
her build teddy bears
from scratch, picking
their fur color and eye
type to begin with.
After that, it’s dress-up
time with a full array of
pink-tastic accessories
and clothes that keep
her happily distracted in
restaurants, cars, and
other frontiers.
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Using the app is super easy, though you
may be waiting around for your dongle (at
press time, demand far outstripped supply,
making for long delays). You can’t process
credit transactions without the dongle and
activation code, although you can create
receipts for cash. If you forget your dongle,
you can key in transactions, but in that
case Square’s cut is a higher fee (3.5%
compared to 2.75% for swipes). If you have
the hardware, you’ll want to hold the dongle
steady while you swipe; the connection felt a
little precarious at times. Lastly, don’t expect
Square to be the cornerstone of a booming
business—there’s a $1.00 minimum
transaction and $100 maximum with a $700
weekly cap for new users, although regulars
can upgrade their accounts.
The bottom line Technophiles and digital
natives will love everything about this
app/dongle, but until Square gets enough
name recognition to make grandma feel

Be sure to hold the dongle and swipe
carefully.

comfortable with any Tom, Dick, or Harriet
swiping her credit card, it may be hard to
make a dent in the market.—J Keirn-Swanson
Square 1.1.1
Square, Inc.
squareup.com
Free
GOOD

iPHONE+iPAD

Each month, the Mac|Life staff gives you a peek inside our iPhones, iPads, and iPod touches
to show you the latest gems, oddities, and WTFs that we’ve uncovered in the App Store.

NIC

Robot Unicorn
Attack
Imagine playing
a game where
you’re a unicorn
running across purple
ﬁelds. But you’re also a
robot. And you have to
rainbow-attack through
metal stars and collect
colorful fairies while
jumping over sharp cliff
crags that will blast your
metal body into a million
pieces, while listening
to “Always” by Erasure
on inﬁnite repeat. No,
I’m not kidding…it’s
awesome.

ROBBIE

RAY

FLO

Find My iPhone

Gravity HD

eBoy FixPix

Find My iPhone
is one of the
main reasons
I continue to love
MobileMe. We have a
tendency in my house to
misplace iPhones. The
service has saved our
bacon more than a few
times. Now that it’s on
the iPhone, we don’t have
to rush to the nearest
computer to ﬁgure out
which German bar we left
one of our iPhones in.

Isaac Newton’s
Gravity HD from
Namco is one
of my favorite puzzle
games. Using a collection
of objects and the power
of gravity, you have to
navigate obstacles to
activate a button on the
playing ﬁeld. The ﬁrst ﬁve
levels are free—a $9.99
in-app purchase gets you
another 95 levels. And
if you get in a jam, Isaac
Newton can help you out.

I’m a huge fan
of eBoy’s pixel
art, and eBoy’s
FixPix puzzle game’s
simple, teeter-totter
gameplay gives me
something to do while
I’m waiting in line at the
grocery store. An added
bonus is that I can save
every puzzle I solve to
my Photos and set it as
my wallpaper on my iPod
touch, or share it with
my friends on Facebook.

PHOENIX WRIGHT

TO DO GENIUS

If you’re a fan of Choose Your Own Adventure books, then you’ll
love the way Phoenix Wright plays out. This port of the popular
Nintendo DS game is an engaging adventure ﬁlled with courtroom
shenanigans where each case you tackle involves investigating the
scene of a crime and procuring important evidence. When you ﬁnally
go to trial, you have to present the right piece of evidence at the
right time, or you’ll be the laughingstock of the jury.
With ﬁve cases total, each
with varying difﬁculty levels,
the game delivers plenty
of exciting legal drama.
Because it’s ﬁlled with cheesy
one-liners and dramatized
Japanese animation, it
maintains a light, humorous
atmosphere, though you
might tire of all the clicking
through you have to do to get
through each line of dialogue.
The bottom line. All in
all, this game will have you
shouting “Objection!” in no
time. —Florence Ion

Intriguingly, ToDoGenius features an “AI” that helps you choose the
perfect task. Just tell the ToDo Genie where you are and how you
feel, and it’ll conjure up a suggestion from your to-do lists. It isn’t
magic—just programmed rules—but the feature gives ToDoGenius
lots of charm.
This productivity app is also snappy and easy to use. Adding
tasks is a breeze thanks to a slick, color-coded interface, and it’s
loaded with features that let you add due dates, link contacts, and
set alarms for tasks. You can ﬁlter tasks by type, reuse old to-dos,
and split goals into smaller chunks. While that’s plenty helpful,
ToDoGenius disappointed us by limiting our plethora of tasks to two
categories: work
and home.
The bottom
line. The Genie
is more gimmick
than genius, but
ToDoGenius is
easy to use and
packs a ton of
handy features.
—Dustin Driver

This court drama will surely
have you on your feet—even
if you’re playing it while
sitting down.

Phoenix Wright 1.00.00
Capcom
capcom.com/phoenixwright
$4.99
GREAT

Flip your device to get a
Stickies–meets–Time Machine
view of to-do’s.

iPHONE

ToDoGenius 1.0.2
Ipanamea
www.todogenius.com
$7.99
GREAT

iPHONE

POCKET LEGENDS

GUITAR HERO

MMOs have traditionally been the domain of Macs and PCs, so Pocket
Legends grabbed us by promising to bring World of Warcraft–style
gaming to iOS devices. It sets you up as a furry little animal hero who
must defeat zombies, yetis, and other villains. Levels are choose-asyou-go, so following along with the storyline can get confusing, but
most quests can be done alone, so entering a level with other players
doesn’t mean you have to co-op. Unfortunately, the game has clumsy
controls and redundant visual backdrops, but on the plus side, a nice
tip system helps new players, and the generous focus on loot-collecting
will keep MMO fans
beavering away.
The bottom line.
This game gets
monotonous unless
other friends join you
to blaze the trail, but
it’s still a decent stab
at bringing an MMO
to iOS.—Florence Ion

Guitar Hero for the iPhone won’t fulﬁll your rock-god dreams, but
it will rock you in its own mobile way. That’s because Activision
adds swipe notes to the cascading audio timeline iPhone gamers
are accustomed to with other music games. The swipe brings new
ﬁnger action to the music genre that, surprisingly, doesn’t feel like a
gimmick. The app ships with six songs, and $1.99 three-song packs are
available via in-app purchases. As
of press time, the pickings were
slim, and songs were only sold as
bundles—a bummer if you only

The Mage’s magical powers have
sweet-looking effects, though they
don’t do much to your enemies.

SOLID
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Pocket Legends 1.21
Spacetime Studios, LLC
spacetimestudios.com
Free (not including in-app
purchases)
iPHONE+iPAD

want one song out of the pack.
The bottom line. We did
encounter a few bugs, and the
inability to fail at a song took
away some of the urgency of
getting all the notes correct.
Still, the game rocked our
morning commute.
—Roberto Baldwin
Guitar Hero 1.0.0
Activision
hub.guitarhero.com/games/
ghiphone/
$2.99

I wanna rock! Especially if it
involves giant ﬁreballs.
GOOD

iPHONE+iPAD
iPHONE
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PUTTING DOWN THE SNOOZE-PAPER
Healthy iPad options make your RSS feeds A-OK
Like it or not, RSS feeds are the news
carriers of the future. Instead of having a
newspaper delivered to me each morning
by a kid on a bike, I get my news delivered
to me each second through the blazingly
fast internet tubes. What’s more, RSS feeds
allow me to subscribe to only those things
I actually care about, meaning no more
ﬂipping through boring business sections
to get to my comics. The problem is most

If it looks like a newspaper and feels like a
newspaper, it might not be a newspaper.

iPad feed aggregators (a fancy term for RSS
collectors) are as ugly as sin or as hard to
understand as another Jersey Shore spinoff.
So I set out to locate the best and brightest
ways to consume RSS news on my iPad’s
gorgeous screen.
That quest ﬁrst brought me to the muchhyped Pulse News Reader ($4, alphonsolabs
.com). Steve Jobs took a liking to this bad
boy and showed it off live at WWDC. Later
that day, Apple pulled it from the App
Store after receiving complaints that it
was utilizing New York Times’ newsfeed.
However, it’s back and now more Timesless than ever. Pulse utilizes columns of
news that can be navigated both vertically
and horizontally. Most of the news items
are displayed as a thumbnail with a small
headline underneath. Pulse can also track
top stories on Digg and constantly showed
off new tweets from my Twitter feed.
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Clicking on a thumbnail brought up an
unassuming grey background with easyto-read black text. The thumbnails dimmed
slightly after being clicked to indicate which
stories had been read, and altogether Pulse
was attractive and easy to use.
I’d also heard about Reeder ($5,
reederapp.com), an app that was getting
more buzz than a vuvuzela at the World Cup,
so I decided to give it a try. Reeder imports
all your feeds from Google Reader with a
straightforward login and then displays
them in a minimal, stylish stack format.
However, I didn’t use Google Reader before
my RSS quest, and Reeder’s inability to
add feeds from the app was initially a bad
sign. If you haven’t used it, Google Reader
(google.com/reader) is an effective but
ridiculously ugly site that compiles multiple
feeds that you subscribe to. Reeder, on the
other hand, is by far the cleanest, most
stylish RSS feeder to use. That’s because
Reeder puts all your news in virtual stacks
of papers. Folders (which are easy to make
at Googlereader.com) can be reversepinched to display the folder’s contents.
News stories can be pinched back into their
stacks, and headlines swiped to be marked
as read or made favorites, or tapped to
display in full story form. The ease with
which these functions are accomplished is
remarkable; Reeder feels like an app created

A classy layout and look proves the Stanfordstudent creators had their ﬁngers on the pulse.

The Reeder app has more input commands than
you can shake a ﬁnger at.

RSS feeds allow me to
subscribe to only those
things I care about...like
the comics.
by Apple to show off the possibilities of an
iPad. The last stop on my quest was The
Early Edition ($5, glasshouseapps.com), a
straightforward aggregator that delivered
my news in nostalgia-inducing newspaper
format. After using Reeder, I wanted to use
pinches and swizzles and swoopydedoops
and all the other fancy input functions it had
implemented. But what The Early Edition
lacks in input functions, it makes up for in
ease of use; everything is simple—including
importing RSS feeds, OMPL folders, and
Google Reader accounts. The Early Edition
is also a good starting point for people
unfamiliar with RSS as it comes jam-packed
with recommended feeds.
All of the apps I tested did similar things,
but they all had distinct advantages. If you’re
not afraid to drop a couple bones to test out
what works best for you, you might prefer
one of these three great RSS readers over
the other. Unfortunately, the same can’t be
said about your paperboy, who might just be
replaced.—Nic Vargus

Introducing App-Stravaganza!

Suggested Uses. Inﬁnite.

Interested in
marketing your
iPhone app or
product here?
The best holder for

iPhone 4 to iPhone 4
FaceTime Video Calling.

Clamp it to a plane’s tray table, a
treadmill or anywhere else you
go. The IN YOUR FACE viewbase
conveniently holds your iPhone
or iPod touch with or without
a case. To find out more go to
theinyourface.com

Contact your MacILife advertising representative
for more details!

flexible holder for iPhone

Aida Rodriguez at 708-562-0686
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APPLE 2.4GHz
CORE 2 DUO MAC MINI
This mini is mighty

A

pple’s been pouring its design magic
into handhelds lately, but now the
lowly Mac mini joins the ranks of
unibody hotness, complete with a glossy, almost
liquid-looking black Apple logo on top. The
smooth aluminum brick has zero screws or
visible seams, just a round black hatch on the
bottom that pops off with a twist, letting you
upgrade the included 2GB of DDR3 memory
to a maximum of 8GB. Gone and not missed is
the sweaty pleasure of prying open a previousgeneration mini with a putty knife.
The unibody mini is only 1.4 inches high,
measuring 7.7 inches square and weighing
3 pounds. It’s even shed the bulky power brick
for a built-in power supply and a regular old
cable. It’s more efﬁcient too, consuming under
10 watts of power when idle, which Apple says
is 25 percent better than the last generation.
Even the package is smaller, roughly the size of
a takeout salad container.
But good things come in small packages,
including a zippy 2.4GHz Core 2 Duo processor.
The integrated Nvidia GeForce 320M graphics
processor shares its 256MB of memory with
the main system RAM, but we saw respectable
performance, clocking 47 frames per second
in Call of Duty 4. Of all the machines we’ve
tested this year, only the Core i5 MacBook Pro
beats that benchmark—pretty impressive for
an entry-level Mac. Read more about the test
results at maclife.com/mid2010macmini.
The mini’s ports include one FireWire 800,
four USB 2.0, Ethernet, an SD card slot, and two
video-out ports: Mini DisplayPort and HDMI.

The new unibody mini
provides a hatch on
the bottom that you
can quickly pop off to
upgrade the RAM.

Scan & PDF: worldmags & avaxhome

It can simultaneously support a 1920x1200
HDMI or DVI display and a 2560x1600 Mini
DisplayPort or VGA screen, giving you lots of
options whether the mini lives in your living
room or ofﬁce. Making its ﬁrst appearance ever
on a Mac, HDMI provides both 1080p video and
8-channel 24-bit audio in one cable. Apple also
includes a video-only HDMI-to-DVI adapter.
While bumping up the specs, Apple also
bumped up the price. This mini starts at $699
(2.4GHz processor, 320GB hard drive), $100
more than the last version (2.26GHz, 160GB
hard drive). The pricey DDR3 RAM is getting
cheaper all the time—the full 8GB upgrade
runs $500 from Apple or (at this writing)
around $290 from Ramjet.com or Other World
Computing (macsales.com).
Unfortunately, Apple considers the RAM
the only user-serviceable part. It’s a shame
to have that huge hole in the bottom and still
not be able to upgrade the hard drive, which
only comes in 320GB and 500GB capacities.
iFixit.com has DIY instructions, but you have to
move a lot of parts—including the logic board,
which sounds incredibly nerve-wracking to us.
And the port placement—everything on
the back—makes it awkward to plug in ﬂash
drives and SD cards, depending on where the
mini is stashed. Moving the power button, SD
card slot, and two of the four USB ports to the
front would help, even if it would mar the mini’s
perfect form.
2.4GHz Core 2
The bottom line.
Duo MaC Mini
The new Mac mini’s
Apple
apple.com
strong consumerPrice: $699
level performance,
Specs: 2.4GHz Core 2 Duo, 2GB
beautiful design, and DDR3 SDRAM, 3MB shared L2
cache, 320GB 5,400-rpm SATA
good value make it
hard drive, Nvidia GeForce 320M
graphics processor with 256MB of
a tempting choice,
DDR3 shared with main memory, 4
USB 2.0 ports, FireWire 800 port,
especially if you
SD card slot, Mini DisplayPort, HDMI
ﬁnd the iMacs’ and
port, audio in, audio out, built-in
MacBooks’ standard speaker, Gigabit Ethernet, 802.11n
AirPort Extreme, Bluetooth 2.1+EDR
screens far too
Great performance for the
glossy. If replacing
value. Easy-access RAM slots for a
maximum of 8GB. HDMI out.
the hard drive were
Inconveniently located SD card
an Apple-approved
slot and USB ports. Hard drive
isn’t upgradeable.
upgrade, it’d be just
about perfect.
GRE AT
Mac | Life
R A T E D
—Susie Ochs
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AdobE PhotoShoP LightRooM 3

Adobe’s pro tool is better than ever, but does that mean it’s the best?
For everyday snapshots of your kids, your dog, and
your road trip to see the world’s largest ball of twine,
your Mac comes with iPhoto, a simple way to organize
and edit your photos. But pro shutterbugs and
photography enthusiasts need far more serious tools
to manage ever-growing libraries of tens of thousands
of images. Adobe’s latest iteration of Lightroom aims
to answer that call with pro-level organization and
photo management, as well as robust editing tools for
perfecting your shots.
In fact, Lightroom 3’s editing tools are the real strong
point. Edits are nondestructive, so you can go back
and tweak (or remove) any of the adjustments you’ve
made or create multiple versions of the same image

PhotoshoP
Lightroom 3
Adobe
adobe.com
Price: $299; $99 upgrade
Requirements: Mac OS 10.5 or later;
Intel processor
Superb image-editing tools.
Web-, slideshow-, and print-output
options are even better than before.
New lens corrections. Widespread
performance improvements
$100 more than Aperture 3.
Screen-hungry interface. Collection
and stacking limitations.

Mac | Life

GREAT

R A T E D
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natural grain effect, perspective-correction tools for
ﬁxing things like converging verticals in tall buildings,
and a more natural-looking vignette effect.
On the back end, Adobe has completely reengineered Lightroom 3 to improve overall
performance, and this is especially noticeable with
big catalogs and high-resolution images. Even on a
modestly powered MacBook with 2GB RAM, our test
library of 30,000 images loaded noticeably faster than
it did in the previous version of Lightroom.
Some other impressive changes improve input and
output. Adobe has streamlined importing photos, and
the new tethered shooting lets you connect certain
cameras directly to your Mac, sending shots into
Lightroom as
you go—perfect

for studio
photography.
On the output
side, Lightroom 3
supports visible
watermarks,
multi-image print
layouts, and
exporting photo
slideshows as HD
movies, complete
with soundtracks.
Lightroom can
also now sync
your photos to
a Flickr account
for automatic
Lightroom’s stacking tools aren’t as good as Aperture’s, but the great Filter menus in
web sharing.
the Library view make it easy to narrow down your searches.
So Lightroom 3
is a seriously
powerful professional tool. But is it better than Apple’s
with different treatments. Lightroom doesn’t support
Aperture 3? When comparing the two, Aperture is much
layers, masks, or other advanced Photoshop tools, but
better at organizing images. It has a clean, uncluttered
for many photo enhancements, it’s quicker than pulling
interface, it scrolls through thumbnails a little more
out Adobe’s big gun.
snappily than Lightroom, and its ability to store albums
One of the best new features is automatic lens
both inside and outside projects provides much more
correction, which can correct for distortion, chromatic
ﬂexibility than Lightroom’s confusing Folders (on the
aberration, and vignetting for each of your lenses.
hard disk) and Collections (virtual albums), which really
Downloadable proﬁles are available for popular lenses,
don’t mesh well. While Aperture excels as a cataloguing
and if there isn’t one for your favorite glass, you can
tool, Lightroom has the edge when it comes to editing.
create and save your own for later re-use. The RAW
The bottom line. It’s a no-brainer for Lightroom 2
conversion process has also been improved, enhancing
users thinking of upgrading, but Lightroom 3 versus
ﬁne detail. New noise-reduction tools produce smoother
Aperture 3 is another story. If cataloguing is more
images at high ISOs without serious loss of quality,
important, then Aperture is the way to go, but
and the sharpening is also improved. When using both
Lightroom’s beeﬁer editing tools offer more ﬂexibility
features, you do need a bit of skill to get the balance
for pro photographers and advanced hobbyists.
just right, but that’s always been the case with noise
—Rod Lawton
reduction and sharpening. Other changes include a

EtERnaL StoRMS FLickERy
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A smarter, better way to Flickr
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Since Flickr’s inception in 2004, shutterbugs have been posting their
photos to ﬂickr.com for the world to see—and comment on. And
Flickery from Eternal Storms improves that experience by providing
a portal that makes everything cleaner and faster.
Flickery sports the now-familiar pane-based interface of iTunes
and iPhoto. The column on the left offers one-click access to images
marked as Favorites, drop-down menus for your photosets, and
folders for your searches. Search terms can be used to quickly drill
down to speciﬁc locations, descriptive text, tags, and users. Prior
searches are persistent and refresh whenever you open Flickery,
so it’s easy to keep tabs on your favorite Flickr users or tags. When
you’re done with a particular search, they can be quickly nixed.
The main display area shows images in a grid, and a slider on the
bottom increases the number of photos onscreen to a maximum of
21 at a time. The right-hand pane lets you view and post comments,
as well as edit photo titles, tags, and descriptions. Photo geeks can
also peek at EXIF data, great for picking out behind-the-scenes

It’s Flickr, only faster.

details. If a photo has geotag data embedded in it, Flickery can easily
show you other images taken nearby. Additional photo information,
like comments and licenses, are tabbed and can be hidden for more
picture-viewing real estate.
Flickery also gives you some editing tools for your images.
Although Flickery can’t access Picnik, the ofﬁcial Flickr editing client,
it does come with its own rudimentary editing system. The built-in
tools aren’t for serious polishing, but they’re nice for ﬁne-tuning
brightness or image sharpness.
And speaking of your images, getting your masterworks online
with Flickery is a snap. The Upload tab includes options for sending
photos and videos to Flickr, as well as recording quick screencasts
and grabbing screenshots. Obviously, photo and video uploads are
the functions you’ll use most often, but the others are so simple that
you might as well take advantage of them if you need to.
The bottom line. Flickery is faster, cleaner, and arguably an
all-around better experience than Flickr. Frequent users shouldn’t
hesitate to drop $18 on this impressive software.—Nic Vargus
Scan & PDF: worldmags & avaxhome
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Eternal Storms
eternalstorms.com
Price: $17.95
Requirements: Mac OS 10.5 or later,
free Flickr account
Everything is always in one
window. Does nearly everything
Flickr does. Spells “ﬂicker”
correctly.
A little slow to enlarge photos.
Limited editing from within app. No
group view for photosets.
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A slim, ultra-portable scanner
comes in handy more often
than you might think.

APPAREnt DOXIE
Simply adorable

Doxie
Apparent
getdoxie.com
Price: $129
Requirements: USB port. Mac OS
10.5 or later
Extremely portable. Quickly
scans documents and photos.
Online storage and socialnetworking integration is
convenient.
Scanned photos aren’t coloraccurate. Oddly sized items tend
to skew if not fed through the
scanner straight. Highest resolution
is 600 dpi.
GO O D
Mac | Life
R A T E D
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From the moment you take it out of the box, Doxie will
charm you—and not just because it’s adorned with
pink heart stickers. Doxie is a portable, easy-to-use
scanner that may very well replace that huge hunk
of a scanner you have collecting dust in the corner of
your home ofﬁce—as long as your scanning needs fall
into the “nothing too complicated” category.
Setting up Doxie is a snap. All you have to do is plug
it in to a USB port (no AC power required), download
the software from getdoxie.com, and feed through
a calibration page. And speaking of feeding, sending
documents and photos through the scanner is a cinch,
and Doxie easily handles oddly sized paper. You do
have to take care to align pages as they enter the
feeder, though, or the resulting scans end up a bit
skewed.
The best part about the software is its socialnetworking integration. You can set up the software
to share your scanned items via popular sites like
Twitter, Tumblr, Google Docs, and Flickr. Additionally,
the free Doxie Cloud service allows you to upload
your ﬁles and generate a short URL valid for a certain
amount of time, ranging anywhere from one week to
three months. These time-limited links can be useful,
but we’d also like the ability to password-protect
certain documents for added security.
The scan quality of the Doxie is ﬁne for casual use.
Business travelers will also like its slim, ultra-portable

form factor and the fact that it doesn’t require a bulky
AC adapter. Pro users, though, will ﬁnd the Doxie’s
tech specs a bit soft. For starters, this scanner isn’t a
ﬂatbed, so it’s only good for sheets of paper that can
be fed through the device (up to 8.5 by 14 inches).
And Doxie’s resolution tops out at 600 dpi. The color
quality of the scanned photos is slightly washed out,
but scans of black and white text documents were
satisfactory. Getting our scans perfectly straight was
also a challenge, though the software does allow you
to rotate the scans if things get a little out of whack.
The scanning software that comes bundled with
Doxie is incredibly simple to use. To scan a document,
press the Scan button in the software window, or
press the heart-shaped button on the device itself. As
soon as your scan is ﬁnished, the software displays a
window with several customization options. You can
add more pages to scan a multipage document into a
single ﬁle, as well as perform minor photo corrections
like cropping and tweaking the contrast, brightness,
and saturation. You can also conﬁgure the Doxie
scanner software to open your scanned images in
other applications for editing, like Adobe Photoshop,
Picasa, and iPhoto.
The bottom line. Casual users and travelers will
appreciate the ease and portability of this adorable
little scanner, but serious professionals should look for
something a little more…serious.—Florence Ion
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With EyeTV One, you
don’t need a TV—or even
an internet connection—
to catch up on all of your
favorite shows.

ELgato EyEtV onE
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If you were one of the Lost faithful that missed the series ﬁnale
because of a scheduling faux pas—yes, we’re still mad about
that—you’ll be glad to hear that Elgato’s EyeTV One can keep you
on track with your favorite shows. This simple digital TV tuner can
transform your Mac into a TV, and best of all, the included EyeTV 3
software schedules and records shows for later viewing.
Out of the box, EyeTV One is incredibly user-friendly. Setup
amounts to little more than plugging in a coaxial DTV antenna—
which you’ll need to purchase separately—and plugging the EyeTV
One into a USB port. From there, the EyeTV 3 software is the real
brains behind the operation: an Auto-Tune option retrieves a list of
channels available in your area, while the program guide—provided
free for the ﬁrst year from TV Guide, then for $19.95 a year after
that—lets you know what’s on.
In our testing, the EyeTV picked up about 30 different channels
in a residential San Francisco neighborhood. At the Mac|Life ofﬁce,
located in an ofﬁce park farther away from “civilization,” we got
half as many channels, so the usefulness of the EyeTV depends
largely on your location and the reception of your antenna. Using
a simple 12-inch antenna placed near a window, we got HD feeds of
network afﬁliates and lower-powered local stations.
While you can use the EyeTV to watch live TV from your
Mac, the best features are its recording and exporting abilities,
giving your Mac DVR (digital video recorder) superpowers. We
manually recorded individual shows and set the EyeTV software
to automatically pick up episodes of our favorites using the Smart
Guide feature. And if there are reruns to avoid, you can manually
select showings to skip.
But don’t throw out your dedicated TiVo box just yet. The
EyeTV One is a single-tuner affair. You can’t ﬂip channels when
you have a recording in progress, and you can’t record two shows
simultaneously. But recordings can be converted for Apple TV or
your iOS device, shared with other computers in your network, or
burned to a DVD with Toast or another external app for archiving.
There’s also a nifty, easy-to-use iPhone app to help you schedule
and stream recordings while you’re away from your home
computer, though that’ll cost you $4.99.
The bottom line. Coupled with the EyeTV 3 software, EyeTV
One is a simple, portable way to pipe digital broadcasts into your
Mac.—Florence Ion
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TV on your Apple—no downloads required
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Elgato
elgato.com
Price: $119.95
Requirements: Intel processor, Mac
OS 10.5.8 or later, your own antenna
Free, over-the-air high-deﬁnition
television. Powerful recording tools.
You’ll have to pay for TV
Guide service after the ﬁrst year.
No bundled antenna. Only one
tuner. Annoying pop-up ads in the
program guide.

Mac | Life
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BLuE MicroPhonES YEti
Record the call of the wild

B

igfoot may get the majority of the media’s attention,
especially after his stint on The Six Million Dollar Man. But
the real star in the half-man/half-bear/monkey/gorilla arena
is the Yeti. While Bigfoot is out stomping his footprint into mud, the
Blue Microphone Yeti (shown left at very close to its actual size) is
doing a bang-up job recording your podcasts, band practices, and
events. Pretty good for a mythical creature—er, an affordably priced
USB mic.
Blue is known for its line of microphones for nerds, but the Yeti mic
takes the company’s dedication to computer-connected mics to the
next level. It includes on-mic controls for selectable audio-recording
patterns (stereo, cardioid, omnidirectional, and bidirectional),
the ability to adjust the gain, a volume control for connected
headphones, and a light-up mute button for when you’re sneezing—
or saying things your mom wouldn’t approve of.
The mic itself is a solid piece of hardware. Its heft keeps it planted
on your desk without worry of knocking it over during spirited
recording sessions. If Edward R. Murrow needed a USB mic, this
is what he would have on his desk. For you singers out there, the
base can be removed and the Yeti can be attached to a standard
microphone stand.
But let’s not forget that all the whiz-bang features in the world
don’t matter if the mic can’t deliver the audio goods. And the Yeti
does just that. Our audio recordings sounded crisp and clean. The
stereo recording setting was especially impressive. Audio panned
smoothly as the sound source moved around the room. When
recording in cardioid mode (intended to cut down on background
“air” in your recordings) we had to lean in close to the mic. It’s
okay for singing, but it can get tiresome for longer sessions like
podcasting. Overall the audio recording was stellar—and we didn’t
even need to download drivers. We just plugged it into GarageBand
and were ready to go.
The bottom line. If you need to capture quality live recordings on
your Mac, the Yeti will deﬁnitely deliver—and you get to look like an
old-timey newscaster.—Roberto Baldwin

Yeti
Blue Microphones
bluemic.com
Price: $149.95
requirements: Mac OS 10.4.11 or
later, USB 1.1 or later
Hard controls on mic. Excellent
audio recording quality.
Controls on back of mic are
awkward. Cardioid mode can
sound thin.
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CoCoon GRaMeRCy
MessenGeR sLinG
A mixed messenger

Cocoon’s Gramercy bag tries to make carrying your
iPad into a fashion statement of its own. And hey, why
not? The iPad is sleek, sexy, and undeniably cool—
shouldn’t it have a case to match? As if in answer
to that question, this bag nicks its name from the
crazy-fashionable Gramercy neighborhood of
Manhattan, but its overall stylishness is more plain
and pedestrian. It’s available in black, grey, or red,
and provides just enough space to schlep an iPad
and the included Grid-It accessory organizer.
The Gramercy is a vertical messenger-style bag.
The front features a small pocket sized to ﬁt an
iPhone or iPod touch, and the clear plastic material
allows you to change songs, answer calls, and
otherwise operate your device normally without
removing it from the pocket. That pocket is a
necessity because the bag’s only zippered pouch
will be occupied by the included Grid-It organizer,
a hardback board created to transport all of your
accessories. The back can double as a mouse pad,
but it’s the weave of elastic bands on the front
that makes Grid-It worth carrying. To keep all your
cables, power adapters, and earbuds in place,
simply slip your gear under the ribbed stripes.
Though it’s not much to look at, the Grid-It works
remarkably well. We could barely shake anything
free from the Grid-It board when we loaded it with
stuff from our desks. It worked ﬁne with both small
items and bulkier stuff like sunglasses. With the iPad in
the back sleeve, a fully loaded Grid-It ﬁts in the zippered
section with room to spare.
Almost everything about the Gramercy feels solid.
The bag is made from ballistic nylon and has a heavyduty zipper. But the strap is a bit wimpy—we wouldn’t
trust it with anything heavy, and the Gramercy is too
small for serious loads anyway. Which is basically its
major ﬂaw. It won’t help you haul a laptop, and if all

Gramercy
messenGer slinG
Cocoon
cocooninnovations.com
Price: $29.99
Requirements: iPad
Snug ﬁt without being too
tight. Front iPhone/iPod pocket is
useful. Grid-It securely holds your
accessories. Good price.
Shoulder strap is a touch on the
wimpy side. Bag is too small to ﬁt
more than an iPad.
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The red Gramercy looks like what you’d get if a deﬁbrillator
bag and a ﬁrst-aid kit had a love child.

you’re carrying is an iPad, you’re probably not going
to need to carry all the accessories intended to ﬁt on
the Grid-It. This poses a bit of an existential problem
for the bag as an object for daily use. If it can’t carry
everything you’ll need (and it can’t), then why use it at
all? Ultimately, this bag is ﬁlling a small niche for
people who need a way to haul around iPads but
not laptops, books, or even just a sandwich.
The bottom line: As long as you can travel
lightly enough, the Gramercy messenger is a solid
iPad bag with a very useful accessory.
—Nic Vargus

This seemingly simple
design works better than
you’d imagine and makes
carrying accessories
effortless.

ADVERTORIAL

Planning That Last Summer Road Trip?

With CarMD, Now For Mac, Solving
Automotive Repair Mysteries is Easy!
When you have an important deadline
at work or a weekend getaway
planned, the last thing you need is
for car trouble to slow you down. But
in today’s cars and trucks, virtually
everything’s computerized. And even
if you do have a degree in Computer
Science, it’s hard to determine
whether that dashboard-warning light
is serious or simple – until now.
Thanks to the CarMD® Vehicle
Health Monitor, now virtually
everyone who owns a car and a
computer can quickly and easily solve
automotive repair mysteries.

Don’t let the complicated-looking interface scare you away. It’s
easier than it looks, even if you’re not a power user.

SIBER SYSTEMS
GOODSYNC PRO

Reliably keeps your ﬁles in sync
With the Mac’s drag-and-drop interface, you’d think duplicating ﬁles
would be a snap. And if all you’re doing is a simple, one-time copy job,
it is. But OS X doesn’t offer much help if you want to regularly keep
ﬁles in sync. Sure, Time Machine handles backups, but even that has
its limits. You might want to work on your local machine for speed’s
sake, but then regularly copy your work over to a network drive, for
example. Or maybe you have a set of working ﬁles that needs to be
dumped to a USB stick at the end of every work day. GoodSync can
handle both of those situations easily—and it can be used in place of
Time Machine if Apple’s simple backup doesn’t quite meet your needs.
At its core, GoodSync copies ﬁles from Point A to Point B. It
doesn’t sound like much, but when Point A is your ofﬁce machine
and Point B is your Mac at home, the power of GoodSync quickly
becomes apparent. You’re not limited to folders on a single machine
or network, either. GoodSync is compatible with FTP, SFTP, and
WebDAV servers, as well as Amazon’s pay-as-you-go S3 ﬁle
storage (aws.amazon.com/s3). So no matter what your hardware
conﬁguration is, cross-platform GoodSync helps you build your own
ﬁle-synchronization setup.
GoodSync’s interface feels a bit
overwhelming at ﬁrst, but after some
GOODSYNC PRO
brief study, the conﬁguration screens
Siber Systems
will have you building bidirectional (for
www.goodsync.com
keeping two ﬁle sets in step) or onePrice: $29.95 for the ﬁrst Mac, $9.95
for additional machines
way syncs (for backing up to a second
Requirements: Mac OS 10.4 or later
location). We wish the Mac application
Reliable one-way and bihad built-in help, but the web-based
directional synchronizations. Works
with hard drives, ﬂash drives, or
manual is thorough, if a little technical.
online servers. Cross-platform.
The bottom line. It may not feel very
Requires a separate license for
each machine. Interface can be
Mac-like, but GoodSync offers ﬂexible
overwhelming and isn’t very Macﬁle syncing whether you’re working with
like. Dense online documentation.
a single Mac, a local network, or keeping
GO O D
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“I have a 24 hour drive between
where I live and where I go to school.
When I plug in my CarMD and get the
green light, I know I’m good to go.”

– Joanna R., college student

How it Works
Just plug the handheld CarMD
device into your vehicle’s Data Link
Connector (DLC) – the same place
your mechanic plugs in his expensive
diagnostic tools. In seconds, CarMD

Special MacLife Offer!
For a limited time, MacLife readers save
$10 when you buy online at CarMD.com
using promo code ML0910*
* Offer good ‘til 11-30-10. Discount off MSRP
(currently $98.99)
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FREE safety recall details for
your vehicle
CarMD customers now get FREE
access to see all of the safety
recalls associated with your
vehicle. This can help you catch a
problem that needs attention and
can often lead to low- or no-cost
repairs. (More information is
available at www.carmd.com)

beeps to conﬁrm the test is
complete. Then plug the CarMD
device into your computer to ﬁnd
out what’s wrong and what it will
take to ﬁx it, including parts and
labor in your zip code.

Coverage
The award-winning
CarMD works on 1996
and newer cars, light
trucks, minivans and
SUVs – foreign and
domestic. It monitors everything
that’s covered by a vehicle’s onboard diagnostic system, which
translates to about 80 percent of
the systems ranging from a loose
gas cap to a catalytic
converter failure.
CarMD software is now for
most Windows® PC and Apple®
Mac systems, including the new
Mac OSX Snow Leopard. Lifetime
software updates mean the CarMD
tool you buy today will work on
the car or truck you invest in
tomorrow. How’s that for peace
of mind, not only for the summer
driving season but for the LIFE of
your car?
To learn more, visit CarMD
online at CarMD.com.
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NikoN CooLPix L110

The 15x zoom delivers, but this low-cost shooter is light on extra features
The CoolPix L110 is a low-cost superzoom from Nikon’s
“L” line of consumer shooters, and while its 15x zoom is
attractive, the camera’s other features are somewhat
limited. For users with modest needs, the 12-megapixel
L110 offers straightforward photography at a good
price, but advanced shooters will quickly outgrow the
L110’s minimal feature set.
The 15x zoom is the camera’s
marquee offering, covering a
range equivalent to 28–420mm,
which is plenty for all but
the most extreme sports
or wildlife shots. While
other superzooms offer
DSLR-style

The L110 lacks the manual
controls and some of the
advanced photographic
features of more
expensive superzooms.

NikoN CoolPix
l110
Nikon
nikonusa.com
Price: $279.95
Requirements: Mac OS 10.4.11,
10.5.8, 10.6, or later; USB port; SD or
SDHC memory card
15x 28–420mm zoom. 3-inch,
460,000 pixel LCD. Autofocus and
zoom speed. Value for money.
Comes in snazzy red or basic black.
Very little manual control. Limitations in Easy Auto, Smart Portrait,
and Sport Continuous modes.
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manual exposure
modes, the L110 is
auto-only, which is a signiﬁcant
limitation. Here’s two more: the camera runs on
four AA batteries, rather than rechargeable lithiumion cells (Nikon says it can take up to 270 shots on a
set of ordinary alkaline cells and 840 shots on more
expensive lithium AAs). And it has no electronic
viewﬁnder, so pictures are composed solely on the
three-inch LCD.
The L110 has just ﬁve operational modes—Easy
Auto, Scene, Smart Portrait, Sport Continuous, and
Auto—which are selected via a button on the back of
the L110. The interface is basic in a way that makes it
clear that the L110 is designed for snapshot shooters
rather than photo experts. The Easy Auto mode offers
automatic scene mode selection, though it uses only
a handful of the more common scene modes, such
as Macro, Portrait, and Landscape, and the camera
often takes a few seconds to ﬁgure out the appropriate

mode. You need to switch to Scene mode to choose
from the full range of preset options. For capturing
people, Smart Portrait mode uses face and smile
detection to snap frames, though it’s a bit hit-ormiss—and depends on what the camera interprets as
a smile. In a lot of cases, you’re better off with one of
the other shooting modes.
Sport Continuous mode lets you shoot at
speeds of up to 11.1 frames per second and for
20 shots in succession, but the resolution is
limited to just three megapixels, and for some
reason the camera uses a minimum ISO of 640.
The manual does warn you to expect more noise
and that shooting in bright light may lead to
overexposure, but still…
The plain Auto mode is where you get
the most control over your photographs,
though there really isn’t very much to
play with apart from ISO, white balance,
and image size and quality. The good
news, though, is that while the L110
is certainly basic, that makes the
camera very simple to use.
Autofocus is responsive, even
at full zoom, and apart from a
slight dead spot in the middle,
the zoom travels quickly
from one end of its range to
the other.
This dead spot in the
zoom becomes a lot more
obvious in the HD movie
mode, where the zoom speed
plummets and the autofocus
becomes painfully slow. But even
the more expensive Nikon CoolPix
P100 (Aug/10, p64, 3.5 stars) has the
same problem—and a lot of digital cameras with
movie modes don’t zoom or autofocus at all while
ﬁlming. While it’s important to point out the L110’s
limitations, it’s equally important to point out that
it’s still pretty good for a stills camera—especially
at this price.
It’s a similar story with the picture quality. The lens
loses deﬁnition toward the edge of the picture, but
it’s sharp in the center, even at full zoom. It’s not the
best, for sure, but for the money, it’s better than we
expected.
The bottom line. The L110 is pretty basic, and some
of its features are quite slow to use or have annoying
limitations. But in its standard Auto mode, it delivers
good quality, it’s easy to use, and it’s very good
value.—Rod Lawton

SCOSCHE fLiPSynC

Until the day we can sync our iPods wirelessly, cables are essential
When is an iPod cable more than just an iPod cable?
And when will you ﬁnally solve the seemingly constant
problem of never having one handy when you need it?
When it’s on your keychain.
Scosche makes a number of über-useful iPod/
iPhone accessories, and the FlipSync is a fully
functional Dock Connector–to–USB cable that folds
up into a compact unit that measures less than two
inches long and weighs just 0.3 ounces. A separate
version providing USB–to–mini USB connectivity is also
available. With the connectors tucked away, it’s smaller
than the fob that unlocks your car.
Since the ends are both attached to one 5.3-inch
cable that runs through the plastic piece in the center,
they need to be pulled out one at a time. First you
pull the 30-pin dock connector out of one end,
then the ﬂat USB 2.0 connector on the other
end—Scosche subtly labels these 1 and 2 so
you remember. When you fold the FlipSync
back up again, the USB end is replaced ﬁrst,
then the dock connector. Well-made and
sturdy, the FlipSync ably does its job, and

we used it in a MacBook Pro’s crowded USB ports
without pulling it off our keychain, which was also
occupied by eight keys and a car fob. And keeping it
with our keys also gave us a natural excuse not to loan
it out to people, which is the No. 1 way iPod cables get
lost at Mac|Life HQ (our coworkers must think we get
them for free).
The bottom line. Apple charges $19 for a basic
cable, which is highway robbery. Scosche’s version
isn’t cheaper, but its utility and convenience give you
plenty of bang for your buck.—Susie Ochs

FlipSync
Scosche
scosche.com
Price: $19.99
Requirements: iPod or iPhone with
30-pin dock connector
Folds up into a lightweight
keychain. Sturdy. Convenient.
Fully extended, it’s
5.3 inches. Closed up,
less than 2.

Can be tricky to plug in to an
iMac since the cable is so short.
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FUN LIKE
F

SSUDOKU

SAVE 10%
TODAY WHEN YOU ORDER
Version 3 Personal Edition
CD-ROM products.

eexcept you end up

SPEAKING JAPANESE.
S
Watch anyone solving a Sudoku puzzle and you see a brain on ﬁre. Surprisingly,
what looks like work is actually fun. Not so surprising, say cognitive scientists,
because your brain loves solving puzzles. That’s how it learns.
At Rosetta Stone, we get the link between language learning and problem solving.
Every screen presents an elegant language puzzle with just enough challenge to make
learning effective and fun.
With Intelligent Sequencing,™ we help you solve new language meaning intuitively,
all without translation. And our sophisticated speech technologies have you speaking
from the start — in Japanese or any of our 31 languages.
Rosetta Stone® software is your language-learning solution. Let the fun begin!
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WIN/MAC compatible.

Six-Month, No-Risk, Money-Back Guarantee.*
Level 1
Reg. $229 $206
Level 1,2,&3

Reg. $539

$485

Level 1,2,3,4,&5

Reg. $699

$629

Call or go online
(866) 482-7278
RosettaStone.com/mas090
Use promo code mas090 when ordering.
©2010 Rosetta Stone Ltd. All rights reserved. Offer limited to Version
3 Personal Edition CD-ROM products purchased directly from Rosetta
Stone, and cannot be combined with any other offer. Prices subject to
change without notice. Offer expires December 31, 2010.
*Six-Month, No-Risk, Money-Back Guarantee is limited to Version 3
CD-ROM product purchases made directly from Rosetta Stone and does
not include return shipping. Guarantee does not apply to any online
subscription, or to Audio Companion® CDs purchased separately from
the CD-ROM product. All materials included with the product at time of
purchase must be returned together and undamaged to be eligible for
any exchange or refund.
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WEStERn DigitaL WD tV LiVE PLuS
Now playing: Netﬂix

We still miss our now-defunct local video store, but yes, Netﬂix
movies beamed right to our TV is a pretty fair trade. And if Netﬂix
streaming hasn’t found its way to your TV yet via a game console,
Blu-ray player, or TiVo, the WD TV Live Plus (the fourth iteration
in Western Digital’s line of home media players) makes a great
purchase. After all, who doesn’t want to pipe their digital videos,
music, and photos to their existing TV and stereo these days?
If that’s a superpower your living room lacks, the Live Plus can
be your radioactive spider with minimal hassle and none of that
messy biting.
At 3.94x4.94x1.57 inches, the petite WD TV Live Plus is the same
size as its predecessor (the WD TV Live), and hooking it to your
entertainment center is as easy as plugging in a few cables. An
HDMI or component port connects it to your HDTV for awesome
hi-def video, while a composite A/V out and a Toslink audio out talk
to your receiver. Add in a USB drive full of media and an Ethernet
connection for streaming media from network-connected media
shares, and you’re off.
Using the bundled remote, the Live Plus’s interface is perfect
for navigating from couch distance. The headlining new feature
is support for Netﬂix streaming. And unlike many Netﬂixcompatible devices, this one lets you actually add items to your
Instant Queue from the device itself. But don’t get too happy just
yet. While you can browse several category lists on the Live Plus—

New Arrivals, and various genre lists, for example—there’s no way
to search Netﬂix for speciﬁc content, so you’ll still need to head to a
Mac (or any number of iPhone apps) to do real queue management.
But like setting up the WD TV Live Plus itself, activating the box
on a Netﬂix account is a simple affair—we were watching Die Hard
2: Die Harder in no time (yes, voluntarily). The Live Plus delivers
another serious upgrade, too. Along with the alphabet soup of audio
and video ﬁle formats already supported by WD TV hardware, it now
supports DVD navigation. So rather than converting all your discs
to folders of menuless, ﬂat ﬁles, you can now use the Live Plus to
easily navigate disc images, including special features and extra
content. It mirrors the experience of playing back the original discs
themselves, and travelers, cinephiles, and parents of disc-destroying
toddlers will appreciate this extra
WD TV LiVe PLus
ﬂexibility—especially its added beneﬁt of
Western Digital
eliminating time you’d otherwise spend
wdc.com
transcoding video ﬁles to whatever digital Price: $149.99
Requirements: TV with HDMI,
format your player of choice requires.
Composite, or Component input
The bottom line. We would’ve liked to
Simplest way to get video ﬁles
have seen full Netﬂix search capabilities, from Mac to TV. Supports a huge
range of audio and video formats.
but the Live Plus’s streaming works
Netﬂix feature lets you browse
great, and its support for DVD navigation
predeﬁned lists, but there’s no
makes it feasible to set one up as the hub search capability.
GRE AT
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VIRTUAL TIMECLOCK ‘10 PRO EDITION
Punch the clock

Tracking your work hours has evolved considerably
since Fred Flintstone held a slab of rock in a bird’s
mouth and bonked it on the head. Virtual TimeClock
’10, the latest product to tackle the job, has reﬁned
employee time tracking to the point where clocks,
cards, and their attendant administrative tedium
are handily tamed. As the name suggests, Virtual
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Virtual TimeClock’s
excellent Report
Writer offers nearly
limitless combinations
of report parameters
without sacriﬁcing
ease of use.

VIRTUAL
TIMECLOCK ’10
PRO EDITION
Redcort Software
redcort.com
Price: $195
Requirements: Mac OS 10.3 or later,
1GHz processor
Simple for employees.
Outstanding, highly customizable
reporting engine. Cross-platform.
Initial setup can be confusing.
Documentation lacks useful
illustrations.
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TimeClock replicates the functionality of the
traditional employee time clock. The Basic edition
runs on a single computer and allows up to three
employees. The Pro edition we reviewed removes the
three-employee cap and adds features like overtime
tracking, vacation accrual, unpaid hours, and a
variety of reports. The Network edition pairs a server
application with client software to enable multiple
interconnected time-clock stations across one or more
physical locations.
From an employee’s perspective, using Virtual
TimeClock could hardly be simpler. It does away
with paper or magnetic-stripe cards, and employees
simply double-click their name on a list to clock in
or out. An optional password can be assigned for
employees to enter before they clock in or out as
well. For organizations that need to track more than
simple hours, Virtual TimeClock can track speciﬁc

activities—useful for situations where you need to
track billable hours. Employees can also add a note
to any time-clock entry, documenting a ﬂat tire on the
way to work, for example. And a built-in messaging
system lets users exchange messages. We’re guessing
that not many people relish the thought of yet another
inbox to manage, but the closed nature of the system
might appeal to HR departments who need a private
communication channel.
co
a
While day-to-day
Wh
y use for employees is simple,
administration of V
Virtual TimeClock is signiﬁcantly
ad
more involved. Setting up the system
m
iinvolves populating eight different
llists of information. Some lists
rrequire little explanation, like Users
and Departments. Others, such as
a
Overtime and Time Deductions, are
O
more complex. A quick-start guide
m
ccompetently takes newbies through
tthe initial conﬁguration process, but
a guided setup option would have
made the initial heavy lifting much
m
easier. A clear and comprehensive
e
user guide is available, although
u
tthere aren’t any explanatory
sscreenshots to help you through.
Since the software is cross-platform,
S
we can cut Redcort a little slack in
w
tthat department, but some visual
rreferences would be a welcome
addition to Virtual TimeClock’s
a
documentation.
d
Once you’ve got TimeClock up
and running, it’s easy to generate
a
detailed reports from the collected
data, starting with a handful of baked-in reports. The
Report Writer feature can also be used to modify
the existing ones or create entirely new reports to
suit the needs of your business. Export options let
you share data with other applications, though we’d
appreciate a bit more ﬂexibility than either tab- or
comma-separated text ﬁles. Still, Virtual TimeClock
manages to put a simple interface on a very ﬂexible
and powerful reporting engine—a very difﬁcult and
frequently underappreciated feat.
The bottom line. Virtual TimeClock ’10 Pro Edition
contains everything a small- to mid-sized company
needs to track workers and time-dependent beneﬁts. A
lack of visuals in the documentation is made tolerable
by a clean and well-thought-out interface. Reporting
features can’t eliminate rote administrative tasks
entirely, but it can make some of them a lot less
onerous.—Stuart Gripman

Matias tactile Pro 3
The sound of success

TacTile pro 3
Matias
matias.ca
Price: $149.95
requirements: Mac OS X; USB port
Great feel keeps you connected
to your typing. Symbols and special
characters printed on keys. Built-in,
three-port USB 2.0 hub. Includes
Volume and Eject keys.
Clattering sound can overpower
quiet rooms. Caps Lock lights but
doesn’t stay down when activated.
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Apple makes excellent pack-in keyboards—unlike
the bizarro world of PCs and their cheap-as-possible
extras. But even Apple’s standard can be beat, and
Matias’ new Tactile Pro 3, a USB 2.0 keyboard with a
decidedly old-school feel, does just that. Mechanical
springs and switches let you feel the action as you
type, subtly improving your accuracy and comfort
while you’re in front of your Mac.
Of all its features, Tactile Pro’s keys speak the
loudest—literally. The keys click and rebound like
clattering rain on a sheet-metal roof. This keyboard
deﬁnitely won’t blend in if you work in a quiet ofﬁce,
and recipients of our phone calls found it distracting.
But we embrace the sound and consider it a small
price to pay for the precision of mechanical keys. The
keys collapse at a point that you can feel, sending
commands to a Mac. With either nimble typing or halfhearted stabs, we could tell every time if the key had
traveled far enough to register a keystroke.
Tactile Pro gets high marks for its key switches, but
its other features back up that success. Contoured key
caps cradle your ﬁngers, helping you stay centered.
Each key is also etched with its extended characters,

making it easy to use often-forgotten symbols. Two
feet raise the back of the keyboard at an angle,
although we prefer the default pitch. Three USB ports
are useful for ﬂash drives and other accessories even
though Matias doesn’t ofﬁcially support charging.
Despite that, we were still able to charge an iPhone.
We only have one complaint. We wish the Caps
Lock key would stay down when activated. It’s a small
detail, but it would’ve provided excellent feedback
in a keyboard that otherwise excels at feedback and
accuracy.
The bottom line. Its sweet feel—and sound—make
the Tactile Pro 3 one of our favorite keyboards
ever.—Zack Stern

The key action echoes the classic Apple Extended Keyboard.
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Keyboard Maestro’s macro editor offers plenty of options, but its sleek design keeps things simple.

STAIRWAYS SOFTWARE KEYBOARD MAESTRO
Holy macros!

KEYBOARD
MAESTRO
Stairways Software Pty Ltd.
keyboardmaestro.com
Price: $36
Requirements: Mac OS 10.5 or later;
10.6 recommended
Lets you easily build shortcuts
that speed up routine tasks.
Floating palettes put window, app,
and clipboard management a click
away. Efﬁcient interface.
Doesn’t sync shortcuts among
Macs or allow custom organization
of actions.
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Insanely great as Macs are, using them means losing
some of your day to launching apps, hunting down
ﬁles, and performing other routine iChores. Keyboard
Maestro helps reclaim some of that time by letting
you create custom macros—keyboard commands
that automate lengthy or repetitive tasks and add new
productivity tricks to your favorite applications. It’s a
powerful package that can simplify any Mac user’s life,
but if you’re not already comfortable with Macs, you
may need to work a bit harder to get the most from
the application.
Keyboard Maestro comes with predeﬁned macros
for everything from keyboard control of your cursor
to searching Google from any application, but you’ll
quickly learn how to build your own macros thanks
to the streamlined editor and a handy tutorial. Just
set a macro’s activation trigger, then choose from a
searchable library of customizable actions you want
to perform. Triggers can be hotkeys, system events,
schedules, and more (even commands from the web
or the Keyboard Maestro iPhone app). Actions activate
button presses, text input, scripts, and almost anything
else you can click, type, or move on your Mac. If you
don’t see the exact action you want, you can record
steps taken in any application and add them to your

macro. When it’s ﬁnished, a macro can be activated
individually or in a group, assigned to work globally or
only in speciﬁc applications, and made available from a
menu bar icon or ﬂoating palette for quick access. More
than a one-trick macro machine, Keyboard Maestro
also offers additional palettes that let you manage and
control windows, multiple clipboards, and applications on
the ﬂy with—yeah, you guessed it—macros.
Despite everything Keyboard Maestro let us do, we
still wanted a bit more. Macros can be shared manually,
but can’t be synced automatically across multiple Macs.
Actions are organized strictly according to preset
categories; the ability to create our own organizational
structure—or to save frequently used actions as
favorites—would make macro design even easier. And
while Keyboard Maestro strives mightily to meet novice
users halfway, the extensive documentation assumes
an understanding of nitty-gritty Mac and computer
operations that not all users will share.
The bottom line. Minor missing features aside,
Keyboard Maestro is a productivity-boosting toolkit
worth a serious look. It may not get you out of the ofﬁce
any earlier, but its ﬂexibility and features will juice your
productivity.—Adam Berenstain

Griffin A-frAme

The A-frame
folds up, but
it’s still too
heavy to
carry around
regularly.

Hefty iPad stand with a price to match
The iPad is great for video, but after about 15 minutes
of holding it up, we start looking for ways to use it
hands-free. Grifﬁn’s A-Frame gives your arm a rest
and sports a minimal style that doesn’t detract from
the iPad itself. If it weren’t for the logo plastered on
the front, it could almost pass as a piece of modern
sculpture. But don’t be fooled—there’s quite a bit of
substance here to go with that style.
A-Frame is as hefty as it is attractive and weighs
nearly as much as an iPad. It’s built out of thick
aluminum with hard edges and silicone grips. It’s
clear that this isn’t a stand to lug around; it’s a
desktop solution. But the weight adds to A-Frame’s
functionality. Unlike lighter competitors, the A-Frame
stays put as you use your iPad, touching, pinching
and scrolling through games, webpages, movies,
and documents.
Grifﬁn didn’t stop at simply building a sturdy stand,
however. Small details help the A-Frame stand out from
the competition. For instance, a small recess on the
speaker side of the silicone cradle actually makes the
iPad a tad louder when you put it upright. The cradle is
also wide enough to ﬁt an iPad outﬁtted with a number

of different cases,
including Apple’s
iPad Case.
The stand looks
and feels great
when the iPad
is positioned in
either landscape
or portrait
mode. In
portrait
mode, a
well-designed
cut-out in the
back lets you plug in for charging or syncing without
visible wires. You can also fold up the A-Frame and
place it on a desktop, and it’ll keep your iPad at an easy
typing angle, which also works well if you’re using a
Bluetooth keyboard. It’s a spiffy functionality that you
never realized you needed until you have it.
The bottom line. Quality comes with a price, but with
a cost as hefty as the aluminum, this stand may not be
for everyone.—Nic Vargus

A-FrAme
Grifﬁn
grifﬁntechnology.com
Price: $49.99
requirements: iPad
Sturdy. Speaker recess improves
sound. Supports portrait, landscape,
or table-top orientation. Smartly
designed cut-out for plugging in
or docking.
Really expensive. Heavy enough
to not be portable.
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>>> Reviews Tough testing, trusted ratings

PoLaRoid 300 inStant CaMERa
Shake it like a Polaroid picture

After a two-year hiatus, Polaroid is back with an instant camera that
has a whole new look and feel. The Polaroid 300 instant camera is
a cross between the company’s now-antiquated One600 model and
the i-Zone pocket camera from the early 2000s, and taking photos
with it is just as much fun as it was with its predecessors.
Loading the ﬁlm is as easy as always. Simply drop in the ﬁlm
cartridge and hit the shutter button to eject the plastic sheet that
protects your ﬁlm. The camera powers up with a simple pull of the
lens, but it takes about 12 seconds to get ready to shoot. The long
delay means you’ll miss most action shots, but the upside is that
the photos develop “instantly,” and their small, 2.1x3.4-inch size
(roughly a credit card) makes them easy to carry around in your
wallet and share with friends.
Each ﬁlm cartridge gives you 10 exposures, so digital shooters
used to grabbing multiple shots at a time will beneﬁt from patience
and basic photo composition (since there’s no cropping). The instant
ﬁlm is ISO 800, so it can handle low lighting and fast movement, and

it also gives the photos a nice old-school graininess. The 300 lets
you choose from four different settings—Indoor, Cloudy, Fine, and
Clear—which adjust the camera’s aperture for proper exposure. All
of the modes trigger the camera’s onboard ﬂash when necessary.
Photos taken indoors are crisp and clear, though those taken
outside on a sunny day with the Fine setting came out overexposed.
Though the photos are a smaller form factor than classic Polaroid
600 snaps, they have the same vintage feel as before and take
about three minutes to develop fully.
The biggest downside to this charming camera is its price tag—
$90 is a bit much for a walk down memory lane. On top of that, it’s
$10 for each pack of ﬁlm. At about a buck a frame, this isn’t really
a camera for everyday picture-taking. While the nostalgia alone
might be enough for some, a dollar a pop feels steep for images that
don’t fully replicate the classic Polaroid experience.
The bottom line. If you’ve got the cash to spare for this nostalgic
throwback, the Polaroid 300 is a fun novelty shooter.—Florence Ion

Polaroid 300
instant Camera
Polaroid
polaroid.com
Price: $89.99
Requirements: Four AA batteries,
Polaroid 300 Instant Film
Instant gratiﬁcation. Has four
different picture modes. Photos
are small enough to carry around
in your wallet.
Expensive. Small images
don’t quite recapture the classic
Polaroid vibe.

Mac | Life
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Waking-Up Just Became Fun
Introducing the innovative iLuv App Station and Vibe Plus
TM

TM

App Station

TM

Award-Winning App-driven Multimedia
Alarm Dock for your iPhone or iPod
FREE iLuv App Clock for Time & Weather

Vibe Plus

TM

Dual Alarm Clock Radio with Bed Shaker
and Dock for your iPhone or iPod
Choose from 7 unique alarm sounds

Our History of CES Innovation Awards

For more information on these iLuv products,
download a free bar code or QR code reader for your
iPhone at the App Store to read the codes above.

www.i-Luv.com
©2010 www.i-Luv.com iLuv and Greenology are trademarks of iLuv Creative Technology registered in the U.S. and other countries. iPod is a trademark of Apple Inc., registered in
the U.S. and other countries. iPhone is a trademark of Apple Inc. iPod and iPhone are not included. The illustrated product and specifications may differ slightly from that supplied.
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>>> Play

HAVE MAC, WILL GAME

So, you guys are
brothers? We can see
the resemblance.

HALF-LIFE 2

Some things are worth waiting for
Almost six years after its release on Windows, the legendary Half-Life 2
has arrived on the Mac thanks to Valve’s Steam digital distribution
channel. For newcomers to the series, Half-Life 2 is everything the Mac
hasn’t had since the halcyon days of Marathon—it’s a terriﬁc sci-ﬁ/
horror ﬁrst-person shooter with a brain.
Set in a dystopian world where humanity has been enslaved by a
multidimensional alien race known as the Combine, Half-Life 2 places
you in the role of Dr. Gordon Freeman, a theoretical physicist turned
unlikely hero who must battle the Combine and work to free humanity
from both the Combine itself and the authoritarian human presence
that has seized power since the alien invasion.
The game takes a little while to get going—it’ll take about half an
hour to obtain your hazardous environment suit and get your hands
on the game’s ﬁrst weapon, the mighty crowbar—but it’s worth the
wait. This isn’t your typical ﬁrst-person shooter. You’ll need to solve
puzzles to advance, and at times you’ll be seriously outnumbered
and outgunned—moments that require more brains than brawn
to survive.
Despite Half-Life 2’s age, this giant of a game still impresses.
Beautifully rendered models both create stunning landscapes and
convey an incredibly claustrophobic world you can’t help but rebel
against. The outstanding dialogue draws you into the plot and
characters. Those in authority sound like they enjoy their power, the
friendly scientists sound lost in their intellectual wanderings, and the
rebels gain your sympathy and make you want to ﬁght for their cause.
Half-Life 2’s unique inventiveness also sets it apart. Where other ﬁrst-
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person shooters might immediately grant you a giant arsenal and tell
you to shoot everything in sight, Half-Life 2 utilizes quieter strengths:
good artiﬁcial intelligence, for example, great controls, a terriﬁc
physics engine, and pheromone-based pods that can summon a giant
insect army to attack your enemies. The awesome gravity gun can
draw objects to you and ﬁre almost any object as a projectile—it’s as
much a tool as it is a weapon.
Valve did well with the port to Mac, but a little more work remains
to be done. During testing, the game crashed twice on a Mac Pro
running Mac OS 10.6.3, and occasional control glitches emerged that
caused the main character to automatically move sideways for 30 to
60 seconds. These are by no means dealbreakers to an otherwise great game, but
HALF-LIFE 2
some patch work isn’t out of the question.
Valve
The bottom line. A few hiccups aside,
valvesoftware.com
this remains one of the ﬁnest ﬁrst-person
Price: $9.99
Requirements: 1.8GHz or faster
shooters for any platform—ever. The
Intel processor, Mac OS 10.5.8 or
later, 1GB RAM, ATI X1600 or Nvidia
story and visuals are spectacular, and the
GeForce 8 graphics card or better,
inventive gameplay keeps you coming
3GB free disk space
back. For $9.99, it’s hard to go wrong,
Terriﬁc story, great graphics,
amazing sound, and inventive
even though the multiplayer mode is in a
gameplay for a meager $9.99
price tag.
separate $4.99 game called Half-Life 2:
Occasional system crashes and
Deathmatch, which wasn’t available for
control issues make us grateful for
the Mac at press time (as soon as it’s out,
Valve’s frequent updates.
we’ll review it on MacLife.com).
Mac | Life E XCE L L E NT
R A T E D
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>>> Play Have Mac, will game

Zoom in on the busy streets to
watch your citizens hustle from
one spot to the next.

ThE SETTlErS 7: PaThS To a Kingdom
Settle down

If managing and expanding a kingdom sounds like a good time, perhaps
you haven’t thought it all the way through. Governing an empire, as the
real-time strategy game The Settlers 7: Path to a Kingdom is eager to
point out, is all about micromanaging. Wage wars on too many fronts,
and you’re toast. Don’t research enough technology, you’re toast. Don’t
cut down enough trees…well, you get the point.
Learning how to do all of these things is almost as difﬁcult as
doing them. In fact, nearly the entire single-player campaign serves
as a tutorial. After you’ve spent hours of trudging through the game,
Settlers is still introducing new objects
and features. Sure, series’ veterans
The SeTTlerS
will have much less trouble becoming
7: PaThS To a
Kingdom (norTh
acquainted with the controls, pacing, and
american ediTion)
overall structure of Settlers, but those
Transgaming
picking up the series for the ﬁrst time will
gametreeonline.com
Price: $49.95 ($59.95 Gold Edition
struggle through seemingly easy tasks.
includes downloadable content)
That’s because Settlers isn’t incredibly
requirements: Intel Core Duo
processor, Mac OS 10.6.3 or later,
accommodating when it comes to helping
2GB RAM, Nvidia or ATI video card
players achieve their goals. For instance,
with 256MB VRAM, 8GB disk space,
internet connection
if you pause a task in the building queue
Fast-paced task juggling is fun.
because you don’t have enough resources
Great artistic style. Tons of ways
to achieve victory. ESRB rating:
to build it, construction on the next items
Everyone.
will never start. Little frustrations like these
Incredibly difﬁcult learning
arise without any explanation.
curve. Glitchy cut-scenes.
Micromanaging isn’t always fun.
Adding to the problem, the campaign
Persistent online connection
doesn’t include an easily accessible
required by Ubisoft’s DRM scheme.
help system, so if you forget how to do
SO L ID
mac | life
R A T E D
something (and you will), you’ll have to pull
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up a separate site or consult the hardcopy manual. In short, saying
Settlers 7 has a long learning curve is like saying Godzilla would be an
unpleasant neighbor.
Once you get the hang of the controls and juggling the tasks, you’ll
promptly be thrown into a roller coaster of emotions. Settlers is
constantly challenging, frustrating, and, against all odds, fun, thanks
to the generally quick pace. Bouncing from one camp to the next,
constantly dashing from one duty to another, and ﬁnally defeating your
rivals is rewarding on many levels. Still, at certain times the gameplay
slows down to a crawl as constructors walk from one end of the map
and back—a fast-forward feature would have been a hugely beneﬁcial
addition for those moments.
Settlers’ distinct visual style makes viewing the cartoony world
enjoyable from both a bird’s-eye view and a fully zoomed-in street view.
The cut-scenes are equally impressive and stylized, but unfortunately
they often stutter and sometimes even cut short an important
character’s dialogue.
Online multiplayer adds yet another layer of depth with matches
often lasting well over an hour. Players can ﬁght alongside or against
their friends and can also appoint computer players as allies or enemies
for full-scale war with up to six players. Connection hiccups are usually
resolved through a quick reconnection, which is lucky because Ubisoft’s
always-online antipiracy software is ﬁnicky and bothersome, requiring
players to be online at all times to play the game. At certain times,
the game even logged out because of a malfunction in the antipiracy
software—how lame is that?
The bottom line. Unless manic multitasking is your idea of fun,
Settlers won’t settle into your gaming rotation.—Nic Vargus
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>>>Ask

Tech Supp orT & TechSpl anaTionS

>>>Canon Comes Clean
All of the Macs at our company print to two very expensive network photocopier/
scanners: the Canon ImageRunner 2270 and the Canon ImageRunner 3025. We just
upgraded the ofﬁce to Mac OS 10.6 Snow Leopard, but there are no Snow Leopard
drivers on Canon’s website! So now we can’t print at all! We called Canon, and they
told us to downgrade to Leopard or purchase a newer photocopier because ours have
been discontinued.
We’ve received several questions like yours (many of them irate at
Canon) since Snow Leopard was released. So we decided to take
matters into our own hands and contact Canon to see what the
problem is. We phoned Canon several times and also got the same
frustrating “downgrade to Leopard or buy a new photocopier”
line. That’s really not an acceptable answer when you’ve invested
$4,000-plus on a printer, so we continually escalated our calls
over a series of weeks until we ﬁnally got hold of perhaps the only
knowledgeable technician at Canon.
It turns out that there actually are Snow Leopard drivers for
your ImageRunner printers. They’re just hidden on the Canon
website, which is why you couldn’t ﬁnd them. In its inﬁnite
wisdom, Canon decided to only list its Snow Leopard drivers
alongside its very newest ImageRunner models, even though
those very same drivers are compatible with nearly 100 older
ImageRunner printers.
So the trick is to go to the driver download page for one of
Canon’s newest ImageRunner printers, such as the ImageRunner
9070 (tinyurl.com/4ul6bc) and download the Snow Leopard
driver, which is currently named UFRII_v2.10_MacOSX.zip. Open
the ReadMe ﬁle that comes with the driver, and you’ll see a list of
all 100 ImageRunner models that it supports.
Once you install the driver, please note that the conﬁguration is

completely different than it was in Mac OS 10.5. Within your Print
& Fax System Preference, you no longer choose More Printers,
but rather go to IP Printing and choose the LPD protocol. This
is outlined in more detail within the updated user manual that
comes with the driver.

let Your Fingers Do the switching

then use Command-~ (tilde) to cycle through its open windows.
But don’t forget about Exposé (F9), which was designed to
help you get to any window fast with either your mouse or your
keyboard. It’s even better in Snow Leopard because it now shows
your minimized windows too. You can customize Exposé to your
liking in System Preferences > Exposé & Spaces.
And those aren’t the only ways to switch windows. You
can always right-click an application’s Dock icon to select
any of its open windows or look in the Window menu of any

In Windows, when I press alt-Tab, it switches me between all of my
open web browser windows. However, when I press Command-Tab
on the mac, it switches me out of safari and into a completely
different application. How do I use the keyboard to switch between
windows instead of applications?

As you’ve discovered, the Mac keyboard shortcut Command-Tab is
used to switch between applications. To switch between windows
of one application, you must ﬁrst switch to that application, and
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once you install snow leopard drivers for your ImageRunner, you’ll
use this new conﬁguration screen to add the printer to your mac.

The Juice Is Loose
What’s the situation with portable batteries? If I’m out and about
and need some juice for my MacBook but don’t have my cables, what
do you recommend?

Witch takes
applicationand windowswitching to
a new level of
awesome.

application. But for the ultimate option, we love the utility Witch ($19,
manytricks.com), which gives you an unbelievable amount of control
over switching windows on your Mac. Witch lets you assign keyboard
shortcuts for virtually every conceivable application- and windowswitching task you can dream of. You can cycle through all open
windows in all open applications (even ones in other Spaces), add
visual feedback when switching through open windows in your current
application, switch between minimized windows, and much more.

We recently reviewed Sanho’s HyperMac line of external batteries (4
out of 5 stars, Apr/10, p68). And we still use them all the time for tasks
ranging from keeping a MacBook Pro fully charged during a grueling
live blog of the iPhone 4 announcement (our 3G modem saps the
MacBook Pro’s battery life insanely quickly) to topping off an iPad’s
battery during a long weekend camping trip out in the woods (no, we
don’t care to leave the electronics at home, thank you).
They’re pricey, starting at $199.95 for the 60-watt-hour battery to
$499.95 for a 222-watt-hour one (hypershop.com). And they’re heavy—
you won’t want to schlep it everywhere with you, only the places you
really think you’ll need it. The mid-range one we tested (150 watt-hours,
$399.95) is 2.4 pounds, just over half the weight of a current 4.7-pound
MacBook. But they last and last (and last), and the built-in USB port lets
you charge up your iDevices or other USB gadgets too.

Picking Apart PDFs
I’ve opened up a 75-page PDF in Preview, and I need to extract three
pages to email to somebody. I’ve been looking for some way to export
only these three pages out of the PDF or to split the PDF, but I can’t
ﬁgure out how to do it.

The secret to extracting pages out of a PDF ﬁle with Preview is that you
actually need to re-create the PDF ﬁle with only the pages you want.
With the PDF open in Preview, display the sidebar if it’s not already
displayed, then choose the Thumbnails option at the bottom of the
sidebar (second button from the left).
In the sidebar, select the thumbnails for your desired pages (Shiftclick for consecutive pages or Command-click if they’re not next to each
other), press Command-C to copy those pages, then press Command-N
or go to File > New From Clipboard to paste those pages into a new
Preview document. Save that new document in the normal fashion, and
it’s ready for emailing.
If you’d like to accomplish this via software, plus get more PDF
creation and editing tools, check out PDFClerk (35 euros, sintraworks
.com) or PDFpen ($50, smileonmymac.com). These products rival
Adobe’s Acrobat 9 Pro ($449, adobe.com) and Acrobat 9 Standard
($299), but at a fraction of the price.

Copy the
thumbnails
in Preview’s
sidebar, then
choose File >
New From
Clipboard to
paste them into
a new Preview
document.

Scan & PDF: worldmags & avaxhome

HyperMac’s batteries
can double—and in some
cases triple—the life of your
MacBook battery.

Safari Incognito
It doesn’t happen often anymore, but once in a while I’ll surf to a page
that won’t open in Safari, and I get a message saying something like,
“Sorry, you are using a browser that isn’t supported. Please use a
supported browser.” I’m using Safari 5, if that matters. Should I just
stick with Chrome or Firefox all the time?

If you like Safari 5, you can still use it and just trick the uncooperative
websites into thinking you’re using a supported browser. First you need
to enable the Develop menu in Safari. This used to require a Terminal
command, but now it’s right in Safari > Preferences > Advanced; just
check the box for “Show Develop menu in menu bar.” Boom, there it
is—magical. Stunning. Phenomenal. (Okay, not really.)
You can ignore the Develop menu for now. But the next time you get
an error message like that, pull down the Develop menu to User Agent,
and select a different browser from the list that pops out. You can try
Firefox, an older version of Safari, Opera, even Internet Explorer 8, 7, or
6. Once you make your selection, the page automatically reloads, but
it’ll think you’re using that other browser, even though you never left
Safari 5. The User Agent submenu even lets you pretend to be surﬁng
on a Windows
machine, in case
you run into any
Mac-hating sites
out there.
Found a site that
requires Internet
Explorer 6? Safari
5 can fake that.
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Preview’s Hidden Power

to certain applications, or
exclude applications, and
even set keyboard shortcuts
for maximizing windows,
instead of or in addition to
the green button.

I found this tip by accident and wanted to share it—hope you haven’t
heard this before. One frustrating thing about the iPhone is photo
management. Oh, sure, you get a chance to delete photos after
importing them into iPhoto, but you only get that one chance, and it’s
all or nothing. If you only want to delete some of the photos, you’ve
got to do that manually on the phone—or so I thought.
Turns out there’s another way. Plug in your iPhone and open
Preview, then select File > Import From [Your iPhone’s Name]. A
window appears showing all the photos on your phone, and you can
move them around, save them to disk, and delete them from the
phone individually or in batches. Don’t ask me why this is in Preview

RightZoom is a handy
way to make those green
buttons behave.

and not iPhoto!

Great tip—we had never heard of that! Thanks so much for passing
it on! (This was sent in by Mike Romo, who manages Norton for Mac
products for Symantec, plus writes a weekly column for iFanboy.com.)
This tip works with iPads too, and if you have both an iPad and
an iPhone connected to your Mac at once, the menu item becomes
Import From Camera, with a submenu that lets you choose which
device. We are just as bafﬂed as you regarding why this is in Preview
instead of iPhoto, or even stuck in iTunes somewhere. But it works
great, and that’s the most important thing.

Pack ’Em In
I’ve got a 32GB iPhone 3GS and was planning to upgrade to the iPhone
4 (probably for the holidays), but I really wish there was a 64GB option.
I download a lot of apps, but I have to keep reducing the amount of
music I keep synced, so there’s enough room for the apps and a free gig
or two for upgrades. Do you think Apple will increase the storage space
in iPhone 4 before releasing the next version of the iPhone? Or should
I start carrying my 8GB iPod nano again too, so I can keep more of my
music on me at all times?

Preview’s photo-import window has tons of information and power.
Who knew?

All I Want To Do Is
RightZoom a-Zoom-Zoom
I’d like to upgrade to Snow Leopard, but I’m afraid that if I do, the
RightZoom app I have installed will no longer work, and I can’t ﬁgure
out how to determine whether it will or not. SnowChecker (free,
snowleopard.wikidot.com/snowchecker) doesn’t list RightZoom, so I
couldn’t check compatibility that way. I’m not sure I want to go back
to the default behavior of OS X’s yellow and green buttons, but I’d like

We’d be pretty surprised if Apple released a 64GB iPhone 4 by the
holiday season, but stranger things have happened. (We don’t get any
advance notice of new Apple products.)
You didn’t mention what bit rate your iTunes library is ripped at, but if
it’s greater than 128kbps AAC (say, 256kbps AAC, Apple Lossless, etc.),
you can have iTunes 9 automatically downsample your music as it adds
it to your iPhone. We did this recently with an iPhone 3G and reduced
our library from 8.92GB of audio to just 4.85GB. So you can save some
serious space that way. The original ﬁles in iTunes aren’t changed, so
you can still enjoy your higher-bit-rate songs at your Mac. The setting is
in your device’s Summary screen; check the box for “Convert higher bit
rate songs to 128 kbps AAC.” As another option, try apps like OrbLive
Free (free), which streams your music from your Mac, and Pandora Radio
(free), which streams music from Pandora.com.
Or you could just duct-tape the iPod nano to the back of your iPhone.
But that would be silly.

We started with
almost 9GB of
music on our
16GB iPhone
3G (top), then
compressed that
down to less than
5GB (bottom)
with the new
setting in
iTunes 9.

to upgrade. Any advice?

You’re in luck. BlazingTools Software has updated RightZoom (free,
blazingtools.com) to be Snow Leopard compatible as of version 1.7. We
installed and tested it on a MacBook Pro running Snow Leopard, and it
worked as expected. Upgrade away!
For readers who haven’t tried RightZoom, it’s a utility that lets
you reassign the green “zoom” button at the top-left of application
windows to make that window full-screen. You can limit this behavior
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Ask is written by Susie Ochs and Scott Rose, a Los Angeles–
based FileMaker developer and Mac consultant. Visit him at
www.scottworld.com.
GOT A TECH QUESTION OR A HELPFUL TIP TO SHARE?
Email ask@maclife.com or write to Mac|Life,
4000 Shoreline Ct, Suite 400, South San Francisco, CA 94080
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HOW TO DO ANYTHING ON YOUR MAC

Hidden Features of the
iPad Camera Connection Kit
The iPad Camera Kit can add countless features to your
iPad—and save you some dough in the process
Many people wouldn’t take a second look at the
$29 iPad Camera Connection Kit because they
could simply transfer photos and videos from their
computer to their iPad via iTunes. But the Kit’s
little USB port–equipped dongle has unadvertised
features. By letting you connect other USB devices
besides your digital camera to your iPad, the Kit
adds tons of features and could save you quite
a bit of money if you use its capabilities to avoid
buying iPad-speciﬁc accessories. We found seven
hidden features that Apple may not want you to
know about. BY CORY BOHON
LEVEL:

>>>WHAT YOU NEED

easy

>> iPad Camera Connection Kit
($29, apple.com)
>> iPad to connect it to
($499 and up, apple.com)

1 Attach a USB Keyboard

The Kit’s USB dongle lets you use any USB keyboard—like the
one likely already attached to your Mac—by simply plugging it in. This
saves you $69 if you forgo buying the Apple iPad Keyboard Dock or
the Apple Wireless Keyboard. Plus, if your own USB keyboard sports a
number pad, iTunes controls, and volume and/or brightness controls,
they’ll still work with the iPad. And you won’t have to deal with the
sometimes-pesky onscreen keyboard, of course.
With some keyboard models, you’ll see a message that the attached
accessory won’t work with your iPad—but don’t believe the hype.
After you dismiss the message, you’ll be able to use the keyboard with
no problems.
Connecting a keyboard through the camera kit is almost too easy.
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2 Use Your USB Headphones

Some people prefer the sound of digital output over
USB to analog output from a headphone jack. If you’ve
invested in a great-sounding USB headset, you’ll be thrilled to
know you can use it with your iPad via the Camera Connection
Kit. Just plug it into the dongle’s USB port, and the iPad might
think a minute, but after that you should be able to use your
headset to listen to music or video. Plus, if your headset has
a microphone, you’ll be able to use that too—this can be
a money-saver since the iPad doesn’t come with earbuds
(mic-equipped or not) like the iPhone does. Apple’s own
mic-equipped earbuds are $29 (for the Apple Earphones with
Remote and Mic) to a whopping $99 (Apple In-Ear Headphones
with Remote and Mic).
This setup might not be particularly
glamorous, but vanity is a small
sacriﬁce to make for sound quality.

3 Attach a USB Microphone

As with the headphones, you can connect a USB
microphone to use with Skype or any other application
that can capture or record audio from the iPad’s built-in
microphone. Using a USB mic gives you better audio quality
than the built-in mic, too.
When you attach one of these audio devices, you can use
your iPad just as you normally would, launching applications
like Skype without having to worry about conﬁguring any
audio settings. The iPad will automatically get input from the
connected device.

Items from a
Camera or SD Card
4 Remove

Besides transferring photos from your digital camera or its SD card to your
iPad, you can use the iPad Camera Connection Kit to quickly erase all of the
images, freeing up the storage space on your camera or card. Connect the Kit’s
USB or SD dongle to the iPad’s dock, and attach a camera or insert your SD
card, respectively. Wait a few seconds while the Photos application’s Camera
Import screen opens.
After viewing the photos to make sure you want to delete them, tap the red
Delete All button in the upper left. You’ll be asked for conﬁrmation, and then
the iPad will remove all of the photos on your card or camera. No need to start
up your camera or drag out your laptop. If you want to remove some photos
but not all of them, select the photos by tapping, and then tap the Delete
Selected button.

A USB mic like
this Yeti from Blue
(bluemic.com, reviewed
on pp62-63) will
always sound better
than the iPad’s built-in
mic.
Removing ﬁles from your SD card is now another iPad-friendly procedure.
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Hidden Features of the iPad Camera Connection Kit (continued)

5 Transfer Photos from an iPhone

Because the camera-less iPad can’t take its own photos, you
need to sync photos to it from a computer or connect your camera
through the iPad Camera Connection Kit. But if your photos are already
stored on an iPhone or iPod touch, the Kit can help you get those on
your iPad without needing a computer—it only takes a few taps.
To do this, use an iPod-sync cable to connect your iPhone or iPod
touch to the Kit’s USB dongle. After a minute, you’ll see the Import
screen of the Photos application, displaying the photos on your iPhone
or iPod touch. Select the photos you want and tap the Import button. If
you use a passcode on your device, the photos won’t be displayed until
your device is unlocked. In testing, we found that we needed to sleep
our iPhone 3GS in order for the images to display. As soon as we awoke
the device, the Import window disappeared—we suspect the iPhone
was trying to draw too much power from the iPad.

Our smudged-up iPad and iPod touch—partners at last.

6Connect an External Hard Drive

While this isn’t supported by Apple, a few clever iPad hackers
have ﬁgured out a way to let the iPad Camera Connection Kit support
an external hard drive, which means you could store more ﬁles than
would ﬁt in the iPad’s built-in storage. It does require you to jailbreak
your iPad, following a rather lengthy guide on Maxwell C. Shay’s site,
time-more.com/ipad. The hack isn’t for the faint of heart, however, as
it does require some Unix monkey business. And your external drive
needs its own power supply too.

Mr. Shay even has a YouTube
video on his site that walks
you through the whole
process.

7Hook Up a USB Hub

To hook up several different low-powered USB devices (i.e.,
camera, headphones, keyboard) at once, we found that you can
add a USB hub and even use the USB accessories simultaneously.
Depending on the types of accessories being added, you may
need a powered hub. And keep in mind that the more items
drawing power from the iPad, the less battery life you’re going
to have. We were able to plug in an Apple keyboard, USB
headphones, and an iPod touch at the same time without any
problems. Your mileage may vary.

86

SEP•10 maclife.com

Scan & PDF: worldmags & avaxhome

Belkin’s 4-port Swivel Hub
($29.95, belkin.com) is
compact and includes an
external power adapter if you
need it.
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Master Services in Snow Leopard
The revamped Services menu in Mac OS 10.6 can save you tons of time and effort

Since the early days of the Mac OS, most users have avoided the
Services menu, largely because of what used to be found there: a
bewildering, ever-growing mess of options, submenus, and shortcuts.
But with Snow Leopard, the Services menu got a major revamp,
making it contextual to the application you’re using, as well as
conﬁgurable. Once you know how to take advantage of its useful
actions, you’ll save yourself lots of time.
First, some background: The Services menu houses a bunch
of small actions, primarily for manipulating selected text and

documents. For example, there are services for looking up a word in
the Dictionary and for creating a new email or note from selected
text. These commands can have keyboard shortcuts for even faster
access. And in Snow Leopard, the Services menu is now contextsensitive, so it only displays relevant options. In (increasingly rare)
applications that don’t support services, you see no options. If you’ve
selected some text, you’ll see quite a few choices in apps that support
services; select an item in the Finder to see different choices.
BY Craig granneLL

LEVEL:

easy

>>>WHAT YOU NEED
>> Mac OS 10.6 Snow Leopard ($29
upgrade from 10.5, apple.com)
>> Snow Leopard requires an Intel Mac

The Services menu got an
overhaul in Mac OS 10.6 for
contextual sensitivity.

1 Using the Menu

The best way to ﬁnd out about the Services
menu is to use it. Open a website in Safari, select
some text, and select Services from the Safari
menu. You’ll see options for what you can do.
These might vary from Mac to Mac depending on
your installed apps.

each application’s relevant
services are found in
[app name] > Services
in the menu bar.
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2 Text-Based Services

Assuming you haven’t amended default services
settings, select New Email With Selection. Mail will open with
your text in a new message, saving you the trouble of copying
the text to your clipboard, opening Mail yourself, and pasting in
the text. The New Note With Selection option works the same
way, but creates a new note in Mail.

Sending text straight to a new email will save you several clicks
and keystrokes.

4Manage Your Services

3Services Shortcuts

In the last step, you may have noticed that Make a New
Sticky Note has a keyboard shortcut, Command-Shift-Y. Switch
back to Safari. With your text still selected, press the keyboard
shortcut. Stickies will open with a new note containing the
selected content.

Stickies are useful, and the Services menu lets you create one with a
simple keyboard shortcut.

5Deﬁne a Service Shortcut

Launch System Preferences and select Keyboard.
Click the Keyboard Shortcuts tab and choose Services from
the list of options in the left-hand pane. In the scrolling
pane to the right, you’ll see all the available services. Use
the checkboxes to turn individual services on and off.

Keyboard shortcuts are easy to deﬁne in the same
System Preferences > Keyboard pane. Scroll down to Look
Up In Dictionary, double-click to the right (near the scroll
bar), and hold Command-Control-D to set the shortcut.
Select a word in TextEdit and use that shortcut—you’ll see
a pop-up deﬁnition. (Some apps launch Dictionary to show
the deﬁnition; others don’t.)

Uncheck services you know you’ll never, ever use.

Keyboard shortcuts make services even easier to use.
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Master Services in Snow Leopard (continued)

6 Searching for Content

In the Searching section of System Preferences > Keyboard >
Services, ensure Search With Google and Search With Spotlight are
active. You can then use Command-Shift-L and Command-Shift-F,
respectively, to search for a selected term in Google (via Safari) or
Spotlight.

Search With Spotlight launches a new Finder window with your
Spotlight search results.

7 Import a Screen Grab

The Services menu enables you to import a screenshot into
Mac word processors such as Pages and TextEdit. Select Capture
Selection From Screen and drag an outline for your screenshot.
The selection will be sent to your text editors. Other options can be
selected in System Preferences.

Drag the red box to deﬁne your screenshot, which is sent
right to your text document.

8 Use the Contextual Menu

Relevant services are also available in the
contextual menu (Control- or right-click to see it). If you
don’t see options such as the ones mentioned in Steps 2
and 3, that’s a known Mac OS X bug. Turn the services off
and on again in System Preferences to ﬁx it.

The “Make a New Sticky Note” service is
missing, but we can bring it back.
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Start Blogging with WordPress
Get your own website up and running in minutes
with the WordPress content-management system
Websites can be a pain to set up—even with
HTML and CSS, hand-coding a site can take
hundreds of hours. And it gets worse if you
want a website you can update frequently
because you’d have to dig back into the original
code to make changes. Enter the CMS, or
content-management system, designed to let
you easily update a site without monkeying
with the underlying code. WordPress is perhaps
the most impressive, powerful, and widely
used blogging CMS there is. For beginners and
non-technical types, it’s incredibly easy to set
up, even if you’re using your own domain. More
advanced users can tweak WordPress to an
incredible degree with themes and plug-ins,
and power users can even adjust the opensource code with a basic text editor.
We’ll assume you want a self-hosted blog
with your own domain name; for example,
mygreatsite.com. (The other option, a hosted
blog, is easier but less professional looking.
Wordpress.com lets you sign up for a free
hosted blog.) You can get a cheap domain name at NearlyFreeSpeech.net—a .com
address runs about $9/year. Next you need somewhere for your blog to run. A
WordPress blog is a piece of software, albeit not one that runs from your Mac. That
means besides simple hard disk space on a server, you need a few minor bells and
whistles to go with it. Make sure your prospective web host provides compatibility
with PHP and SQL databases. Web hosting is cheap—NearlyFreeSpeech.net, for
example, offers pay-as-you-go pricing for storage and bandwidth that can be as low
as $2/month. Popular domain-registration and hosting service GoDaddy.com charges
about $57/year for hosting with 10GB of storage and 300GB of trafﬁc. That should be
sufﬁcient for most blogs, even if you intend to stream video. Lastly, pick up a good FTP
client, which makes it easy to upload ﬁles to your blog—we like Fugu (free, rsug.itd.
umich.edu/software/fugu/). BY DAVE STEVENSON

>>>WHAT YOU NEED

LEVEL:

medium

>> WordPress (free, wordpress.org)
>> TextEdit (included with Mac OS X)
>> FTP client such as Fugu (free, rsug.itd.umich.edu/
software/fugu/)
>> Web hosting space (prices vary)
>> Personal domain name (optional, prices vary)

Up an SQL
Database
1 Set

With your web hosting and domain name set up,
the ﬁrst step is to create an SQL database. Your
new host’s help section will walk you through the
process of setting one up. Make sure you note
down the name of the database, as well as your
username and password.
Every host’s SQL setup
is a little different.
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Start Blogging with WordPress (continued)

2 Download WordPress

Download WordPress from wordpress.org. Rename wpconﬁg-sample.php to wp-conﬁg.php and open it using TextEdit.
Go to the section called My SQL settings. Enter the details
exactly as they appeared when you created your database.

3Secure Your Site

Copy and paste the link in the conﬁg ﬁle into the address bar
of your web browser to generate a set of keys that will make your
passwords harder to crack. Copy the keys from your web browser
back into your conﬁg ﬁle. Save it and close it.

Looks like gibberish, but think of it as secret security sauce.

Replace database_name_here, username_here, and password_
here with the correct details. We also had to change localhost,
according to our hosting company’s instructions.

4Upload to New Host

Log in to your space using your FTP client (we’re using
Fugu). You’ll get the login details from your hosting service, or
try ftp://[your-site-name].com, although the address can vary
depending on your hosts. Upload everything in your WordPress
folder to your new host. Go to [your-site-name].com, and you’ll
see the WordPress welcome screen.

Upload it all; you’re basically installing WordPress in your web space.
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5Name Your Blog

Think up a name for your blog and make sure you enter a
reliable email address so your WordPress install knows where to
reach you—this address will be used to notify you when someone
leaves a comment on your blog, and it’s where a new password
will be sent if you forget your old one. Make sure to change the
username from “admin” to something less common and harder to
guess, and use a strong password.

Your blog needs a title, a username for you, and of course a password.

6Preview Your Blog

Once you’re in the WordPress Dashboad, click your blog’s
name in the upper left (mouse over it for a tooltip saying Visit Site)
to see the prototype of your new blog. When you next visit your
blog, type [your-site-name].com/wp-admin to get to the login screen
and Dashboard.
Our default blog isn’t much
to look at, but it’s up and
running, and it’s ready for
content and customization.

7 Upload Multimedia

With WordPress installed, you’ll be able to see why so many
bloggers swear by it. Naturally, you get rich text formatting, and
WordPress allows you to upload images and videos without needing to
revisit your FTP client. Once you’ve clicked Add New Post, simply click
the image button on the toolbar, and WordPress will automatically
upload your multimedia ﬁles into new folders on your FTP server.

Let WordPress handle
the uploading.

8 Explore Themes and Plug-ins

In days gone by, installing new themes or plug-ins was a
nuisance. You had to download a new theme, upload it via FTP, then
activate it in WordPress. Now, if you go to WordPress’s Dashboard
and click Appearance, you’ll see the Themes settings and an Add
Themes tab. Click this, and you’re taken to a wonderland of free
themes where installing a new one couldn’t be simpler. The same
goes for plug-ins, which can be searched for by keyword. WordPress
is resilient to user error as well—if you make a mistake in the front
end (as opposed to in an FTP client or when trying to edit your
WordPress database), you’re very likely to be able to undo your
changes and return to a working version of your site.

More themes than
you can shake your
mouse at.

>>Why Not iWeb?
It’s hard to ignore the temptation of Apple’s iWeb. You probably already have it, it produces
acceptable results, and unlike WordPress, iWeb doesn’t make you go near an SQL database
or ﬁddle with the back ends of hosting accounts or domain names. iWeb even has built-in and
downloadable themes and enough multimedia compatibility to keep people happy.
But WordPress leaves iWeb in the dust, especially for the ambitious webmaster or those who
think they might make some money from their blog. For starters, WordPress has a far more
active community than iWeb, which means a lot more choice when it comes to themes, as well
as more plug-ins and more help forums if you get stuck. The upshot is that your website is
likely to be more individual if you use WordPress. iWeb’s themes are quite heavy on clip art and
stock backgrounds, which will mark your new site as the work of a rookie. iWeb is also poorly
suited to blogging. It lets you add a blog, but in order to update it you need to be in front of a Mac that has iWeb installed—not much use if
you’re without your MacBook. A WordPress blog can be updated from any computer with a web browser, and you won’t lose any features.
iWeb does have a few upsides: it’s undeniably easy to use, and its iPhoto integration means that if you don’t care to learn anything new, you
can still have a decent-looking presence on the web. But anyone with a modicum of ambition should give WordPress a go—you won’t regret it.
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Your
Guitar Tone
On Your
iPhone
AmpliTube® iRig™
Take your Amps
& Pedals with you on
your iPhone/iPod/iPad
AmpliTube iRig is the unique
combination of an ultracompact plug-in adapter and
a mobile app that turns your
iPhone®, iPod touch®, iPad™ into
the ultimate mobile guitar and
bass tone and effects processor.

www.amplitube.com/irig
Download the FREE version now!

only

$39

.99

+ AmpliTube
Free for iPhone

AmpliTube® and iRig™ are trademarks property of IK Multimedia
Production. All other product names and trademarks are the property
of their respective owners, which are in no way associated or afﬁliated
with IK Multimedia. iPhone®, iPod touch®, iPad™, are trademarks of
Apple Computer, Inc., registered in the U.S. and other countries.
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Storage drives are evolving signiﬁcantly, and this month, Rik Myslewski
examines the approaching sea-change known as SSDs and bids...

Farewell to Hard-Disk Drives

T

he plain, unvarnished
truth about the future
of storage is that
fundamental differences between
hard-disk drives (HDDs) and
solid-state drives (SSDs) will
lead to the HDD’s doom. Those
differences, however, also explain
SSD’s bad reputation for getting
slower over time, among other
things. Such kinks are being
worked out, and 2011 will be the

year SSDs go mainstream.
To the SSD’s advantage, the HDD’s ancient spinning-disk
tech makes the average latency (the time it takes to ﬁnd the
data) of a speedy Seagate Barracuda
7200.11 HDD a full 4.16 milliseconds.
For a bits-on-chips Micron RealSSD
C300, average write latency is a little
over 0.08 milliseconds. Ouch. Also,
a hard drive reads and writes data in
a single stream, while an SSD deals
simultaneously with multiple chip
channels (four to ten, usually). The
more channels, the higher the bandwidth. A serial HDD just
can’t compete with a parallel SSD.
There are two types of SSDs. One, called a single-level cell
(SLC), holds one bit per cell; the other, called a multi-level cell
(MLC), holds two. The cells are essentially identical—it’s the
way they store bits that’s different. But MLCs are cheaper
than SLCs, and they’re (usually) slower and (potentially)
have shorter lifespans. That’s why SSD manufacturers use a

A serial HDD just can’t
compete with a parallel SSD.
technique called wear-leveling to evenly balance cell usage.
Essentially, it ensures that an SSD’s MLC cells grow old
together.
The facts behind why older SSDs have slowed down relate
to how bits are erased on HDDs and SSDs. When you delete a
ﬁle, you don’t actually erase anything—you merely tell your
Mac to forget about that ﬁle. When you need its space back on
an HDD, you simply write over it. On an SSD, however, you have
to erase it ﬁrst, then write over it. But when you erase bits
from an SSD, you have to do so one block at a time (usually
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512KB), even though you write to one page at a time (there are
commonly 128 4KB pages in a block).
Let’s say a block on your SSD contains data from multiple ﬁles.
Some of those ﬁles are active, some are “deleted” but not erased.
But now, when you want to write a new ﬁle to pages in that block,
there are so many inactive—but full—pages that there’s no
room for that ﬁle. So you need to erase those inactive pages.
But remember that you must erase the entire block at the
same time. So to protect the active ﬁles in that block, you write
the block out to some free space on your SSD or to a buffer, then
erase the block, then write the original good stuff back to the
just-erased block. And you’ve just wasted a ton of time.
What’s worse, the more you use your drive, the more it ﬁlls up,
and the more time you waste keeping it clean. The older it gets,
the slower it gets. The solution to this problem was once simply
to wipe an aging, slowing SSD clean and
start over—not convenient, but effective.
But SSD designers have come up with
better ideas, such as setting aside a good
chunk of the SSD as extra space for write
operations (called overprovisioning), then
to erase inactive pages during garbagecollection idle time—and to have those
overprovisioned blocks be available when
others go south.
Another was the introduction of TRIM technology, in which
the operating system explicitly tells the SSD to erase the pages it
no longer needs. Windows 7 supports TRIM; Mac OS X doesn’t—
though it’s rumored for the future.
More effective, however, are increasingly sophisticated, zippy
drive controllers, such as the Indilinx Barefoot or the Marvell
controller in the Micron RealSSD C300, that are smarter than
TRIM. SandForce’s DuraClass Technology controllers, which
power Other World Computing’s Mercury Extreme Pro SSDs,
among others, add compression and other goodies to the mix.
So SSDs will get better. Indilinx’s new JetStream controller is
coming soon, and Intel’s popular X25-M will update late
in the year. It may take a generation for SSDs and HDDs to
reach price parity, but when they get even close, hard-disk
drives are doomed.
>>Since the late 1980s, Rik Myslewski has paid his rent by keeping an

eye on Apple. He was editor-in-chief of MacAddict from 2001 until its
transformation into Mac|Life in early 2007, and is now a member of
the snarkily sophisticated team at London’s The Register, which is
“biting the hand that feeds IT” daily at www.theregister.co.uk.
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